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About

Your Documentation

Three standard documents are included with your Amiga:

I

Quick Connect — How to Set Up the Amiga

This booklet, which folds out into a large poster, shows you how to connect
your Amiga equipment and any peripherals, such as a2 monitor or printer.
You can hang this poster in a convenient spot while you follow the set up
instructions.

, Introducing the Amiga

This manual describes the major components and features of your Amiga,
and tells you what to expect when you first turn on the computer. The
manual also introduces you to the Amiga Workbench™, which is the
software interface that lets you interact with your computer through
graphic symbols appearing on the screen. The expansion capabilities of the
Amiga are also covered.

Using the Amiga Workbench

This manual explains how to use the software packaged with your
computer. The manual begins with a tutorial aimed at the first-time user.
Subsequent chapters explain the Workbench software in detail. An
introductory chapter covering the basics of AmigaDOS is also included.

Here’s what's in each chapter and appendix:

Chapter 1, Tutorial, takes you step-by-step through the elementary tasks
involved in using your Amiga.

Chapter 2, Basic Operations, expands on the tutorial to provide a more
detailed explanation of how the Amiga works.

Chapter 3, Preferences, tells you how to properly set your Amniga to work
with monitors, printers, and other peripheral devices and how to
customize your Workbench screen (e.g., by changing colors and type
fonts).



Chapter 4, The Workbench Programs, explains all the programs on the
Workbench disk, like Say, which lets you enter text for the Amiga to
speak.

Chapter 5, The Extras Programs, explains all the programs on the Extras
disk, like GraphicDump, which lets you print out screen images.

Chapter 6, MEmacs, explains the MEmacs text editor which is included
on the Extras2.0 disk.

Chapter 7, Introducing AmigaDOS, introduces you to the basic concepts
behind AmigaDOS. The discussion includes a description of the Shell, a
keyboard-based interface that lets you run programs and perform basic
operations through typed commands. Several of the most common
AmigaDOS commands are also explained.

Appendix A, Troubleshooting, contains a list of possible problems and
suggested solutions.

Appendix B, Printers, lists many of the printers that can be used with the
Amiga, as well as the standard printer escape sequences.

Appendix C, Fountain, explains the Fountain program on the Extras2.0
disk. This program allows you to use outline fonts with your Amiga.

The Glossary defines important texms used throughout the manuat.



How To Use This
Documentation

I you have never used an Amiga before, read Quick Connect and Introducing
the Amiga. Then read Chapters 1 through 3 in this manual. Finally, as you
need or want more detailed information on the Amiga’s operations and specific
features, read the remaining chapters.

If you have used an Amiga before, you should first read Quick Connect and
Introducing the Amiga. In this manual, you may want to skip the tutorial,
but you sheuld read the other chapters as needed to learn what’s new about
Workbench.

A Word About
Symbols and Type Styles

This symbol draws attention to instructions that
must be read carefully in order to avoid damage to
your system.

Bold words Words that appear in bold are defined in the glossary.

Screen Output Words that appear in this style can be one of two things:
input you must type at the keyboard or output that is shown
on the Amiga screen.



A Word About
Keys

All references to alphabetical keys are shown in uppercase letters. Unless
otherwise specified, do not press Shift. If the instructions read “Press Q,”
simply press the Q key. If an uppercase letter must be used, it will be specified
tn the instructions.

Non-alphanumeric keys are shown as they appear on the keycap {Ctrl, Esc,
Del, Alt, Help}.

The Amiga keys are referenced by their position: left Amiga { A ] and right
Amiga | A | Several keys on the keyboard have arrows on the keycaps. The
list below shows the keycap and the name used for that key:

T

-l -
Return Backspace
{} -
Shift - Tah

The group of arrow keys to the left of the numeric keypad are the cursor keys,
The keys are referenced by the direction of their arrow: up cursor, down cursor,
left cursor, and right cursor.

At times, you need to press a sequence of keys. In these instances, the keys are
separated by a hyphen and shown in the order they should be pressed, such as
Ctrl-O. This means you must press, and hold, the Ctrl key, then press the O.
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Chapter 1. Tutorial

This chapter introduces you to the Amiga® system and the
Workbench™ software by telling you how to:

¢ turn on your machine

use the mouse

choose options from menus

make backup copies of your floppy disks
prepare floppy disks for data storage
organize your files on a disk

When you finish this tutorial you will know enough about
your Amiga computer to begin using application software,
such as spreadsheets, word processors, desktop publishing or
graphics programs.

Don‘t worry if it seems that some ideas are not explained in
full detail. Chapter 2, “Basic Operations,” provides more
complete expianations.

Getting Started

Turn on the power to your computer as shown in your
Introducing the Amiga manual. The power light on the front of
your machine signals that the power is on. You must also turn
on the power to your monitor. Read the documentation that
came with your monitor for instructions.
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An animated screen will appear showing a floppy disk being
inserted into a disk drive.

2.0 Rems (16.00x)
Copyright & 1998 Comnodore-Aniga, Imc,
M1 Rights Reserved

This is your signal to insert the Workbench2.0 disk into the
disk drive,

1. Insert the Workbench2.0 disk into the disk drive,
metal end first, with the labeled side facing up .




The process of turning on your computer and loading
information from a disk containing the Amiga operating
system is known as booting your computer—irom the old
expression ‘pulling yourself up by your bootstraps.” It refers to
the process of reading the information needed to stare the
system frorm a storage device, such as a floppy disk, into the
computer's memory.

The disk drive light comes on as the Amiga starts
reading the information on the disk. Never remove

a floppy disk from the drivewhile the disk drive light
is on.

The first thing that you'll see on your monitor is some
introductory information, such as copyright notices and the
name and version numbers of the software, After a few
seconds, the introductory screen is replaced by the Workbench
screen. It is through this screen that you access the programs
on the Workbench2.0 disk.

Horkbanch 2.

2 glner men
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Ram Disk
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pointer

Workbench window
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RAM stands for Ran-
dom Access Memory.

You cen change the
shape and color of the
pointer with the
Pointer editor in the
Prefs drawer (ex-
plained in Chapter 3}.

A window (an area on the screen that accepts and displays
information} fills most of the screen. This window, called the
Workbench window, contains two icons. Icons are irnages that
represent various items, such as disks or files.

The icon with the word Workbench2.0 underneath represents
the actual Workbench?2.0 disk that is in your disk drive.
Whenever you insert a disk into the drive, an icon representing
that disk appears in this window.

The icon labeled Ram Disk represents a section of the Amiga’s
internal memory that is available for temporary data storage.
The Rarn Disk acts like a floppy disk in that you can store
information in it and retrieve information from it. However,
the computer can access information on the Ram Disk much
faster than information on a floppy disk.

The contents of the Ram Disk are erased when the Amiga
1s turned off.

There is also a pointer on the screen. The pointer is controlled
by the mouse. By placing the pointer over objects on the screen
and pressing a mouse button, you can start programs, exit
programs, copy disks, rearrange your screen, and much more.
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Using the Mouse

The mouse controls the movement of the pointer. When you
move the mouse across your table or desk, the pointer will
move across the screen.

1. Hold the mouse with your thumb and little finger
resting on either side of the mouse. Put your index and
middle fingers over the mouse buttons,

2, Without pressing either button, slide the mouse across
your desk.

As you move the mouse, the pointer moves in the same
direction. If you run out of room before getting the
pointer where you want it, lift the mouse, put it down
where there is more room, and continue moving it.
Lifting the mouse does not move the pointer.

To work with an icon, you must first point to it. When pointing
to an icon, the tip of the pointer must be over the icon. The tip
is where the pointer’s “hot spot” is located.
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Throughout this chap-
ter, you are reminded
that the selection but-
ton is on the left, and
the menu button is on
the right. These re-
minders only appear
in this chapter,

Once you have the pointer in the right spot, you use a mouse
button to send an instruction to the computer. There are two
buttons on the mouse:

menu
button

The left mouse button is the selection button; the right mouse
button is the menu button. How to use the mouse buttons is
explained in the following sections.

The Selection Button

Pressing and releasing a mouse button is known as clicking.
Clicking the selection button while pointing to an icon

is known as selecting an icon. When an icon is selected,

it becomes available for use and changes its appearance

in some way.

For instance, the Workbench2.0 icon, along with the other
icons in the Workbench window, is enclosed in a box that
appears to be raised above the screen.

1. Point to the Workbench2.0 disk icon, and press and
release the selection (left) button.
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[

Horkbench2. @

EI(I)'

When the Workbench2.0 icon 1s selected, it appears to
sink into the screen. An icon will remain selected until

you click on another icon or on an empty part of the
screen.

2. While the Workbench2.0 disk icon is selected, point to
it, hold down the selection {ieft} button, and move the
mouse.

A copy of the icon will move across the screen. When
you release the mouse button, the icon will move to the
new location. This is known as dragging.

You can drag any icon by pointing to it, holding down the
selection button and moving the mouse. You can also drag

windows and screens. This ts explained further in a later
section.

d icon

selected icon

If you accidentally
click the mouse but-
ton twice, a new win-
dow will appear on
the screen. Don't wor-
ry about this. Just
Ieave it there, ond con-
tinue on with the tuto-
rial,
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menu bar

The Menu Button

The right mouse button is the menu button. When this button
is held down, 2 menn bar appears across the top of the screen.
The menu bar shows the headings of any menus that are
available to you. A menu is a list of options, known as menu
itéms, that is provided by the software you are using.

1. Hold down the menu (right) button,

The menu bar appears across the top of the screen. It
consists of four menu headings: Workbench, Window,
Icons, and Tools. Each of these menus is explained in
detail in Chapter 2.

| li
m‘

Werkbench?. ¥

R

The next section of this tutorial explains how to choose an
item from a menu.



Quick Review

¢ Moving the mouse moves the pointer across the
sCreen.

® The left mouse button is the selection button.
Pressing and releasing the selection button while
pointing at an icon makes that icon available for use.
This is known as selecting an icon.

& Holding down the selection button while moving
the mouse drags the selected icon to a new location
on the screen.

¢ The right mouse button is the menu button. Holding
down the menu button causes the menu bar to
appear.

Most programs allow you to interact with the Amiga through
menus. For instance, you can rename an icon or copy a file by

choosing menu items from the Workbench menus. While

menus may vary from program to program, the steps involved
in choosing a menu item are the same for all Amiga software.

Tutorial
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Using Menus
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leons menu

The following example shows you how to choose a menu item
from the Icons menu.

1. Point to the Workbench2.0) icon on your screen, and

click the selection (left} button.

The icon will change color and will appear to sink into
the screen. This indicates that the icon is selected. (If
the icon is still selected from Step 3 of the “Using the
Mouse” section, it will already be highlighted. Selecting

it a second time has no effect.]

2. Hold down the menu (right) button, end point to the

fcons heading in the menu bar.

A list of options, known as menu items, will appear.

Herkberch

R Disk
——

-
I
Horkbench2. 8

2|

3. Without releasing the menu (right) button, move the

pointer down to the Open menu item.

Notice that when you point to Open, it is highlighted.
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4. While Open is highlighted, release the mouse button.

The Workbench2 0 disk window will appear on the
screen.

Mouse shorteut: Another way to open an icon is to point to the
icon and double-click {quickly click twice} the selection [left)
button.

You don’t always need to use the mouse to choose a menu
item. You can often get the same result by pressing two keys on
the keyboard — right Amiga and a corresponding letter.
Keyboard shortcuts are shown to the right of the menu item.

For instance, to choose Open from the Icons menu, you can
press right Amiga-O. (Press right Amiga, keep holding it down,
press O, then release both keys.|



1

12

Tutorial

ghosted menu items

Ghosted Menu Items

At certain times some menu items are not available for use.
The unavailable items are displayed less distinctly than the
others. These items ase ghosted and will not be highlighted
when the painter passes over them.

[}
o
Ran Disk

o
Horkbench2. 8

Usually menu items are ghosted because something on the
screen must be selected before the menu can be used. For
instance, if you haven't selected an icon, you cannot choose
any of the menu items int the Icons menu.

Quick Review

# Before choosing a menu itern, the icon, window, or
screen that you want to work with must be selected,

® To choose the menu item, hold down the menu
{right] button, highlight the menu item by pointing
to it, and release the menu button.,
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Working with Windows

When you open a disk icon, a window appears. A window is a
rectangular area on the screen that displays information, such
as graphic images and text, and allows you to work with that
information. If you were following the steps explaining how to
use the menus, you should have twe windows on your screen:
the Workbench window and the Workbench2.0 disk window.

The Workbench window contains icons for the Ram Disk and
for any floppy disks that have been inserted into a disk drive.
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The Workbench2.0 disk window contains several deawer icons.
Drawers are subdivisions of a disk that are used to organize the
information on that disk. Opening a drawer icon also opens a
window.

The Amiga computer is multitasking. This means that it is
possible to have more than one program running at a time.
For instance, you could have a calculator, a clock and an
animation all open and running at the same time. This usually
results in several windows open at once, with the windows
overlapping each other.
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close gadget

However, only one window at a time can accept input from
you. This is known as the active window. The frame of the
active window is a different color from the other windows on
the screen.

Take a look at the border of the Workbench?.0 disk window. It
contains several boxes, known as gadgets, that let you control
the window in many ways, including moving the window,
changing the size of the window, scrolling [moving) the
contents of the window, and closing the window.
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These are some of the most common gadgets found on
windows on the Amiga. Depending on the software you are
using, windows can contain any combination of these gadgets.
Some application programs may open windows that contain
gadgets for controlling special features of the program. For
instance, 2 window in a paint program may have gadgets that
let you choose colors, brushes, magnifications, or other
specialized functions.

The gadgets in the Workbench window are briefly explained in
the following sections. Complete information on the standard
system gadgets is available in Chapter 2.
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The Title Bar

The title bar identifies each window. The title bar of the
Workbench2.0 disk window contains the name of the window
and information as to the amount of data contained on the
Workbench2.0 disk. When a drawer icon is opened, the title bar
of the drawer window displays the name of the drawer.

You can also use the title bar to drag a window across the
screen.

1. Point to the title bar of the Workbench2.0 disk
window.

2, Hold down the selection {left) button, and move the
mouse.

An outline of the window will appear and will move in
the same direction as the mouse.
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3. Release the mouse button.

The window will move to its new location.
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depth gadget

The Depth Gadget ©

The depth gadget lets you move a window to the front of the
screen or push it behind any other open windows. This is
useful when you have several windows open and the one you
need is not at the front of the screen. If you've been following
along with this tutorial, there should be two windows open on
your screen: the Workbench window and the Workbench2.0
disk window.

1. Point to the depth gadget in the Workbench window,
and click the selection (left} button.

The Workbench window moves to the front of the
screen. The Workbench2.0 disk window has not been
closed. It is just hidden behind the larger Workbench
window,
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2. Point to the depth gadget on the Workbench window,
and click the selection (left} button again.

The Workbench window will be pushed to the back of
the display, and you will be able to see the
Workbench2.0 disk window again.



The action of the depth gadget depends upon the window's
location. If the window 1s behind another window, selecting
the depth gadget brings it to the front of the screen. If the
window is at the front of the screen, selecting the depth gadget
sends it to the back. You can also send a window to the back of
the screen, regardless of its current position, by holding down
Shift and selecting the depth gadget.

The Zoom Gadget 0

The zoom gadget changes the size of a window. This is helpful
when you have several windows open on the screen. You can
move unneeded windows out of the way by making them
smaller with the zoom gadget.

Selecting the zoom gadget on the Workbench2 0 disk window
reduces the size of the window.

1. Point to the zoom gadget in the Workbench2.0 disk
window, and click the selection (left) button.

The Workbench?.0 disk window becomes smaller.
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zoom gadget
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sizing gadget

2. Click on the zoom gadget again.

The Workbench window returns to its previous size and
position.
In general, if a window is small when it is opened, selecting the
zoom gadget will make it large. If a window is large when it is
opened, selecting the zoom gadget usually makes it smaller. If
you change the siz - or position of a window, the window will
use that new size or position when the zoom gadget is selected.

The Sizing Gadget [

Another way to change the size of 2 window is by using the
sizing gadget. This is an easy way to change a window’s size so
that you can see other information on the screen.

1. Point to the sizing gadget in the lower right corner of
the Workbench window.

2. Hold down the selection (left) button, and move the
pointer up and to the left.

The window becomes smaller as you move the mouse.

warkbench 208 949344 qmaphoc: ren 1E2012D obher men

o] Horkbench Ej@l

|

Ram Disk

K1

Werkbench?. PaNSi0N

NEI kX

[ 1 <[3




3. Release the mouse button.
The window stays the smaller size.

You can enlarge the window by pointing to the sizing gadget
and moving the pointer down and/or to the right.

The Scroll Gadgets

When a window is small, you cannot always see all its icons.
You can tell whether all the icons are visible by looking at the
scroll gadgets that run along the right side and bottom of the
window. The scroll gadgets are made up of scroll boxes, scroli
bars and scroll arrows.
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The scroll bars are the highlighted ateas inside the scroll boxes.
The bars change size depending on how much of the window’s
contents are visible. When the scroll bar completely fills a
scroll box, all of the icons are visible.
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When some of the icons in the window are not visible, the
scroll bars shrink and only fill part of the scroll box.
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By dragging the scroll bars, you can see the hidden icons
without changing the size of the window. If you were following
the steps on how to use the sizing gadget, your Workbench2.0
disk window should be small, as shown above. If not, use the
sizing padget to make the window smaller.

1. Point to the scroll bar along the right side of the
window.

2. Hold down the selection {left) button, drag the scroll
bar down, and release the mouse button.

Drag the scroll bar into the empty space of the scroll
box. For instance, if the bottom of the scroll box s
empty, drag the scroll bar down into the bottom of the
box. When you 1elease the mouse button, you will see
the icons from the bottom of the window.
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3. Point to the scroll bar in the bottom of the window.

4. Hold down the selection (left) button, and drag the
scroll bar to the right.

When you release the mouse button, you can see the
icons from the right side of the window.

The location of the scroll bar indicates what part of the
window is currently visible. For instance, if the scroll bar is in
the lower portion of the vertical scroll box, vou are looking at
the bottom of the window.

Another way to move the scroll bar is to point in the empty
area of the scroll box and click the selection {left} button. The
scroll bar will move to the empty area.

The scroll arrows also allow you to scroll through the viewing
area of the window. The direction of the arrow determines in
which direction the viewing area will move.

1. Point te one of the scroll arrows in the lower right
corner of the Workbench2.0 disk window.

2. Click the selection (left) button.

The viewing area will move in the direction of the
arrow. If you hold down the selection {left] button, the
viewing area will move more quickly.
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close gadgel

A requester is a mes-
sage from the system.
It is a box that ap-
pears on the screen
and has gadgets thar
let you select a course
of action,

The Close Gadget m
When you are finished working in a window, you can use the

close gadget to rermove it from the screen.

1. Point to the close gadget in the Workbench?2.0 disk
window.
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2. Click the selection (left} button.
The Workbench2.0 disk window disappears.

Be especially careful of the close gadget on the Workbench
window. When you select this gadget, a requester asks you if
you are sure you want to quit the Workbench. If you close that
window, you cannot access any of the Workbench programs.

NOTE: You do not want to close the Workbench at this time.
Cases in which you may want to do so are explained later in
this manual.
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Quick Review

# The title bar displays the name of the window and
information about its contents. By pointing to the
title bar, holding down the selection (left) button and
moving the mouse, you can drag a window to
another area of the screen.

¢ Selecting the depth gadget of the front-most window
moves that window behind any other open
windows. If 2 window is behind another window,
selecting tts depth gadget brings it to the front of the
screen. Holding down Shift and selecting the depth
gadget sends a window to the back of the screen.

® Selecting the zoom gadget changes the size of a
window. Selecting it again returns the window to its
previous size and position.

® By drageing the sizing gadget, you can expand or
shrink the size of a window.

¢ Dragging a scroll bar enables you to see the hidden
areas of 2 window. Another way to move a scroll bar
is by pointing to the empty area of the scroll box and
clicking the selection {left) button.

# Selecting a scroll arrow moves the viewing area of
the window in the direction of the arrow. Pointing to
a scroll arrow and holding down the selection {left)
button moves the viewing area more quickly.

& Selecting the close gadget removes a window from
the screen.
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Making Backup Copies of Disks

One of the most important things for you to do is to make
backup copies of all your disks. A backup copy is simply a
duplicate of an original disk. It is important to use the backup
as vour everyday working disk and to store the original disk in
a safe place. This way if the working disk is ever damaged, vou
can make another copy from the original disk.

Most application software allows you to make a backup copy.
Generally when you purchase a program, it includes a licensing
agreement. Be sure to read the agreement to learn exactly how
many copies you are aliowed to make. Making and distributing
unlicensed copies of disks is a copyright violation {zlso known
as software piracy] and is illegal.

To copy your Workbench2.0 and Extras2.0 disks, you need two
blank 3.5 inch disks that are write-enabled |able to accept
information}. This means that the small plastic tab in the
corner of the disk must be covering the hole.




When copying your disks, you’'ll notice that the Amiga often
instructs you to insert disks into specific disk drives. It refers
to these drives by their drive names. The Amiga’s internal disk
drive is known as DFQ.. If you attach an external drive to the
computer, that drive is known as DF1:. A second external drive
is DF2:, and so on.

If you tell your Amiga to copy the disk in DF1;, it will copy
whatever disk is in drive DF1:. {A colon must always follow
the drive name | Be careful when specifying a drive name when
saving or copying files. Make sure you know which disk is in
which drive or you could accidentally save or delete files on
the wrong disk.

When copying your disks, you will review most of the basics
that you have just learned. If you only have one floppy drive,
please read the next section. If a second floppy drive has been
added to your computer, skip ahead to the section titled “Using
Two Disk Drives,” on page 1-29.

Using One Disk Drive

When you use only one disk drive to copy your disk, the
system reads information from the Workbench2.0 disk {the
source disk) into the Amiga’s internal memory. Then, you have
to remove the Workbench?2.0 disk from the disk drive and
insert a blank disk [the destination disk). The information is
then written to the blank disk. This is known as a disk swap.
You may have to swap disks several times before the copy is
completed. The steps involved are outlined below.

1. The Workbench2.0 disk should be in the internal disk
drive, known as DFQ:.

2. Point to the Workbench2.0 icon, and click the selection
fleft) button.

Tutorial 1-25
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3. Hold down the menu (right) button.
The menu bar appears.

4. Point to the Icons menu, move the pointer down to the
Copy menu item, and release the menu button.

Horkbench  Hindow

Copy menu item _.

A requester appears and shows how many times you
will have to swap the disks. The number of swaps
depends on the amount of memory available to the
systern. If you have enough memory that cthe disk copy
will take fewer than 5 swaps, this requester may not
appear,
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Fewrr disk swaps are needed if
other tols are closed.
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5. Point to the Continue gadget, and click the selection
{left} button.

A second requester asks you to insert the source disk,
Workbench2.0, into drive DFO;, the internal disk drive.
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A cylinder is o phys-
ical division of a disk.
The 3.5 inch disks
used with the Amiga
have 80 cylinders

6. Since the disk is already in the drive, simply point to

the Continue gadget in the requester, and click the
selection (left) button.

The text in the requester will show how many cylinders
have been read and how many are left.

After the Amiga has read as much information as it can
from the source disk, a third requester instructs you to

aumbered 0-79, insert the destination disk into drive DFO:.
Make suge the disk drive light is out before removing
the Workbench2.0 disk from the drive.
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7. Put your blank disk into the drive, then select the
Continue godgel.

Point to the Continue gadget in the requester, and click
the selection {left) button. The data that was read into
memory is copied to the blank disk.
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To finish copying the disk, follow the requesters that
appear, and switch back and forth between the
Workbench2.0 disk and the backup disk as many times
as requested by the system. |Be sure the drive light is
out before removing a disk from the disk drive.) When
the copy is finally finished, the message Disk Copy
Finished appears in the requester.

8. Remove the backup disk from the drive and put an
adhesive label on it.

Write the name of the disk on the label.

The procedure is the same for copying the Extras2.0 disk
except for one small detail. After you choose Copy from the
Icons menu, a requester asks you to insert the Workbench2.0
disk into any drive. The Amiga must load the DISKCOPY
program on the Workbench2.0 disk before it can begin copying
the Extras2.0 disk.

At this point, be sure to use your original Workbench2.0 disk.
A second requester asks for the Extras2.0 disk, and from there
the procedure follows the steps outlined above. Always be
sure to read the exact text in a requester and follow the
instructions.

The backup disks are named copy._of Workbench2.0 and
copy—of_Extras2.0. You'll leam how to rename the disks on
page 1-34,

Using Two Disk Drives

When only one floppy drive is available, the system reads
information from the source disk (the disk that is being copied|
into the Amiga’s internal memory. Then the source disk is
removed from the disk drive, and the destination disk (the
blank disk| is inserted. The information in memory is then
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blank
disk icon

copied to the ‘blank disk. This is known as a disk swap. The
disks may have to be swapped several times, depending on how
much memory is available.

When you have a second disk drive added to your Amiga, you
can save time by putting the Workbench?.0 disk {the source
disk] into one drive and the blank disk (the destination disk|
into the other. This way the Amiga can copy directly from one
disk to the other. You do not need to swap disks, and the disk
duplication proceeds much faster. The steps involved are
outlined below.

1. Insert the Workbench2.0 disk into the Amiga’s original
internal drive, known as DFQ:,

2. Insert the backup disk into your second drive.

A new disk icon appears on the screen. Since it is

point, there is no information on the disk. Therefore,
the computer sees it as an unknown disk.

Horkbench2. 8
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3. Point to the Workbench2.0 disk icon, and press the
selection (Jeft} button.
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4. Continue to hoid down the selection (left) button, and

drag the Workbench2.0 disk icon over the icon for the
blank disk,

dragging
H I:lﬁ Workbench2 0

digk icon
DF17777!
-
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5. Release the mouse button.
A requester will ask you to insert Workbench2.0 into
drive DFQ: and to insert the destination disk into your
second drive.
s . e
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A cylinder is a phys-
ical division of a disk.
The 3.5 inch disks
used with the Amiga
have 80 cylinders,
Aembered 0 to 79.

6. Since the disks are already inserted, simply point to
the Continue gadget in the requester and click the
selection (left) button.

The Amiga will read the information on the
Workbench?2.0 disk and copy it to the destination disk.
A requester shows the number of eylinders that have
been copied and the number of cylinders left to be read.

7. When the disk copy is finished, make sure that both
drive lights ore out and remove the backup disk from
the drive.

8. Put an adhesive label on the new backup disk.
Write the name of the disk on the label.

The procedure is the same for copying the Extras2.0 disk
except for one small detail. After you drag the Extras2.0 disk
icon over the blank disk’s icon, a requester asks you to insert
the Workbench2.0 disk into any drive. The Amiga needs to
load the DISKCOPY program from the Workbench2.0 disk
before it can begin copying the Extras2.0 disk. A second
requester asks you to replace the Extras2.0 disk, and from there
the procedure follows the steps outlined above.

The backup disks are named copy_of_Workbench2.0 and
copy—of_Extras2.0. You'll learn how to rename the disks in the
next section,
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Quick Review

With one disk drive:

Select the icon for the disk to be copied. Choose Copy
from the fcons menu. You'll have to swap back and
forth between the source disk [the disk being copied)
and the destination disk. Follow the instructions in the
requesters that appear on the screen. When the Disk
Copy Finished message appears, wait for the disk drive
light to go out, then remove the disk from the drive.

With two disk drives:

Drag the icon for the disk to be copied over the icon of
the destination disk. A requester will appear
confirming that the disks are in the appropriate drives.
Select Continue, and the disks will be copied. Be sure
all disk drive lights are out before removing the disks
from the drives.
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Renaming Your Backup Disks

After copying your Workbench2.0 and Extras2.0 disks, you
should rename the backup disks, removing the words
copy_of_. from the names. To rename a disk:

1. Put the copy_of_Workbench2.0 disk in the disk drive.

2. Point to the copy_of _Workbench2.0icon, and click the
selection (left} button.

3. Hold down the menu (right) button, point to the Icons
menu heading, then move the pointer down to the
Rename menu item.

Rename is highlighted.
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4. Release the menu (right) button.

A requester will appear containing the words
copy.of_Workbench2.0.
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5. Delete capy-of_.

Move the cursor to the beginning of the text gadget. To

do this you can use the left cursor key, press Shift-left

cursor, or click on the C in copy. Then use Del to erase
copy_of . Each time you press Del, the character under
the cursor will be deleted.

Be sure to erase the underscore before the W,
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6. Press Return.

The requester disappears and the disk icon is now

named Workbench?2.0.

Follow the same steps to rename copy_of_Extras2.0 to

Extras2.0.
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Rebooting the Amiga

ctrl

Now that vou have a working copy of your Workbench2.0 disk,
you can reboot the computer with that disk. Reboot is the term
used to describe the process of resetting the Amiga without
turning the power off. Rebooting eliminates any data stored on
the Ram Disk and abruptly terminates any programs that are
nunning.

i. Insert your working copy of the Workbench2.0 disk

inte a disk drive.

If your Amiga has more than one floppy disk drive, it
does not matter which drive you use. Each drive is
checked for a bootable disk. {A bootable disk is one that
contains the files the Amiga needs to start operation.|

However, if a bootable disk is not found in any drive, the
animated screen is displayed. At this point, a bootab)e
disk must be inserted into drive DF0: in order for the
Amiga to boot. The Amiga will not check any of the
other drives after the initial search.

. Wait for the disk drive light to go out, then hold down

Ctrl {Control), left Amiga, and right Amiga.
All three keys must be held down at the same time.
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Just as you should never remove a disk from the drive
while the floppy drive light 1s on, you should also never
reboot or turn off the computer when a floppy disk or
hard disk drive light 15 on. Be sure to wait for all disk
activity to stop.

The Workbench screen will appear just as it did when you
booted with the original Workbench2.0 disk. Once you have
rebooted with your working copy of Workbench, store the
original disk in a safe place.

Using Application Software

Application software refers to the programs available for use
with your Amiga, such as databases, video and sound
programs, or educational packages. When you purchase
application software, be sure to read the documentation
included with the software to learn how to use the program.

Some application software is supplied on a bootable disk.
This means that you can insert the program disk into the
Amiga‘s disk drive, turn on jor reboot) the Amiga, and get
started. You usually do not need to use the Workbench2.0 disk.

Just as you made a backup of your Workbench2.0 disk, you
should always make a backup of your program disks. {Most
application software will allow you to do this, although some
programs may be copy-protected. Some programs may also
place restrictions on your right to make backups. Please
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consult your license agreement packaged with the application.)
Store the original program disk in a safe place, and use the copy
as your working disk. This way if anything ever happens to

damage the disk, you can make another copy from the original.

When you boot with a program disk, the program may
automatically start (this is common when loading games,
animated demonstrations, etc.], or you may be presented with
a Workbench screen. If a Workbench screen appears, you may
need to open the program disk icon, then another program icon
to get started. Again, this procedure varies, so be sure to read
the documentation packaged with the program.

No matter what type of application software you are using, you
will undoubtedly want te save your work. In general, itis a
good idea to save your work on disks other than the program
disks. You should also make a copy of your original program
disk{s}, and wse the copy as your working disk.

For instance, when using a word processing program, you will
want to keep your data files on a separate disk, or data disk.
Your data files contain the documents you create with your
word processor. One reason for using a separate disk is that
there may not be much extra room on the program disk.

Another reason is to safeguard your program disk against
accidental damage. If possible, you should keep the disk write-
protected. The small plastic tab in the comer of the disk should
not be covering the hole. This way you can’t erase or write over
any files stored on the disk.
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Formatting a Disk

Before you can store data on a disk, you must first format the
disk. The magnetic surface of a blank disk is one large
continuous area. When a disk is formatted, the Amiga’s
operating system [AmigaDQ8$) divides that area into
manageable sections $o that it can easily find stored
information. An easy way to do this is with the Format Disk
menu item in the Icons menu.

The following steps explain how to format a blank disk. You You can also ose For-
may want to try this now so that you know how to do it in the mat Disk to erase the
future. Or, you may want to come back to this section when conteats of a disk.
you need a formatted disk. It might be a good idea to format at

least one disk now, so that you have one readily available when

you need it.

1. Insert a blank disk into the disk drive.

The disk icon is labeled DFQ:2222. {If the disk is in an

of Rarkdesch

1)

% Disk

E

Horkbeach?. 9
[ blank
H disk icon
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2. Point to the disk icon, and click the selection (left)
button.

The icon will be highlighted.

3. Hold down the menu (right) button, point to the Icons
menu, move the pointer down to Format Disk, and
release the menu (right) button.

Kerkberth  Hindcu

Format Disk
menu item

I<I> €

T <iy

4. A requester will ask you to insert the Workbench2.0
disk in any drive. Insert the Workbench2.0 disk, point
to the Continue gadget, and click the selection (left)
button.

The Amiga must toad a program from the
Workbench2.0 disk before it can format the blank disk.

5. A requester asks you to insert the disk to be formatted
into the disk drive. Remove the Workbench2.0 disk,
and insert the blank disk. Point to the Continue gadget
and click the selection (left) button.
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Next, a requester asks you if it is OK to format the disk
in the disk drive. It also reminds you that any data on
the disk will be erased.

O to Format disk in alT=
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(all data will be srased) ?
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6. Point to the Continve gadget in the requester, and
click the selection (left) button,

Contlnue gadget
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Once the formatting process begins, you'll see text in the
requester showing the cylinder of the disk that is being
formatted and verified. When the disk is formatted, its disk
icon is labeled Empty. You can change this to any name you
like by using the Rename item in the [cons menu.

Organizing information on a Disk

To store information on a disk in a logicai manner, disks are
generally divided into drawers. Think of a disk as a filing
cabinet. You wouldn’t take all your papers and throw them into
the cabinet. You would put drawers in the cabinet. Then you
would organize the papers into folders and put the folders in
the drawers.
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A formatted blank disk does not contain any drawers. If you
were to store alt of your files an the formatted disk without
creating any drawers, it would be like throwing your papers
into the drawerless file cabinet. When you opened the disk
window, all the file icons would be in the disk window. If you
had many icons on the disk, you would have to screll through
the window until you found the correct icon. This could be
quite tedious and time consuming. Instead you should create
some drawers, then put your files into them.

Let’s assume that you have several business reports you want
to keep on disk. Perhaps for each month you produce several
reports pertaining to payroll, inventory, sales, office
expenditures, etc. Here's how you might organize them:

First, you should give your disk an appropriate name. For this
example, we'll name it Reports. To name the disk, use the
Rename item in the Icons menu.

L

Insert the formatted disk into the disk drive.
The formatted disk is labeled Empty.

. Select the Empty disk icon.

Poitit to the icon, then click the selection {left) button.

. Hold down the menu (right) button, point to the Icons

menu heading, then move the pointer down to the
Rename menu item.

Repame is highlighted.

. Release the menu button.

A requester containing the word Empty appears on the
screen. Use Backspace to erase the word Empty. Type
the name Reports.

. Press Returm,

The disk icon is now labeled Reports.



1-44 Tutorial

Next, you might create four drawers pertaining to the four
quarters of the year: Quarterl, Quarter2, Quarter3, and
Quarterd. You can create drawers with the New Drawer menu
itern in the Window menu.

1. Open the Reports disk window by double-clicking on
the disk’s icon.

The Reports disk window appears on the screen.

2. Select the Reports disk window, then choose New
Drawer from the Window menu.

A new drawer, labeled Unnamedl, appears in the
Reports disk window. A Rename requester also appears
t0 let you change the name of the drawer,

;. G936 graphuc: men TRAZEDT ubher mem ;
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Follow step 1 to create each additional drawer. Your window
would look like this:

Werkkbenon 2.8 95485 graphicy mam 143 sther mer

0] Workbench E”Q,J

Mo
Ran Disk r...‘=l_” {_‘E'-—]l

" “-; .9 Quarterd  Gwarterd
orkbench?. [T] w

b= gl

Ouarterd Trashean

You can store files in any of these drawers, but you might
also want to create some drawers within those drawers
corresponding to the difterent months of the quarter.

For example, within the Quarterl drawer, you might want
drawers for January, February, and March. Again, you can use
the New Drawer menu item.

1. Open the Quarter! window by double-clicking on its
drawer icon.

2, Select New Drawer from the Window menu.

A drawer icon labeled Unnamed1 will dppear in the
Quarterl window. A Rename requester also appears so
you can change the name of the drawer. For this
example, name the drawer January.
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Create two additional drawers tor February and March in the
same way. When you wanted to save the Sales report for
January, you would put it in the January drawer within the
Quarter] drawer.

r

0| Horkbench E”;gl
H 0] Reports 18% full, 192K free, B% in use E[@I
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e || =]
H Quarterd Quarterd
o o] Quarter] (o2}l
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Paths

When a program asks you for the name of a file, you must
specify the complete path to the file. The path specifies the
disk name, or location, and all of the drawers that lead to the
specified file.

The manner in which you refer to files varies from program to
program. Some programs may provide separate hoxes |called
text gadgets) in which you can enter the disk name, any drawex
names, and the filename. However, sometimes you may need
to enter the complete path on one line.
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To correctly reference the path, you must type:
1. The name of the disk followed by a colon. For instance,
Reports:

You can also substitute the disk’s volume name with the
disk drive name — DF0:, DF1:, or DF2:. However, if you do
this, be sure the correct disk is in the drive that you specify.

2. Toput a file in the disk window, not in a drawer, specify the
filename aiter the colon. For instance,

Reports:Sales

The icon for the Sales file would be in the Reports disk
window.

3. Toput the file in a drawer, you must first specify the drawer
name, followed by a slash, then the filename:

Reports;Quarterl/Sales

The icon for the Sales file would be in the Quarterl
window. You would first have to open the Reports window,
then the Quarter] drawer.

4. However, in this example, there is another drawer —
January. To put a file in the January drawer, you must
specify each drawer, followed by a slash, then the filename:

Reports:Quarterl/January/Sales

The icon for the Sales file would be in the January window.
You would first have to open the Reports window, the
Quarterl window, then the January drawer.

The chart on page 1-49 gives several examples of how to
determine path names.
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Quick Review

To correctly specify a path, you must type:

1. The disk name or drive name followed by a colon,
such as Reports: or DF0:.

2. The complete sequence of drawer names. Each
drawer name must be fotlowed by a slash.

3. The filename.

Naming Files

When choosing names for your files and drawers there are a few
rules you must adhere to:

® A filename can be up to 31 characters long.

¢ Colons (:) and slashes |/] are not allowed within the name.
They are reserved to separate disk names and drawer names
when specifying a path to 2 file.

® Beware of using spaces before or after filenames as they
are hard to see on the screen and can be confusing,

¢ Uppercase and lowercase differences between file names
are not recognized. This is known as case-indifference.
However, the Amiga will use the case you specified when
displaying the filename.

¢ You cannot have two files with the same name in the same
drawer. If you already have a file named Sales within the
Quarterl drawer, you cannot create a second file also named
Sales. The Amiga will replace the original Sales file with the
new file of the same name.

¢ You can have two files with the same name in different
drawers. For instance, you could have files named Sales both
in the January drawer of Quarterl and the Febniary drawer.
As long as the paths to the files are different, you will not
have a problem.
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Sample Path Chart

Reports
@ ‘
Quarter! Vendors
2 3 —_—I.—. 4
= E =
January Returns Income CashFlow
5
= =]
Sales Expenses
=
Rem

The chare above illustrates a typical disk arrangement. If you were to open the Reports disk icon,
you would see the Quarterl and Quarter2? drawers and the Vendors file in the Reports disk
window.

If you were to open the Quarter]l drawer, you would see the January drawer and the Returns and
Income files in the Quarter! drawer window. Open the Quarter2 drawer, and you would sce the
April and May drawers and the CashFlow file, and s0 on.

It is possible to have several files on one disk with the same name. For instance, in this example
there are three files called Sales. However, each Sales file is in a different drawer. So long as che
correct path to the file is specified, you do not have to werry about replacing one Sales file with a
different Sales file.

The list below shows the cotrect path to each of the files in the chart:

1 Reports:Vendors

Reports:Quarterl /Returns
Beports:Quarterl/Income
Reports:Quarter?/CashFlow
Reports:(Juarterl/january/Sales
Reports:Quarter2/April/Sales

Reports: Quarter2/May/Sales

Reports: Quarter2/April/Expenses/Rent

=N - SR R VN
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Chapter 2. Basic Operations

In the tutorial, you learned the basics about using your Amiga,
such as using the mouse to move the pointer, using menus, and
making backup copies of disks. This chapter reviews what you
leamned in the turorial and presents some more detailed
information explaining:

¢ the Workbench system

additional mouse techniques

how to respond to requesters

the features of the Workbench screen
special features of windows

standard gadgets used on the Amiga
the different types of icons

the four Workbench menus

Hf you were following the steps outlined in the tutorial, you
should have rebooted your Amiga with the backup copy of
your Workbench2.0 disk. If you are a new user and have not
read Chapter 1, you skould do so before starting this chapter.

The information in this chapter is presented in independent,
easy-to-reference sections. Each section contains both
explanatory text and, in most cases, a step-by-step
demonstration. For instance, if you need to know about a
particular gadget in a window, you can look in the “Windows”
section where there is a subsection explaining that gadget.

When you have finished with this chapter, you will be ready to
use the programs included on the Workbench2.0 and Extras2.0
disks.
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The Workbench System

The Amiga works with a screen/window/icon/menu/pointer
system that is available to all applications. This system is
known as the Workbench. Below is a brief explanation of each
of these elements:

pointer

icon

window

HorkbenchZ .8 i’ @ El-l

Hindow  Tions Ten.s

25

0 |Horkbemch?.§  96% f.ull, K frgc. 3% |D|.gl
| =] —=|

Thell Expansion Systen Moniters

sScreen ——————

I" WShartep  Mtilities m
Prefs ~

rashcan ]
1¢]>|A

<> C

LK

screen

An area of the display with the same video
attributes. This includes the number of pixels on
each line, the number of colors, and the color
palette. Screens are as big as the display area
jsometimes larger). Several screens can be open
at once.

window A rectangular area on a screen that can accept or

display information. Several windows can be open
on a screen at once, but only one window at a time
can accept information. Many programs are run in
windows. For instance, you can have a word
processing window and a spreadsheet window open
at the same time on the Workbench screen.



icon A small picture that represents disks, drawers, files
or programs stored on floppy disks, hard disks, or
on other storage devices.

menu A list of options from which you can choose a
specific operation, such as copying a file, renaming
zn icon, or organizing the contents of a window.

pointer An image that you can move across the screen by
moving the mouse. When you move the pointer
over an icon or to certain areas of the screen, you
can then use the mouse buttons to send a message
to the Amiga.

All of these elements combine to provide the icon-based
environment that you use to interact with your Amiga. It is
this environment that is known as the Workbench.

You can compare the Amiga Workbench to a carpenter’s
workbench. When a carpenter is building a cabinet, he spreads
his tools and his materials out upon his workbench and then
proceeds to build the cabinet upon that same surface.

In a similar way, the Amiga Workbench provides you with a
computerized work surface. Think of the pointer, menus and
windows as your tools and of the programs on the
Workbench2.0 disk, or any other application software, as your
materials. You use your tools and materials on the Amiga
Workbench to build or czeate a file, whether it’s a text file from
a word processing program, an animation file from a video
program, ot 2 data file from a spreadsheet program.

The main visual component of the Workbench is the
Workbench screen. Even if you are using a commercial
application, chances are that the first screen you see will be
the Workbench screen. Sometimes an application will start
with a specialized screen, but the Workbench screen is usually
present somewhere in the background.

Basic Operations
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The floppy disk that contains the basic Amiga software is
called the Workbench?2.0 disk, and when you open this disk the
window that appears is called Workbench2.0. This results in
several elements sharing the Workbench name, but they are all
parts of the Workbench environment.

Mouse Techniques

Click = press and
release

Hold down = press
continually

Point = mave pointer
Hp so that it is over an
object on the display

pointer

— 1

The mouse lets you communicate with your Amiga by moving
and positioning a pointer then pressing one of the mouse
buttons. Even though there are only two buttons, there are
many operations that you can perform.

When an instruction tells you to click the mouse button, it
means to press and release the button. Holding down the
mouse button means to press the button until you are told to
release it. To point to an icon, use the mouse to move the
pointer so that its tip is inside the icon’s box, as shown below:

]
Horkbench2 0
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In Chapter 1, the word right or left was specified in
instructions telling you to press a mouse buttor. Throughout
the rest of the manual, however, the buttons will be referred to
by their correct names. The left button is the selection button,
and the right button is the menu button.

The Selection Button

The left mouse button is the selection button. With this
button, you choose, or select, the icons, windows, or screens
that you want to use. You can also use the selection button to
move, or drag, items around the screen.

Selecting

You need to select an icon, window, or screen before you can
work with it. For instance, when an icon is selected, you can
make a copy of it, change its name, and even delete it.

All icons are surrounded by a box. When an icon is not
selected, the box appears raised above the screen or window
surtace.

When you select an icon, the box appears to sink into the
screen or window surface. Some icons may change color or
shape when selected. Drawer icons may change from a closed
drawer to an open drawer.
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selected

To select an icon:
1. Point to the icon.
Make sure the pointer tip is within the icon’s box.
2. Click the selection button.
The icon will change to show that it is selected.

Ho-kbench @8 940224 gqraphics men 949458 ciher nea

8| Morkbenth

2 el M . »
iLﬁ" Iil'l Iil]
Expansien  Systen Kenitors

Workbench2.§ “Shell

selected

== =

HBStartup  DRiLities ﬂ
Prefs

rashcan

E
| ) an

£y E—

1 <[}

If you click the selection button while the pointer is elsewhere
on the screen or window, the icon will no longer be selected
and will return to its original appearance.

To select a screen or window:

1. Click the selection button while the pointer is inside
the screen or window, but not over an icon.

When a window is selected, the frame surrounding the window
changes color. When a Workbench window is selected, the
frame of that window is highlighted and the amounts of
available memory are displayed across the top of the screen.
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Selecting Multiple lcons

At times you rmay want to select several icons at once. When
multiple icons are selected, you can treat them as a single
entity. You can delete, move, or copy the entire group in one
operation. There are three ways to select multiple icons: drag
selection, extended selection, and the Select Contents menu
itemn [explained on page 2-55).

Drag selection is a way to select several icons at once by using
the mouse to draw a box around them. To do this:

i. Move the pointer just outside of the outermost icon you
want to include in the box.

Do not let the pointer touch any icons.
2. Hold down the selection button, and move the mouse.

As you move the mouse, a dotted box will be drawn.
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3. When the box encloses the icons that you want to
select, release the mouse button.

All of the icons inside the dotted box will be selected.
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You can adjust the
time allotted for a
doable-click with the
Input Editor, ex-
plained on page 3-6.

Extended selection is useful when the icons you want to select
are not in a group that you can enclose in a box. To use
extended selection:

1. Select the first icon.
2. Hold down Shift.
3. Select the other icons.

While holding down Shift, point to each icon and click
the selection button.

4. Release Shift.
Each icon you have clicked on will be selected.

Double-clicking

Double-clicking means clicking the selection button twice in
rapid succession. When you point to an icon and double-click
the selection button, a window appears or a program is started.

Dragging
Dragging is the act of moving an icon, window, or screen.

Dragging an Icon

You can move an icon into another window by dragging it out
of the onginal window and into a new window. You can also
copy and delete icons by dragging them to certain areas on
the screen or in a window. {This is explained in the “Icons”
section.)
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To drag an icon:
1. Point to the icon.
2, Hold down the selection button, and move the mouse.
A copy of the icon will move with the pointer.
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3. Release the selection button when the icon is
positioned where you want it.
If you have selected several icons, you can drag all of the icons

at once. Hold down Shift, point to one of the icons, hold down
the selection button, and move the mouse. All the selected

icons will move as you move the mouse.
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Dragging a Window

When you have several open windows on the Workbench
screen, they may overlap each other. You can move the
windows around by dragging them. This helps you see the
information presented in all the windows.

To drag a window:

1. Point to the top border of the window, but make sure
the pointer is not over any of the square gadgets at
either corner of the border.

This area is known as the window’s title bar.
2. Hold down the selection button, and move the mouse.

An outline of the window appears and moves across the
screen.
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3. Drag the outline to where you want the window, then
release the selection button.

When you release the selection button, the window
appears in the new location.
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Dragging a Screen

It is possible to have more than one screen open at a time. For
instance, you can have your Workbench screen, a terminal
program screen that lets you communicate with other
cormputers, and a text editor open at the same time. You can see
parts of each screen by dragging them.

To drag a screen:
1. Point to the screen’s title batr.
This is the area across the top edge of the screen.
2. Hold down the selection button.
3. Move the mouse down.

To expose a screen, you can only drag the front screen down,
not up. However, if a screen is larger than the monitor’s display
area, you can drag it up or down or side-to-side so that you can
see all areas of the screen.

Am.ga™erm VB2 Terminal OK

title bar

0] Horkbench

]

Ram Disk

An alternative method for dragging a screen is to hold down
left Amiga, then hold down the selection button and move the
mouse up or down. It does not matter where the pointer is
positioned.
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The Menu Button

The right mouse button is the menu button and is used to
display menus and to choose items from them.

You can also use the menu button to cancef an operation that is
being performed with the selection button, such as drag
selection. Cancelling is described at the end of this section.

Using Menus

To see the available menus, hold down the menu button, and
menu headings will appear across the top of the screen. The
Workbench has four menus: Workbench, Window, Icons, and
Tools.

menu bar Homkbench  Wiedow  Trors Tools

Workbeachl. 8
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To see the items in a menu, keep holding down the menu
button and point to the different menu headings. When the
pointer touches any part of the heading, the available items
will be listed beneath the heading.
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To choose a menn item:
1. Continue to hold down the menu button.
2. Move the pointer down the menu.

As you point to each available menu item, it will be

highlighted.
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3. Whea the menu item you want to choose is highlighted,
release the menu button,

Not all menu items are available at all times. The unavailable
items are ghosted jnot displayed clearly| and will not be
highlighted when the pointer passes over them.

Sometimes menu items are ghosted because samething on the
screen needs to be selected. For instance, all the items in the
Icons menu are ghosted if an icon on the screen is not selected.
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Some menu items may have submenus. Submenus are
additional options that appear to the right of the menu item. (If
amenu item has a submenu there will be a > alter the item
name.} You must choose an aption from the submenu list to
use the menu item.

For instance, when you point to the Snapshot menu item in the
Windows menu, a submenu appears. You must choose either
Window or All to use Snapshot {explained on page 2-56).
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To choose an option from a submenu:
1. Point to the main menu item.

The menu item will be highlighted, and the submenu
will appear to the right of the menu item.

2, Keep holding down the menu button, move the pointer
to the first item in the submenu, then move down the
list to the item you want to choose.

The submenu item will be highlighted.
3. Release the menu button.

Cancelling

You can cancel an operation being performed with the
selection button by clicking the menu button while still
holding down the selection button. The following operations
can be cancelled: selecting, dragging, drag selection, and
changing the size of a window. Some examples of cancelling
follow.

If you have several icons selected, and you want to cancel the
selection of all of them, click on an empty area of the screen.

To cancel the selection of one icon:
1. Point to tlhe icon.

2. Hold down Shift and the selection button, then click
the menu button.

If you are dragging an icon or a window across the screen, and
you decide you want to leave it in its original location, click
the menu button before releasing the selection button. The
operation will be cancelled, and the icon or window will
remain in its original position.

You can cancel drag selection in the same way. If you are
selecting several icons, click the menu button without
releasing the selection button to cancel the operation. None of
the icons will be selected.
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=—= Using the Amiga without a Mouse =——

All mouse actions can be accomnplished with the keyboard.
You can use the keyboard to move the pointer, select icons,
and choose menu items. |A description of the keyboard can
be found in your Introducing the Amiga manual.) The chart
below outlines the keyboard methods:

Operation

Moving the
pointer

Selecting an icon,
window or screen

Dragging

Mouse Method
Move the mouse.

Point to an icon,
window or screen.

Click the
selection button.

Pointt to an icon or
title bar.

Hold down the
selection button.

Move the mouse.

Release the
selection button.

Keyboard Method

Hold down an
Amiga key and

a cursor key.
{Hold down Shift
to move the
pointer faster.)

Point to an icon,
window, or
screen.

Hold down

left Amiga and
left Alt.

Point to an icon or
title bar.

Hold down

left Amiga and
left Alt.

Use the cursor
keys to move the
pointer.

Release all keys.




Operation
Drag selection

Choosing a menu
item

Cancelling

Mouse Method

Hold down the
selection button.

Move the mouse
to draw a box
around the icons.

Release the
selection button.

Hold down the
menu button to
display menus.

Point to a
menu heading.

Pointto a
menu item.

Release menu
button.

Hold down menu
button while
selection button
is pressed.

Keyboard Method

Hold down lekt
Amiga and left
Alt.

Use the cursor
keys to move the
pointer to draw a
box around the
icons.

When the box is
drawn, release all
keys.

Hold down
right Amiga and
right Alt to
display menus.

Keep holding
down keys, and
use the cursor
keys to point to a
menu heading,

Keep holding
down keys, and
use the cursor
keys to point to a
menu ltem.

Release all keys.

Hold down right
Amiga and right
Alt while Jeft
Amiga and left
Alt are pressed.

The keyboard equivalent to clicking the left mouse button
is to press left Amiga and left Alt.

The keyboard equivalent to clicking the right mouse button
is to press right Amiga and right Ale.
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Requesters

Before you begin to examine the individual aspects of the
Workbench systemn, take a few minutes to learn about
requesters,

A requester is a small window opened by a program, like
Workbench, when it needs a response from you. You will come
across requesters repeatedly as you start to use the various
parts of the Workbench, like menus, windows and icons. When
a requester window appears, it is immediately brought to the
front of the display and is automatically selected.

Requesters are often the result of a menu choice. Several of the
menu items are followed by three dots {. . .} to indicate that
they generate requesters.

A requester will always contain text explaining what you
must do. Be sure to read the text in the requester before
selecting a gadget ot entering text.
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Action Requester

Some requesters ask you to choose between two options. For
instance, it may ask you if you are sure you want to proceed
with an operation or if you want to cancel the operation.

Disk(opy B o/
= ]

Put  SOURCE disk
( FROM disk ) in drive DFQ:

Conkgpwe 4 Cancel | action gadgets

—
Workbenchz . 8
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DR BUSY
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These requesters contain two action gadgets, One gadget lets
you proceed with an operation. It is usually labeled OK,
Continue, or Retry. The other gadget is a Cancel gadget and
stops the operation without performing any action. To choose
one of the optinns, select the appropriate gadget.

Keyboard Shortcut: To select the gadget that lets you proceed You can change these
{OK, Continue, or Retry}, press left Amiga-V. To select the keys with the ICen-

. trol editor exploined
Cancel gadget, press left Amiga-B. in Chapter 3. P
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Text Requester

Another type of requester is one that asks you to enter text.
This type of requester contains a text gadget, a rectangular box
that allows you to enter text. For instance, the following
requester appears when you choose the Rename menu item.
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When the requester appears the text gadget is automatically
selected. When you type at the keyboard, the text appears to
the left of the cursor {the small, highlighted box inside of the
text gadget).

If you click the selection button while the painter is
somewhere else on the screen, the requester may no longer be
selected. To enter your text, you will have to move the pointer
inside of the text gadget, and click the selection button.



Sometimes text gadgets will contain information that needs to
be changed. For instance, when you choose the Rename menu
item, the text gadget may contain the current name of the icon.
Some keyboard shortcuts for editing text within 4 text gadget

are listed below:
Del

Backspace

right Amiga-X
right Amiga-Q

Shift-left cursor
Shift-right cursor

Shift-Del

Shift-Backspace

Erases the character highlighted by
the cursor.

Erases the character to the left of the
CUrsor.

Erases all the text in the gadget.

Retrieves what was in the gadget
before the text was changed.

Moves cursor to the beginning of the
line.

Moves cursor to the end of the line.

Erases the character highlighted by
the cursor and all characters to the
right of the cursor.

Erases all the characters to the left of
the cursor.

When the text in the gadget is correct, press Return, {With
some programs, you may also need to select an action gadget.|
The requester will disappear, and the action will be carried out.
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File Requester

Another type of requester is one that allows you to enter the
name of a file. These requesters often appear so you can specify
a file from which to read or to save intormation.

A file requester usually contains a list of the files on the
Workbench or boot disk. To read through the list, drag the
scrall bar up or down or select the scroll arrows. Ii the file you
want to use is in a different drawer or on another disk, the
gadgets in the requester allow you to look for that file.

Select the Disks gadget, and a list of available floppy drives,
hard disk partitions and assigned volumes will be displayed.
[Assigned volumes are explained later in this manual )

Hanh enct Sireen

available drives _ﬂf”.': . :n:kh::r.h! '\ 7
A =
TUENY:
scroll bar ——" | ;
—
braver |
scrall arfows/ File | I
1 | Bisks | arent| (anulj
Rl T gk it R e .
1¢| >1-£|

To list the available files and drawers on a disk, point to the
disk’s name and click the selection button. The display will
change to list the files and drawers on that disk.
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If the file is in a drawer, point to the name of the drawer, click
the selection button, and a list of files in the drawer appears.
When the correct filename is displayed, point to the filename
and click the selection button.

When you select a disk or drawer from the list, its name
appears in the Drawer text gadget. When you select 2 filename,
it appears in the File gadget. You can also type the correct disk,
drawer and file names directly into the text gadgets. Click
inside the text gadget, and a cursor will appear. You can then
type the proper names.

The Parent gadget returns you to the parent drawer of the
currently displayed list of files. The parent drawer is the drawer
that is one level above the currently shown drawer. For
instance, if you're looking at a list of files in the Utilities
drawer, selecting the Parent gadget will return you to the list of
drawers and files on the Workbench2.0 disk.

Once the correct filename is displayed, select the OK gadget. If
you change your mind and want to exit the requester, select the
Cancel gadget.
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The Workbench Screen

title bar

The Workbench screen provides the background for your work,
Icons and windows appear on this screen.
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Title Bar

The top border of the screen is known as the title bar. When a
Workbench window is selected, the title bar shows the name of
the screen, as well as how much memory is available. Graphics
mem refers to available Chip RAM. The amount of Chip RAM
in your system determines how much memory is available for
graphics and digitized sounds. Qther mem refers to all other
available RAM including any expansion, or Fast, RAM.

When you hold down the menu button, the menu bar is
displayed. The menu bar lists the menu headings. Available
menu headings are shown clearly, while unavailable menu
headings are ghosted.



Workbench Window

When you boot your Amiga, the Workbench window fills the
Workbench screen. This window contains icons for any floppy
disks that have been inserted into a drive and the Ram Disk.
Depending on your system'’s configuration, it is possible that
there may be other icons in the window.

Although the Workbench window looks and acts like a
window, it is an essential part of the Workbench screen. When
the Workbench window is selected, the Workbench screen is
also selected.

Moving the Workbench Screen

Since the Amiga is multitasking, it is possible to have multiple
screens open ac the same time. For instance, you can be
running a graphics program on the Workbench screen and a
terminal program connecting you to an electronic bulletin
board on anather screen. In this case, you will have to move the
Workbench screen in order to see the other screen. There are
several ways to move the Workbench screen.

One way to drag the screen is by pointing to the title bar,
holding down the selection button, and moving the mouse.
Another way is to hold down left Amiga and the selection
button, point anywhere on the screen or Workbench window
and move the mouse up or down.

The small box in the upper right corner of the Workbench
screen is its depth gadget. You can click on this gadget to move
the Workbench screen behind or in front of other screens.

You can also move the Workbench screen with the keyboard.
Pressing left Amiga-N moves the Workbench screen in front of
all other screens. Left Amiga-M moves the front screen behind
all other screens.

Basic Operatlions
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You can customize
this action to a key of
your choice with tie
IControl editor ex-
plained in Chapter 3.

These keys cam also be
changed with the
[Control editor.
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Windows

Workbench2.0

A window is an area of the screen that displays and accepts
information. There are many different types of windows.
You've already seen the Workbench window that appears when
you boot your Amiga. Double-click on the Workbench2.0 disk
icon, and a window appears displaying the contents of the
Workbench2.0 disk.
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Many of the programs on the Workbench2.0 disk create
windows when their icons are opened. You may find that much
of the commercial software you purchase also opens windows.

New windows open on the front of the screen. While several
windows can display information simultaneously, only one
window at a time can accept information. This window is
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known as the selected, or active, window. When a window is
selected its border, or frame, is a different color from the other
windows on the screen.
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To select a window, point anywhere inside the window or its
title bar, and click the selection button. Clicking the selection
button while the pointer is outside of the window will
deactivate the window. It will no longer be selected.

When you have several windows open on one screen, it often Different programs
results in windows overlapping each other. When you want to "l‘::’ "{i{iﬂiﬂ:"’:‘; 3:‘;
look at the contents of a particular window, you may need to ﬁm' a um-quep gafl];get,
move other windows around so that you can see the one you it is usually explained
want. Most windows have gadgets to allow you to perform in the program docu-
these actions. Gadgets are the boxes and bars in a window’s mentation.

border. Some of the most common gadgets are explained in the
following sections.
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litle bar

Title Bar

Across the top of each window is a title bar that shows the
name of the window. For Workbench windows, the name will
be the same as the name of the icon that was opened to create
the window.

For instance, when you open the Workbench2.0 disk icon, the
window will have a title bar that looks something like this:

wor<beact DB 999950 graphivs msm 1RZRYI2 atber mer
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1,024 bytes

One megabyte (MB) =
1,024 kifobytes
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The information in this title bar identifies how much data is
on the disk. It states what percentage of the disk is full, how
many kilobytes are free {available for storage), and the number
of kilobytes that are in use for existing data.

When you open a drawer icon, the title bar only displays the
name of the drawer.

As explained earlier, you also use the title bar to drag a window.
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Zoom Gadget

Selecting the zoom gadget changes the size of a window. In
some cases, as with the Workbench 2.0 disk window, the
window becomes smaller.
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Selecting the zcom gadget a second time returns the window
to its previous size and position. If you change the size of a
window, the window will return to that new size and position
the next time it is zoomed in and back.

Depth Gadget )

When you have several windows overlapping each other on the
screen, you can move them back and forth with the depth
gadget. If 2 window is front-most on the screen (not obscured
by other windows}, selecting this gadget pushes that window
behind all the ather windows.
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depth gadgel — o SorowemTH

befure selecting

Selecting the depth gadget on any window other than the front-
most window, brings that window to the front. For instance, if
you have three windows open on the screen, selecting the
depth gadget of the middle window will bring it to the front of
the screen.

Horkbengn 7 B %45464 grapn (s =em S58930 gther non
JE|E|=|
H' o] Wilities
wf
: I 1l
Ram Disk 0| Nerkhimchl 4 905 J0EC DN - o

IF)

Workbench? . @

P = _|

Shell Tysten  Westartup  Momiters

| 20 =] =]

depth gadget

atter selecting

: Utilities Expansion m
Prefs

<ol B

Horkhencr .8

0| Workheneh

Ran Disk @ N

_rj’ﬂ (latk Hore 'E

Morkbenchz. ¥ !|

depth gadget

Bisplay Sav

If you hold down Shift and select the depth gadget, the window
will move behind all the other windows.
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Scroll Gadgets

Sometimes a window is not large enough to show all of 1ts
icons. You can see the window’s contents without changing its
size by scrolling the window. Scrolling refers to moving the
viewing area of a window so that you can see unexposed icons.

Most windows have two scroll gadgets, one along the right
edge of the window and one along the bottom. The scroll
gadget is mace up of a scroll box, a scroll bar, and scroll arrows.
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The scroll bar is the highlighted rectangular area inside of the
scroll box. The size of the scroll bar indicates how much of the
window is visible, If the entire window is visible, the scroll bar
fills the entire scroll box. However, if the scroll bar only fills
half of the scroll box, only half of the window is visible. By
dragging the scroll bar to the empty area of the scroll box, you
can see the obscured icons.

The position of the scroll bar reflects which portion of the
window is visible. For instance, if the scroll bar is in the upper
half of the vertical scroll box, you can see the icons in the top
of the window.
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To drag a scroll bar:
1. Point at the scrolf bar.
2. Hold down the selection button.
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3. Use the mouse to drag the scroll bar to an empty area of
the scroll box.

The viewing area of the window will move in the same
direction as the scroll bar.

Another way to move the scroll bar is to point to an empty area
of the scroll box and click the selection button. The scroll bar
will move to the area where you have pointed.

You can also use the scroll arrows to scroll the viewing area of
a window whether or not all the icons are visible. This can

expose empty areas of the window into which icons can
be moved.



To use a scroll arrow:
1. Point to a scroll arrow,
2, Click the selection button.

The viewing area of the window will shift in the
direction of the arrow.

To move the contents more quickly, hold down the selection
button while pointing to a scroll arrow.

Sizing Gadget 4
As its nams implies, the sizing gadget lets you change the size
of the window — making it larger or smaller as needed.
To change the size of 2 window:

1. Point to the sizing gadget.

2. Hold down the selection button, and move the pointer
towards the upper left corner of the screen.

The window will become smaller.
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3. Point to the gadget again, hold down the selection
button, and move the pointer towards the fower right
corner of the screen.

The window will become larger.
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When you have sized the window, release the selection
button.

You can cancel the sizing operation by pressing the menu
button before releasing the selection button,
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Close Gadget [0]

Selecting the close gadget closes the window. When you are
through working in a window, select the close gadget, and the
window will disappear.
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It you select the close gadget on the Workbench window, a
requester will ask you if you really want to quit the
Workbench. If you select OK, all Workbench functions will be
closed, including any Shell windows started from an icon. You
cannot close the Workbench if you have any programs
running.

In order to leave a Shell window open, you must start one with
the NEWSHELL command. There are two ways to do this:

1. Open a Shell from the icon, then type NEWSHELL at
the prompt.

2. Use the Execute Command menu item in the
Workbench menu.

Type NEWSHELL in the text gadget.

To get the Workbench back, type LOADWB jload Workbench) at
the Shell prompt and press Return.
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Additional Gadgets

In previous sections, you leamned about the various gadgets
that appear in requesters and in the borders of Workbench
windows. However, there are several other types of standard
gadgets used by Amiga programs. You will encounter these
gadgets as you proceed through this manual and learn about
the programs on the Workbench2.0 disk. This section briefly
describes these gadgets and how to use them. When a gadget 15
used in a program window, the documentation explaining that
program will also explain the exact function of the gadget.

NOTE: Many of the examples used in this section refer to
editors in the Prefs drawer. Don't worry if you do not
understand the concept behind an editor; they are further
explained in Chapter 3, "Preferences”. Right now you should
only be concerned with learning how to use the different types
of gadgets.



Check Box

v

Check hoxes let you turm an option on or off. For instance, the

Input editor uses a check box to allow you to turn on the

Acceleration option.
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When the option is on, the box contains a check mark. if the

option is off, the box is empty.
To change the setting:
1. Point to the check box.

2. Click the selection button.
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Cycle Gadget

A cycle gadget lets you select one option from a list of options.
The complete list is not shown, only the selected option is
displayed. For instance, the Printer editor contains cycle
gadgets that let you select your printer specifications.
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To see the available options:
1. Point to the cycle gadget and click the selection button.
The next option in the list will be displayed.
2. Keep clicking the selection button until you return to
the first option that was displayed.
When you return to the first option, you will know that
you have read through all the available choices.
To select an option:

1. Keep selecting the cycle gadget until the option you
want to use is displayed.
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Radio Button @

A radio button also allows you to select one option from a list.
However, in this case, the entire list is visible and each option
has a radio button next to it. For instance, the Serial editor uses
radio buttons to let you select the appropriate settings for
sending information through the serial port {fully explained in
Chapter 3).
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The radio button next to the selected option will be
highlighted, and it will appear that the button has been pushed
into the screen. The other buttons in the list will remain one
color and will appear to be raised above the screen.

To select a radio button:

1. Point to the radio button next to the option of your
choice.

2. Click the selection button.
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Scroll Gadget

Scroll gadgets used within windows ate very similar to the
scroll gadgets contained in the border of the Workbench
windows.
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However, this type of scroll gadget allows you to select from
options displayed in the scrolling list. It may also have a
display box or text gadget underneath the scrolling list that
shows the selected option.

The scroll gadget shown above 1s from the ScreenMode editor.
This gadget allows you to choose the type of screen display you
will use.

A scrol] gadget can only show a limited number of options

at a time, but there may be many more from which you can
choose. The available choices will be shown in the scroiling
list. You can tell if all the options are shown by looking at the
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scroll bar. If all the options are visible, the scroll bar fills the
entire scroll box. if the scroll bar only fills part of the scroll box,
not all of the options are visible.

To scroll through the options:
1. Point to the scroll bar.
2. Hold down the selection button.

3. Move the mouse so that you drag the scroll bar through
the scroll box.

To choose an option:

1. Scroil through the list until the option you want to
choose is displayed.

2. Point to your choice.
3. Click the selection button.

Your choice will be highlighted. When you release the
button it will appear in the display box or text gadget
underreath the scroll area.

A display box 1s a rectangular box, similar in appearance to a
text gadget, but you cannot enter information in it. A display
box only reflects the choice you made with the scroll gadget.

When a text gadget is underneath the scroll gadget, you can
sometimes enter a choice not displayed in the scrolling list,
such as a new filename for saving information.

Whether or not the scroll gadget uses a display box or text
gadget depends on the individual program.
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Selection Gadget

A selection gadget lets you select from several displayed
options. The Palette editor uses a selection gadget to let you
select a color to change.
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In this case, you simply point to the color you want to use, and
click the selection button. The selected option will appear in
the display box to the leit of the selection button.



Slider Gadget

Slider gadgets allow you to select a value within a given range.
They are similar to scroll gadgets in that you drag a slider bar
through a slider box to select a specific value.

Basic Operations

2-43

mtl ?rehﬂnus Eil@l
R!II
freen: ] t
Blue: §-of— ‘
Save | Use | Cancel |
2
I 3¢5/

The sliders shown above allow you to change the colors of the

Workbench.

The slider value is shown to the left of the slider. This is the
value associated with the current position of the slider bar.

To change the value:

1. Point to the slider bar.

2. Hold down the sefection button and move the mouse to

the right or left.

The slider value will change as the bar moves.

3. When the desired value is shown, release the selection

bution.

glider box
glider bar
slider value
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Icons

Icons are pictures on the screen that represent disks, drawers,
and files. Icons provide quick access to information stored on a
disk. The Workbench uses several types of icons:

i
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A disk icon represents any disk that
is available or accessible by the
Workbench. Disk icons are located
in the Workbench window. When
you open a disk icon, a window
appears on the screen.

A drawer icon represents a
subdivision of the disk storage area.
When you open a drawer icon, a
window appears.

A tool icon represents a specific
program. For example, the Clock
icon in the Utilities drawer is a tool.
When you open a tool icon, the
program is started.

A project icon represents a file
where information created or

used by a tool is stored. The
Mode_Names icon in the
WRStartup drawer is an example of a
project. When you open a project
icon, the associated tool, if any, is
also opened. The tool will then
begin to operate on the project.

The Trashcan represents a place on
the disk that is used to store
unwanted items until you choose to
remove them from the disk.
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Every icon on your screen, whether it’s a disk, drawer, project,
tool, or trashcan, has a corresponding file that contains the
information that produces the icon’s image. These files are
called .info files.

For instance, the Clock icon, in the Utilities drawer, represents
the Clock program. There are two files in the Utilities drawer:
Clock, which contains the data to run the program, and
Clock.info, which contains the data that creates the Clock
icon.

The Workbench Menu

The Workbench menu pertains to the Amiga‘s general
operations as well as to all open windows on the Workbench
screen. You can use the Workbench menu to update the screen
display or see which version of the software you are using.

A [rnse Togls

Workbench menu

Horkbench2 8
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To the right of many of the menu items are keyboard shortcuts.
These shortcuts allow you to choose the menu item without
using the mouse. Simply hold down right Amiga, then press
the specified letter key. You do not have to use the mouse at all.
In this manual, the keyboard shortcuts are shown along the
right margin.

Backdrop AB

When yeu choose Backdrop, the Workbench window
disappears and the disk icons appear on the Workbench screen.
The disk icons are no longer in a window. This is useful when
you have several windows open, and you need to move through
them frequently. It eliminates the need to keep moving the
Workbench window out of the way.

Horkbencs i 8 558776 qraphoc: ~en 93BG ohar nes

7|

Ran Disk

H w

Nerkbenchi. b

backdrop ———»

When Backdrop is chosen, a check mark appears to the left of
the menu item. To return to the Workbench window, choose
Backdrop again. If you choose Backdrop, then turn off or reboot
your computer, the Workbench window will reappear. To save
your Backdrop selection, use the Snapshot menu item in the
Windows menu (explained on page 2-56).



Execute Command... AE

NOTE: This menu item is provided for users who are familiar
with AmigaDOS.

This menu item allows you to execute {start} an AmigaDOS
command without opening a Shell window. {Some basic
AmigaDOS commands are explained in Chapter 7,
“Introducing AmigaDOS.") When you choose Execute
Command, 4 requester prompts you to enter the command and
its arguments.

[
o
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Ein Fisk Enter Command
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Comnand: E_ | |
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When you type the command, it appears in the requester’s text
gadget. After you've entered the command, select the OK
gadget [or press Return) to execute it. If you select the Cancel
gadget, the requester will disappear without executing the
cormmand.

texi gadget
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Workbench Qutput
Window

In cases where the command results in output, the Workbench
Output Window is automatically opened on the front of the
screen.
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The window will remain on the screen until you select its
close gadget.

1f you choose Execute Command a second time, the text gadget
will display the previousty entered command. You must delete
the old command before entering a new command. The output
will be shown in 2 new Woarkbench Output Window, even if
another output window is already open on the screen.

Redraw All

Redraw All redraws all open windows on the Workbench
screen in case of a disturbance to the Workbench. On rare
occasions a program may cause part, or all, of the screen to be
disrupted. If this occurs, choosing Redraw All may help to
restore the windows to their proper appearance.



Update All

Update All redraws each open window, updating its appearance
to reflect the current state of the window. If you are only
communicating with the Amiga through the Workbench, you
probably will not use this menu item too often. However, if
you are using both the Shell and the Workbench, you will find
this option quite helpful.

If you have several windows open and have been using the
Shell to make changes to the contents of the disk, the changes
will not be immediately reflected in the windows. For
instance, if youu were using the Shell to delete files and their
icons, the icons would remain in the windows until you closed
the windows and re-opened them, or chose Update All from the
Workbench menu.

Last Message

Sometimes you will see a message flash across the title bar; it
may be either an information or an error message. Some
examples of common error messages are: object not found
(the file you are looking for is not on the disk}, disks are
incompatible types (appears if you try to drag a floppy disk icon
over the Ram DDisk icon or hard disk icon), the Trashcan cannot
be moved (appears if you try to drag the Trashcan out of its
window).

Some messages flash briefly, others remain until you press the
selection button. In order to see the last message, select the
Workbench window and choose Last Message from the
Workbench menu. The message will be shown in the title bar.
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About

The About menu item opens a requester which shows the
internal version number of the Workbench and Kickstart
software as well as copyright information. Select the OK
gadget to close the requester.

Quit. .. AQ

This operation is not recommended unless you are an
experienced Shell user.

Quit allows you to close all Workbench operations. The only
reason you may need to do this is if you do not have enough
RAM to run a particular application program. By closing the
Workbench, you will make additional RAM available.
However, if you do this, you should leave a Shell window open
so that you can reopen the Workbench later, {This is explained
at the end of this section.)

If you have any Workbench programs running when you
choose the Quit menu item, an error message will flash in the
title bar of the screen. The message will state that the system
cannot quit as there are Workbench programs launched. It will
also state the number of launched programs.

If you still want to Quit, you must shut down all programs.
Disk and drawer windows can remain open. Once all programs
are terminated, you can choose the Quit menu item. This
time, a requester will ask if you want to quit the Workbench.

If you select OK, all Workbench windows and icons will
disappear, and you will not be able to access any of the
Workbench menus. The only way you will be able to
communicate with the Amiga is through a Shell window that
was opened with the Execute Command menu item or through
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another Shell. A Shell window opened from the Shell icon is
considered a Workbench program, and you cannot use Quit if
the window is open.

3
I

bo you really want

to ait workbesch? | Quit requester
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f

Workbench2.8
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To quit the Workbench and leave a Shell window open, use the
Execute Command menu item:

1. Choose the Execute Command menu item.
A requester will appear on the screen.
2. Type NEWSHELL in the requester, and press Return,
A Shell window will open.
Since this new Shell window was started from a typed
command, instead of from an icon, this window will remain
open when the Quit menu item is chosen. To get the

Workbench back, type LOADWS {load Workbench) at the Shell
prompt, then press Return.

It you do not leave a Shell window open, you have to reboot the
Amiga to return to the Workbench system.
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The Window Menu

The Window menu is only available when a window on the
screen ts selected. The options in the Window menu pertain to
the active window. For instance, vou can use the window
menu to organize the contents of a window or to change the
way the information is displayed.

Window menu

Some of the menu iterns have keyboard shortcuts which are
shown to the right of the item. To choose a menu item with the
shortcut, press right Amiga and the specified letter key.



New Drawer AN

New Drawer allows you to create a new drawer in the active
window, The drawer is automatically labeled Unnamed]. This
is a convenient way to create drawers for file storage.

To create a New Dirawer:

1. Select the window in which you want to create the
drawer.

2. Choose New Drawer from the Window menu.

A new drawer icon, labeled Unnamedl, will appear in

the window.
Hor<henck Sc-een =
o] Morkbench |
h’ Enter 3 new aame for *Umnanedi’.
Ran Bisk New Hame: vt
, ane: [innan !‘ ]
m x| _Cancel |
Horkbenthl.§
. o) bats B full, BIK free, X in use IEIE
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You cannot creoie a
new drower in the
Workbench window.

new drawer

Unnanedd

| N e— — 1

Traslu:an

1<>[d]

3. A Rename requester appears to allow you to change the
name of the drawer.

Delete the existing name, type in the new name, and
press Retum.
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Open Parent

Except for the Workbench window, every window has a parent
window. The parent window is the window that contains the
icon that was opened to create the current window.

For instance, the Workbench window is the parent of all the
disk windows. The Workbench window contains the disk
icons that must be opened in order for the disk windows to
appear.

Disk windows often contain drawers. When you open a drawer
icon, a window appears. Theretore, the disk window is the
parent of the drawer window.

For example, the Workbench?.0 disk window contains the
Utilities drawer. When you double-click on the Utilities
drawer icon, the Utilities window is opened. The
Workbench?2.0 disk window is the parent of the Utilities
window,

Choosing Open Parent brings the selected window’s parent to
the front of the display. If the parent window is closed, it is
automatically opened.

For instance, if the Utilities window is selected and you choose
Open Parent, the Workbench2.0 disk window will be
automatically opened (if 1t was closed) and brought to the front
of the display. If the Workbench2.0 disk window is selected and
you choose Open Parent, the Workbench window will be
brought to the tront of the display.

To open the parent of a window:
1, Select the window.,
2, Choose Open Parent from the Window menu.
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Close AK

To remove the active window from the screen, choose Close.
1. Select the window.
2, Choose Close from the Window menu.
The window will disappear.

Mouse Shortcut: A shortcue for closing windows is to select
the close gadget in the upper left corner of the window.

Update

It you make changes to the contents of a window through the
Shell or the Execute Command menu item, those changes
will not be reflected in the window until you either close and
re-open the window or choose the Update menu item. Update
redraws the active window so that it accurately reflects the
contents of the window.

{This is very symilar to the Update All menu item in the
Workbench menu, except that Update only affects the
currently selected window.|

Select Contents AA

When you choose Select Contents, all of the icons in the active
window are selected. This is an alternative to drag selection or
extended selection.
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Clean Up

Clean Up rearranges the icons in a window in an orderly
fashion. When icons are copied or created, they sometimes
appear on top of another icon or in a separate area of the
window. Clean Up automatically places all the icons in the
active window in a neat arrangement, so that you do not have
to arrange each icon individually. '

Clean Up does not save the arrangement to disk. If you only
clean up a window, but don’t save it with the Snapshot menu
item [explained below), the arrangement will be lost the next
time you open the window.

To Clean Up a window:
1. Select the window you want to rearrange.
2. Choose Clean Up from the Window menu.

Snapshot p

Snapshot lets you save the arrangement and position of a
window. It 1s commonly used after Clean Up. When you point
to the Snapshot menu item, two submenu items appear:
Window and All.

Snapshot Window lets you save the position and size of the
active window as well as the Show and View By modes
jexplained in the following sections). However, it does not save
the position of the icons in the window.

To save the placement of a window:
1. Select the window.
2. Choase Snapshot Window from the Window menu.

Snapshot All lets you save the positions of all the icons as weil
as the position and size of the active window. Whenever you
open the window, it will be arranged in the same way.



To save the placement and the arrangement of 2 window:
1. Select the window.
2. Choose Snapshot All from the Window menu.

Show >

Not every file on a disk or in a directory has a corresponding
icon. The Show menu item allows you to see all the fileson a
disk, whether or not they have icons. Show has two submenu
items: Only Icons and All Files,

Choosing Show All Files displays a pseudo-icon for each file or
drawer in the selected window. {A pseudo-icon is a temporary

icon supplied by the Workbench for files that do not have their
own icons.] You can treat these pseudo-icons just like any other
icon and use the menu items in the Icons menu to manipulate
the icon.

To display icons for all the files in a window:
1. Select the window:,
2. Choose Show All Files from the Window menu.

mor<herch 2od o EML grgphios mem 301524 abver men

o] Horkbench 1Ellg

IIITH%T!I:

= =] =1
o= = e
Workbench?. 8 ri] =] || Trashcan [-?H »

s Systen = I

Prefs IE I [ =

=1 T | R T

Basic Operations

2-57

Pseudo-icons do not

have .info files.
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afler choosing

Show Only Icons displays only those files and drawers which
have icons {.info files). All pseudo-icons will be removed from
the window.

To display only the real icons:
1. Select the window.
2. Choose Show Only Icons from the Window menu,

Only the window’s real icons will be displayed.
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View By >>

The View By menu item allows yvou to change how the
information in a window is displayed. View By has four
submenu itemns: Icons, Name, Date, and Size.

When you choose View By Icons, the window appears in its
default state.

Choosing View By Name changes the window display. The
window will contain an alphabetical list of the icons. This list
includes the size of the file, its attributes {whether it can be
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read, deleted, executed, or written), and the date it was created.
{See the explanation of the Information menu item, page 2-70,
for details on attributes.|
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You can select files and drawers from the window just as you
would select an icon. Simply point to the file or drawer name,
and click the selection button. The name will be highlighted to
show that it is selected. You could then use menu items in the
Icons menu to manipulate the file or drawer. To open a file or
drawer, point to the name, and double-click the selection
button.

View By Date sorts the list in chronological order, with the
most recently created file listed first. This is helpful if you have
two different versions of a file and are looking for the one with
the most current information.

View By Size sorts the list by size, with the smallest file listed
first. If you find that you are running out of room on your disk,
you can use this option to see which files take up the most
space. You can then choose which files to delete or to move to
another disk.
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The Icons Menu

lcons menu

The Icons menu lets you work with the icons on the screen.
Among other things, you can copy, rename, and open icons
with this menu. You can also delete icons, and the
corresponding files or drawers, from the disk. An icon must be
selected before you can choose items from this menu.

Ram Disk
—_—

BRSO

Herkbench?, 8

Open AO

To open an icon is to make the items represented by the icon
available for use. When you open a disk or drawer icon, a
window appears on the screen displaying the icons contained
on that disk or in that drawer. When you open an individual
project or tool, you actually start the corresponding program.

To open an icon:
1. Select the icon.
2. Choose Open from the Icons menu.

Mouse Shortcut: A shortcut for opening icons is to point to the
icon and double-click the selection button.



Copy AC

Copy allows you to copy disks, drawers, programs, or files. A
copy of a drawer, tool, or project is made in the same window as
the original. {To copy a drawer, tool, or project to another disk,
see the “Copying by Dragging” section, page 2-65.|

An important use of Copy is for making backup copies of your
disks. I your Amiga only has one disk drive, this is the most
common way to copy disks using the Workhench.

To copy a disk:

The disk that is being copied is known as the source disk
(FROM disk). You should always write-protect your source disk
s0 that you cannot accidentally erase any of its contents. (The
write-protect tab should be pushed towards the top of the disk
so that the small hole is uncovered.|

The disk that you are copying to is known as the destination
disk (TO disk!. This can be a blank disk or a previously used
disk whose contents you no longer need. This disk must be
write-enabled in order to accept the information from the
source disk. (The write-protect tab should be covering the
small hole in the corner of the disk.|

When you use the Copy menu item, the system will read a
certain amount of information from the source disk into the
Amiga’s internal memory. Then you will have to take the
source disk out of the disk drive and insert the destination
disk. {This is known as swapping disks.] The Amiga will then
copy the information to the destination disk.

1. Put the disk you want to copy, the source disk, into the
Amiga’s internal disk drive, known as DF0..

Make sure the write-protect tab is in the protected
position. The small hole in the comer of the disk should
be open.
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When you duplicate o
disk using the Copy
menu itea, the Amiga
only uses ome disk
drive even if you have
a second drive con-
nected to yoar Antiga.
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2. Select the source disk’s icon.
Point to the disk icon, and click the selection button.
3. Choose Copy from the Icons menu.

A requester will ask you to insert the Workbench2.0 disk
in any drive. The system needs to read a program from
the Workbench?.0 disk before it can begin the copy
procedure,

4. Insert the Workbench disk.

If the disk copy is going to require several swaps {5 or
more), a requester will tell you how many times you will
have to swap the disks.

biskCoy ;-
o ja|[<)

Narning: This will take 5 swaps.
Fewer disk swaps are meeded if
other tools are closed.

Continue gadget ————« {onkinue Cancel
Horkbench2, 8
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Closing any unnecessary windows or stopping any
unneeded processes will help to reduce the number of
swaps.

If the disk copy requires fewer than 5 swaps, you will not
see a requester.



5. Select the Continue gadget in the swap requester.

A requester tells you to insert the source disk into drive
DFO:, the internal drive.

Put  SOURCE disk
{ FROM disk } in drive DF§;

(ong En [ w Cancel
T

=

Workbench2, ¥ \\
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6. Put the disk you want to copy in the drive, then select
the Continue gadget.

Text in the requester will reflect how many cylinders the
system has read and how many are left to read. (A
cylinder is a division of a disk. The 3.5 inch disks used
with the Amiga have 80 cylinders numbered 0-79.)

A requester will instruct you when to insert the
destination disk into drive DF0:.

Make sure the disk drive light is out before removing the
source disk from the drive.

Continue gadget



2-64 Basic Operations

8] [=]
Put  DESTIMATION disk
¢ T disk ) in drive DFD:
Continue gadget ———— (ongiuel o Cancel
—
Horkbench2. ¥
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If at some point 7. Put your destination disk into the drive, and select the
you want to stop Continue gadget.
the copying pro-
cess, wait for a The data from the source disk will be copied to the
Swap requester destination disk.
to appear and se-
lect the Cancel You will have to follow the requesters and switch back
gadget. and forth between the source disk and the destination

disk as many times as stated in the first requester. (Be
sure the drive light is out before ejecting a disk from the
disk drive.] When the copy is finally finished, the
message Disk Copy Finished appears in the requester.

8. Remove the destination disk from the drive and put a
label on it.

The destination disk's icon will now have the source
disk’s name with a copy_of__ prefix. For instance, if
the source disk was called DataDisk the destination disk
will be called copy__of _DataDisk.



To copy a drawer:
1. Select the drawer icon.
2. Choose Copy from the Icons menu,

The copy of the drawer, and any icons contained in the
drawer, will be made in the same window as the original
drawer.

To make 2 copy of the drawer on another disk, see the
“Copying by Dragging" section.

To copy a project or tool:
1. Select the icon.
2. Choose Copy from the Icons menu.
A copy of the icon will be made in the window.

Copying by Dragging

You can copy a disk by dragging the source disk’s icon over the
destination disk’s icon.
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copying Files drawer

to Data disk

You can copy a drawer, project or tool to another disk by
dragging the icon over the other disk icon or into the other
disk’s window. The original icon will stay on the original disk,
and a copy will be created in the destination disk’s window.
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You cannot make a copy of an icon on the same disk with this
methad. For instance, if you were to drag an icon from the
Utilities window into the Systerm window, it would not be
copied. The icon would simply change drawers. It would move
from the Utilities drawer to the System drawer.

You can copy several icons at once by using drag selection or
extended selection. When the icons you want to copy are
selected:

1. Hold dewn Shift.

2. Point to one of the selected icons, then drag it over the
other disk’s icon or into the other disk’s window.

As you drag one icon, the rest will follow.



Rename... AR

You can change the name of an icon with the Rename menu
item. A common reason for using Rename is to remove the
copy_of_ prefix from a newly created icon. You may also.
want to change the names of your disks and files as you create
more files. For instance, if you onginally created a disk called
Reports and it is starting to get full, you may want to change its
name to Reports1990. You could then start a new disk named
Reports!99].

To rename an icon:
1. Select the icon.
2. Choose Rename from the Icons menu.

A requester with a text gadget will appear and show the
current name of the icon.
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You can also
press right
Amiga-X to
erase every-
thing in the
text gadget.

3. Enter the correct name.

You will have to delete the old name {use Backspace) and
enter the new name. Be sure to delete any spaces before
or after the new name.

4. Press Return.

The requester will close, and the new name will appear
under the icon.

When renaming icons be careful not to leave any spaces before
or after the new name. These will be impossible to discern on
the screen and will cause confusion if you ever need to type the
icon’s name.

Information. .. Al

Choosing Information results in a window displaying
information about the selected icon. The contents of the
window vary depending on the type of icon.
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Chock (Tool) Script
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This information includes the icon’s:

name The type of the icon is shown in
parentheses. The permissible types
of icon are disk (or volume], drawer,
project, trashcan or tool.

image A picture of the icon is displayed in
the center of the window.

size The number of blocks and bytes that
the disk, project, or tool fills. [This
does not apply to drawer icons ]

stack The amount of memory reserved as
temporary storage for a specific tool.
{This does not apply to disk or

drawer icons.)
last changed date Indicates when the item represented If your Amige does not
by the icon was created or the last bave a bottery

backed-up clock, you
must first set the cor-
rect time with the
Timte Prefs editor, ex-
plained in Chapter 3.

time it was changed.
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For a disk icon, the window also shows whether the disk is
write-enabled (Read/Write] or write-protected (Read Only). If
the disk is Read/Write, you can both read information from the
disk and save new information to it. If the disk is Read Only,
you can only read information from it.

For a drawer, project, or tool, there are six independent
attributes that you can select. When an attribute is selected,
there will be a check mark in the box to its right. To select, or
deselect, an attribute, point to its check box and click the
selection button. Each attribute is explained below:

Script

Archived

Readable

Writable

Executable

Deletable

[f this attribute is selected and the
program is executed through the
Shell, it will be run as a script [a text
file of AmigaDOS commands).

This attribute is set by some backup
programs to let you know that a file
or directory has been saved, or
archived.

If this attribute is selected, you can
read, or access, the information in a

fle.

If this ateribute is selected, you can
write information to the file. Iif it is
not selected, you cannot make
changes to the file. For instance, if a
file is readable but not writable, you
will be able to read its contents, but
you will not be able to change them.

If this attribute is selected, vou can
execute, or run, the project or tool.

If this attribute is selected, you can
erase the drawer, project, or tool
from the disi, If it is not selected,
the object is protected from deletion.



If the icon represents a project, there may be a Default Tool
gadget. This specifies the path to the took that created the
project. When the project icon is opened, the defaule tool 1s also
opened so that it can work on the project.

If there is a Comments box, you can include a short note, up to
79 characters, in the information window. For instance, if you
have an icon representing a text file you created, you may want
to add a note to remind yourself of the file’s contents. To do
this, select the text gadget next to Comments, and type the
note. Press Return when you are finished.

The Tool Types box allows you to specity different parameters
for some programs or files. How to use Tool Types is covered in
Chapter 4, “The Workbench Programs”. If a program supports
Tool Types, the permissible Tool Types will be explained when
that program is explained.

To save any changes you make to the Information window, you
must select the Save gadget in the lower left corner. If you
make changes but decide not to save them, select the Cancel
gadget or the window’s close gadget.

Snapshot AS

Snapshot saves the positions of all the currently selected icons
on disk. Every time you open the window, any icans that you

snapshot will appear in their saved positions. You can save the
position of multiple icons by using drag selection or extended
selecuion.

To snapshot the position of an icon:
1. Select the icon(s) you want to snapshot.
2. Choose Snapshot from the Icons menu.

The next time you open the window, the icon|s} will be
in this position.
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You cannot use this
menu item with the
Trashcan.

Unsnapshot AU

Unsnapshot allows you to cancel the snapshot position of an
lcon.

To unsnapshot the position of an icon:
1. Select the icon.
2. Choose Unsnapshot from the Icons menu.

The next time you open the window, Workbench is free
to place the icon anywhere it wants to within the
window.

Leave Out AL

Leave Qut allows you to move an icon out of its original
window and into the Workbench window. {The file represented
by the icon remains in its original drawer on the disk, only the
icon is moved.] The icon remains in the Workbench window,
even if you reboot the machine.

For instance, you may have a file that you use every day, but
you have to open a disk icon and two other drawers to get to it
For faster access, you can use Leave Out to move the icon into
the Workbench window.

To use Leave Qu:
1. Select the icon.
2. Choose Leave Out from the Icons menu.

The icon will move into the Workbench window.
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Put Away AP

After using Leave Qut, you can return the icon to its original
drawer by cheosing Put Away.
To use Put Away:

1. Select the icon in the Workbench window.

2. Choose Put Away from the Icons menn.

The icon will move back into its original window.

Delete...
The Delete menu item lets you erase files, and their icons, You cannot delete a
from the disk. Use Delete with caution. Once you delete an disk icon or the Trash-

icon, you cannot retrieve its information. can icon.

To delete an icon:
1. Select the icon.

You can use drag selection or extended selection to
choose more than one icon to be deleted.

2. Choose Delete from the Icons menu.

A requester warns you that you cannot get back what
you delete and shows the number of items to be deleted.
This is to safeguard against deleting items that may still
be selected from a previous operation.
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3. Select the OK gadget to delete the icon.

The icon will leave the screen and all data associated
with that icon will be erased from the disk. I you do not
want to delete the icon, select the Cance) gadget.

Be careful when deleting drawer icons. The requester will show
the number of drawers being deleted, but you are also erasing
everything contained in those drawers.

Format Disk. ..
When you insert a blank 3.5 inch disk into the Amiga’s disk

depending on which disk drive it is in. At this point, the Amiga
does not recognize the disk as an AmigaDOS disk. In order to
use the disk, it must frst be formatted for AmigaDOS.

I you format a disk that contains data, all data will be
erased.
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To format a disk:
1. Put the disk into the disk drive.

You can put the disk into any disk drive — internal or
external. Make sure the disk is write-enabled [the plastic
tab should be covering the hole).

2. Select its disk icon.
I it is a blank disk, the icon will be labeled according to

Horkbenc 0.8 %:830w jragh .-z res

fan Disk

)

Horkbenth2, 8
!
Hl N blank digk icon

bF{ ;2172

3. Choose Format from the Icons menu.

If you are formatting a blank disk, a requester will ask
you to insert the disk to be formatted into the disk drive.
Even if the disk is already in the drive, the requester
appears to allow you to switch disks or to cancel the
operation. Select Continue to proceed.
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A second requester will ask if it is OK to format the disk in
the disk drive and remind you that all the data will be
erased. Select Continue to proceed or Cancel to stop the

pracedure.
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if you are formatting a disk that contains data, a requester
will ask if it is OK to format the disk, it will state the disk’s
name, and remind you that all the data will be erased.

0K te Fernat volume
copy_of Merkbench 4
Call data will be erased) ?

ALAREY ll(*ll_llg CCEL |

=

copy_of_Morkbench2.®

This requester presents you with a third option: OK-Quick. If
you select OK-Quick, just the root block track of the disk is
formatted. The root black contains the information that
identifies the disk and where all the files are stored. Erasing the
root block essentially erases the entire disk as the system will
no longer be able to find any of the files on the disk. This is
much quicker than a regular format.

However, if your disk has any type of read/write error, you
should perform a regular format by selecting the QK gadget.
Each cylinder of the disk will be reformatted.

Once the formatting process begins, text in the requester
shows the cylinder of the disk that is being formatted and
verified. After a disk has been formatted, its disk icon will be
labeled Empty. You can change the name by using the Rename
item in the Icons menu.
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A read/write error oc-
curs when something
physically disturbs
the magnetic pletter
it @ disk, This pre-
vents the computer
from reading the in-
formation stored in
the location of the er-
ror. Formatting the
disk can sometimes re-
pair the error.
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Empty Trash

As explained in the “Icons” section, the Trashcan is 2 place
where you store unneeded files. To delete an icon using the
Trashcan, drag the icon you want to “'throw away’ over the
Trashcan icon. The icon is then stored in the Trashcan drawer
until you decide to delete it. To actually remove the file(s)
stored in the Trashcan, you must choose Empty Trash.

To delete an icon with Empty Trash:

1. Drag the icon over the Trashcan, and release the
selection button.

If you open the Trashcan, the icon will be in the
Trashcan window.
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2. Make sure the Treshcon icon is selected (the lid will be
open), then choose Empty Trash from the Icons menu.

If you open the Trashcan window, the icon will be gone.
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When you put an icon in the Trashcan, it will stay in the
Trashcan unti} you choose Empty Trash from the Icons menu.
As long as you have not selected Empty Trash, you can retrieve
an icon from the Trashcan. To retrieve an icon, open the
Trashcan window, and drag the icon into any window.

Some special rules apply to the Trashcan:

® You cannot delete a disk by dragging its icon over the
Trashcan icon.

¢ You cannot move the Trashcan into a drawer.

¢ You cannot delete the Trashcan.

The Tools Menu

The Tools menu allows you to run application software by
choovsing a menu item instead of opening the program icon. If
the application software supports this feature, there will be
instructions on how to create the new menu item in the
documentation accompanying the program.






Chapter 3. Preferences

In Chapter 2 you learned about the Workbench system and
how the various components work. You should now be
comtortable with the basic steps involved in using the Amiga,
such as selecting and opening icons, choosing menu items, and

working with windows.

Now it’s time to put that knowledge to work. This chapter I_ '
explains the Preferences editors. These editors, which are —

found in the Prefs drawer, let you personalize your Amiga -

environment. For instance, you can:

® change the Workbench colors

o change the shape of the pointer

® change the size of your display area

® specify your printer

& set up a printer for graphic output

® set up a modem for use with the Amiga

You do not need to use every editor in order to use your Amiga.
Many of the editors let you change how things appear on the
screen to suit your own tastes. However, if you connect a
printer, modem, Multiscan or A2024 monitor to the system,
you must use the appropriate editor to tell the Amiga how to
interact with the new device.

After your system is set up the way you like it, you can move
on to Chapter 4 and learn about the other programs included
on the Workbench2.0 disk.
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The Prefs Drawer

Open the Prefs drawer in the Workbench2.0 disk window, and
the following window appears:
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This window contains the icons for the Preferences editors,
which are listed below in the order in which they are covered:

Time Lets you set the date and time.

Input Lets you change the mouse speeds (how fast
the pointer moves, the length of time
allowed for a double-click} and key repeat
speeds.

Palette Lets you change the colors of the
Workbench.

WBPattern  Lets you select or create a background
pattern for the Workbench screen and/or the
Workbench windows.



Pointer

Font

ScreenMode

Overscan

Printer

PrinterGfx

Serial

IControl
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Lets you change the size, shape, and color of
the pointer.

Lets you change the fonts used in the
different areas of the screen.

Lets you choose a different display mode.
This is necessary if you are using certain
types of monitors with your system, such as
an A2024 or Multiscan monitor.

Lets you adjust the size of the display area
for text and for graphics.

Lets you specify the printer driver that
matches your printer and allows you to
specify options such as paper size and
maigin width.

Lets you set up your printer to print
graphics.

Lets you set the specifications for the senal
port. This is used for communicating
through modems or networking systems.
Lets you choose the keys used for some of
the keyboard shortcuts, such as moving the
Workbench screen or choosing an action
gadget from a requester.

All of the editors, except for Time, have menus which allow
you to save different configurations for each editor. For
instance, if you use two printers with your Amiga, you

could save the settings for each printer in the Presets drawer.
When you wanted to switch printers you could just open the
appropriate file, instead of reselecting each individual printing

option.

The menus and the Presets drawer, which are explained at the
end of the chapter, are optional and do not have to be used in
order to set up your Amiga.
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Action Gadgets

When you open an editor icon, a window appears on the screen.
Each editor window has three action gadgets: Save, Use and
Cancel. You must select one of these gadgets to implement
your changes or to close the editor window. Their functions are

explained below:

Save

Use

Cancel

If you've made changes to the settings that
you want to keep, select the Save gadget.
This will implement any changes you have
made, save the changes to disk and close the
editor. The new settings will remain in
effect even if you reboot the Amiga.

If you've made changes to the settings that
you want to try, but vou do not want to save
them at this time, select the Use gadget.
This will temporarily implement any
changes made and close the editor. If you
reboot the Amiga, your changes will be lost,
and the previously saved settings will be
used.

If you've made changes in the editor but
decide you don’t want to use them, select
the Cancel gadget. This will close the editor
without using or saving any changes made
in the window. The settings that were in
effect prior to opening the editor will remain
in effect.
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The Time Editor

Open the Time icon, and the following window appears:
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This window lets you set the correct date and time.

To set the date:

1

Select the cycle gadget in the upper left corner until
the correct month is displayed.

As you select the gadget, the calendar will change to
reflect the displayed month and year.

. If the incorrect year is displayed, select the year

gadget, delete the incorrect information, and enter the
current year.

Click in the gadget, press Backspace or Del to erase the
displayed year, type in the current year, and press
Retum.

. Select the correct day from the calendar display.

The currently selected day will be highlighted.
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To set the time:

1. Point to the slider bar in either the minute or hour
slider.

2. Drag the bar until the correct value is displayed at the
top of the slider, then release the selection button.

The hour value is based on a 24-hour clock and ranges
from O {midnight} to 23 {11 PM). The minute range is
from 00 to 59.

Repeat the above steps with the other slider.

The Input Editor

Open the Input icon, and the following window appears:

Horkbench Screen

Input_Preferences ] L= JLalC]|
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Input window — .| Kevboard
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Key Repeat Rate: 0,038 sec 1 J
Key Repeat Test: | |
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This window lets you change the speed at which the mouse
and keyboard operate. There are two mouse speeds that you
can change: how fast the pointer moves across the screen and
how fast the mouse registers a double-click of the selection
button. For the keyboard, you can change how fast a key
repeats when it is held down continuously and how long it
takes before a key will start to repeat.

Mouse Speed

The Mouse Speed slider lets you determine how fast the
pointer moves across the screen as you move the mouse.

There are three mouse speeds that you can choose from: 1, 2,
and 4. A setting of | is the fastest; 4 is the slowest. You may
want to try each setting until you are comfortable. While you
don’t wane the pointer to move too siowly, it may be hard to
control if it is moving toa fast.

Another factor to consider is the size of your work surface.
When the mouse speed is fast, you don’t need to move the
mouse very much to get the pointer across the screen. A slower
mouse speed requires more desk space for your mouse.

To set the mouse speed, drag the slider bar until the desired
value is displayed. As you drag the slider, the displayed mouse
speed takes eftect. This allows you to try out each speed
without exiting the editor.

Acceleration

There may be times when you need to be able to move the
mouse over large screen areas while keeping fine control for
smaller movements. For instance, if you are using the mouse
to create a complex drawing with a paint program, you may
need to cover a lot of screen surface quickly but with precision.
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If you simply increase the mouse speed, you lose a certain
amount of mouse control. However, when acceleration is
tumed on, the mouse speed remains constant when you first
start to move the pointer, allowing you to work precisely
within a small area. However, as you move the pointer further
across the screen, the mouse speed gets faster—similar to
pressing the accelerator on a cax. This allows you to cover large
areas of the screen quickly.

When acceleration is on, a check mark appears in the check
box. To turn acceleration on or off, select the check box.

Double-Click

The Double-Click slider determines the maximum amount of
time allowed between the two clicks of a double-click.

The range is from 0.20 to 4.00 seconds. If you set the double-
click speed to 0.20 seconds, you must click the mouse twice

within two-tenths of a second in order to register a double-
click.

To see the amount of time for the selected value, select the
Show gadget. A box appears next to the gadget and remains
there for the length of time allowable between the two clicks.

To test the speed you've chosen, double-click in the Test
gadget. If the double-click took place within the allotted time,
a Yes appears next to the Text gadget. If there was too much
time between your two clicks, a No appears.

Key Repeat Delay

Most of the keys on the keyboard automatically repeat when
held down. However, there is a delay that occurs before the key
starts repeating. The delay, measured in seconds, can be
changed by using the Key Repeat Delay slider.



You can see the current setting by looking at the slider value.
The range is from 0.20 {shortest) to 1.50 {fongest) seconds. To
increase the delay before the key starts repeating, drag the
slider bar to the right. To decrease the delay, drag the slider bar
to the left.

Key Repeat Rate

The Key Repeat Rate slider determines the rate at which the
keys will repeat, after the initial key repeat delay.

The allowable range is from 0.002 (fastest} to 0.250 (slowest]
seconds. To increase the speed, drag the slider bar to the leit. To
decrease the= speed at which the keys repeat, drag the slider bar
to the right.

Key Repeat Test

You can test the settings you have chosen for key repeat delay
and key repeat rate with the Key Repeat Test gadget.

Select the gadget by pointing to it and clicking the selection
button. A cursor will appear in the gadget. Hold down one of
the letter keys on the keyboard. Your input will appear in the
Key Repeat Test gadget and will show the current key delay
and key repeat rates.

Preferences
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The Palette Editor

Palette window ———— sl Green; 4 8

Open the Palette icon and the following window appears:

Horkbench Screen
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This window lets you change the colors of the Workbench.
Each color on the Workbench screen is made up of various
amounts of red, green, and blue. The red, green, and blue sliders
let you change the amounts of each color and create new
colors. The current Workbench colors are shown in the
selection gadget at the top of the window.

The number of available colors is determined by the type of
display mode you are using and is set via the ScreenMode
editor [explained later in this chapter]. For instance, although
the standard Hires display uses 4 colors, you can change the
screen mode and use up to 16 colors. In this case the Palette
editor would have 16 colors in its selection gadget.
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To change a color:
1. Select the color you want te change,

Point to a color in the selection gadget, and click the
selection button. The selected color will be shown in the
display box to the left of the selection gadget.

2, Use the slider gadgets to change the selected color.

By changing the values of the sliders you can change the
amount of red, blue and green used in the selected color.
As you drag the bar through the slider box, the color in
the display box and on the screen will change.

Be careful when changing the black and white settings as it
could affect the three-dimensional appearance of the screen. To
preserve the three-dimensional effect, be sure to keep the color
that replaces black darker than the color that replaces white.

By experimenting and changing the values for each of the three
color sliders, you can ¢reate any of the Amiga’s 4,096 colors.
The table below shows some settings that will bring you close
to your desired color.

== Palette Color Table =
Color Red Green Blue
White 15 15 15.
Yeitow 15 15 0
Orange 15 7 0
Red 15 0 0
Brown 8 5 0
Cray 8 8 8
Purple 7 0 10
Lt. Blue 6 8 11
reen 0 8 0
Blue 0 0 15
Black 0 0 0

Remember these settings are just approximate, You may have
to adjust the settings to achieve the color you want, as the
actual shade of the color may vary depending on your monitor.
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In addition to the standard Preferences menus [explained at the
end of this chapter), the Palette editor also has a Presets menu

item in the Edit menu which lets you choose from nine
predetermined color settings. For instance, it you choose

Sunset from the submenu, the default grey changes to blue and
the default blue becomes orange.

The Workbench Pattern Editor

Open the WBPattern icon and the following window appears:
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This editor lets you change the background pattern of the
Workbench and its windows. You can select an already existing
pattern or create your own. The pattern will fill any open areas
of the window. The default is no pattern.

For a quick demonstration of how this works, follow the steps
below:

1. Select one of the patterns in the Presets gadget.

A magnified view of the pattern will appear in the box in
the middle of the window. An actual-size view will be
shown in the display box above the Presets gadget.

2. Select the Test gadget.

The selected pattern will fill the background of the

Workbench.
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Your screen is made
up of rows and colums
of tiny dots, or pixels.
The mumber of pixels
in ¢ screen depends
upon the display mode
you have chosen fex-
plained later in this
chapter).

To create a pattern:
1. Select the Workbench or Windows radio gadget.

This determines whether the pattern appears in the
Workbench window or any open disk or drawer
windows.

2. If there is a pattern in the magnified view box, select

the Cleor gadget.

This will erase the contents of the magnified view box.
The box will fill with the currently selected color.

3. Select a color to draw with from the color selection

gadget.

Point to a color in the selection gadget, and click the
selection button. The selected color will appear in the
display box above the gadget. You can also select a
pattern from the Presets gadget, and then use the mouse
to edit it

. Point within the magnified view box to where you want to

start drawing, then click the selection button.

One pixel of the selected color will appear. I you hold down
the selection button and move the mouse, you can fill in
several] pixels at once. When you want to switch

to another color, move the pointer over to the color
selection gadget, and select the next color you want

to use.

As you create your pattern in the magnified view, the pattern
is repeated in the actual-size box. This gives you a better
idea of how the pattern will lock on the display.

If you make a mistake while drawing, use the Undo gadget
to erase the last action performed by the mouse. The pattern
shown in the Undo display area will be exchanged with the
pattern in the magnified view box.
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5. When your pattern is finished, select the Test gadget,

The pattern will appear in the background of the Workbench
window or any open disk/drawer windows, depending on
which radio button you selected.

The Pattern radio buttons determine where the pattern will
appear. When the Workbench button is selected, the pattern
that currently appears in the magnified view will be used on
the Workbench when you select the Test, Save or Use gadget. If
the Windows button is selected, the pattern in the magnified
view will be used in all disk and drawer windows.

You can switch back and forth between the two patterns by
selecting the buttons. When you select the Workbench radio
button, the last pattern that appeared in the magnified view
box while the Workbench button was selected will reappear.
When you select the Windows button, the pattern will change
to the last pattern created for the windows.
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The Pointer Editor

Open the Pointer icon and a new screen appears:

Pointer Preferepnces

Pointer Preferences =] |
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This editor lets you change the size and shape of your pointer.

A magnifed view of the current pointer is shown in the left
side of the window. It 1s this image that you modify to change
the puinter. To the right of the magnified view are copies of the
pointer which let you judge how the Pointer will look against
the colors on the Workbench.

Although the pointer is only made up of three colors, there are
four colors shown in the selection gadget. The left-most color
is the Workbench background color and is transparent. This
color cannot be changed. You will be able to see through any
areas of the pointer drawn with this color. You can change the
other three colors.
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To change the colors:

1. Select the color you want to change from the color
selection gadget.

Point to the color and click the selection button. The
selected color will be shown in the display box to the left
of the selection gadget.

2. Change the amounts of red, green and blue in that coler
by using the three color sliders.

To edit the pointer:
1. Select the color with which you want to draw.

Point to the color and click the selection bucton. The
selected color will be shown in the display box to the left
of the selection gadget.

2. Point to a place in the magnified view where you want
to piace a pixel of the selected color, then click the
selection button.

A small, colored rectangle appears where you've clicked
the mouse. To draw several rectangles, hold down the
selection button and move the mouse.

Pointer Preferences
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Repeat steps 1 and 2 to add other colors to your pointer. Just
peint to the color in the selection gadget that you want to draw
with, and click the selection button.

The four gadgets along the right side of the screen are explained

below:

Test

Clear

Set Point

Reset
Color

While you are drawing in the magnified view
box, the screen pointer does not change. The
Test gadget lets you change the screen pointer
s0 that it reflects what is drawn in the
magnified view box. This way you can see
what the pointer looks like on the screen
without closing the editor.

If you select the Cancel gadget after changing
the screen pointer by selecting Test, a requester
will remind you that you have changed the
pointer and ask if it is OK to discard the
changes.

The Clear gadget erases the magnified view
box. All pixels will be changed to the
background color. You can then draw a new
pointer.

The Set Point gadget lets you choose where to
put the pointer’s point, or “hot spot”. The point
is the single pixel in the pointer that must be
inside an icon’s box in order to select the icon.
In the magnified view, the point is indicated by
a smaller square within one of the pixels.

To select the point, select the Set Point gadget,
point to the pixel in the magnified view where
you want the point to be, and click the
selection button.

The Reset Color gadget brings back the last set
of colors that were saved.
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The Font Editor

The Font editor lets you change the fonts that are used on the
Amiga. This is primarily useful to people with hard disk
systems. With a floppy disk system, the only font immediately
available to you 1s Topaz, which is stored in the computer's
ROM jRead-only memory|. Additional fonts are supplied on
the AmigaFonts2.0 disk, but to use these, you have to delete
programs from your Workbench disk. This is not advisable
until you are an experienced Amiga user.

Never delete anything from your master copy of
Workbench2.0,

Open the Font icon, and the following window appears:

Font Preferences S]] IEIIElr[
Horkbench icon text @ | topaz 8
Screen text ) [topaz &

System default text ) |topaz 8

topaz 9} |
topaz 9}\
123436789 aRbBcCdDaEfFof
A
]
Color selection (Morkbench icon text onlyl:
¥ Text Only Teut: i [ | |
2 Text & Fisld fiet: [ R | i
Save | tse Cancel | z
1 <[>

This window lets you change the fonts that appear under the
Waorkhbench icons and in the Workbench menus and title bars.
It also allows you to change the default system font that the
Amiga uses to display information, such as the output of the
View By menu item.

A font is a set of char-
acters of the same de-

sigm.

Fant window

available fonts
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Text Radio Buttons

The radio buttons at the top of the Font editor window allow
you to select the text that you want to change. Your choices

are:

Workbench icon
text

Screen text

System default text

Changes the font below icons in the
Workbench windows. This is the
only text for which you can specify 2
color [see the “Text/Field” section
on page 3-22). Any changes to the
Workbench icon text will take effect
when you exit the Font editor.

Changes the font that appears in all
screens — in the menus, the title
bar, requesters, etc. This font

will only take effect when the
Workbench is reset. When you
select the Save or Use action gadget,
the Font editor will close, and the
Workbench will automatically try to
reset. If you have any project or tool
windows open, a requester will ask
you to close them. You can leave
disk or drawer windows open.

Changes the font that the Amiga
uses to display information, such as
the text in the Workbench Output
Window. This font change is not
immediately noticeable.

To select a text area, point to the radio button next to that area,
and click the selection button. Remember, you can only
change the font for one text area at a time. However, you can
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change the font for each area without exiting the Font editor.
For instance, you can select the Workbench icon text radio
button, and select a font for the icons. Then, select the Screen
text radio button, and select a font for the screen. Finally, select
the System defaunle text radio button, and select another font.

NOTE: Many application programs choose their own fonts and
are not affected by your choices in the Font editor.

Font Gadget

When you select a radio button, a list of available fonts appears
in the scroll gadget. The font name is followed by a number.
The number represents the size of the font—the higher the
number, the larger the font. Sizes vary from font 1o font, as
some fonts are naturally smaller than others. The maximum
size allowable is 124 points.

When you are selecting a font for the Workbench icon text or A geaspreportional
Screen text, all of the fonts are available. However, the font foot is one where
used for the System default text must be a nonproportional :ﬁfﬁﬂcm is the
font, such as Topaz or Courier.

To see the names of the available fonts, drag the scroll bay, or
use the scroll arrows, to scroll through the fonts. To select a
font, point t2 it and click the selection button. The name of the
selected font will be shown in the text gadget next to the
selected radio button.

An example of the chosen font, in its actual size, is shown in
the display box next to the font scroll gadget. If you do not like
the way a font looks, select another one. You can keep making
selections a3'long as the appropriate radio button remains
selected.
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The field is the area
immediately surround-
ing the text.

Text/Field
NOTE: This is only applicable to the Workbench icon text.

When changing the font for the Workbench icons, you can also
specify the color of the text and the field. Two radio buttons let
you choose between Text Only or Text & Field.

If vou select the Text Only radic button, the text will be the
color specified by the Text color selection gadget. The field will
be the Workbench background color or pattern.

I vou select the Text & Field radio button, you can specify a
color for both the text and the field. This option ensures that
the text is legible regardless of the background pactern.

To change the color of the text or field, select a color from the
appropriate color sclection gadget. Be sure to select two
different colors for the text ond the field. Otherwise, the text
will blend in with the field, ond you will not be able to read
the words.

The number of available colors is determined by the
ScreenMode editor, while the colors themselves are
determined by the Palette editor. You cannot change the colors
within the Font editor.

Types of Displays

This section explains the types of displays that you can use
with your Amiga so that you will be aware of your choices
before using the ScreenMode or Overscan editors.

The ScreenMode editor lets you change the display mode for
the Workbench screen. The display mode refers to the number
of horizontal pixels and the number of vertical pixels in a
screen. This is also known as the screen resolution.
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The standard Workbench screen that appears when you boot
with your original Workbench disk is a Hires {high-resolution)
screen. It is 640 pixels wide {keft to right). Its height is
determined by your country’s video standard, For an NTSC
display, used throughout North America, a Hires screen is 200
pixels high {top to bottom); for a PAL display, used in Australia
and most of Europe, it is 256 pixels high.

Maost display modes provide an interlaced option which
doubles the number of horizontal lines on a screen, thereby
increasing the resolution. Depending on which model of
Amiga you own, your system may use a Hires-Interlaced
screen (400 lines NTSC; 512 lines PAL}. Interlaced screens may
flicker when used with certain monitors. Some Amiga models
have special hardware installed to eliminate the flicker when
used with the appropriate monitor. It is possible to add similar
hardware to other Amiga models as well.

The display modes available to you may depend upon the type
of monitor you are using. Each display mode is explained in the
following sections, and the chart on page 3-24 lists all the
display modes, the hardware needed to use that mode, and the
standard screen sizes.

Remember that the display mode you choose only pertains to
the Workbench screen. If an application opens its own screen,
you should check the documentation supplied with the

software to see which display modes the application supports.

In the following sections describing the various display modes,
the information along the right margin is presented in the
following format:

# width x height of standard screen
® width x height of interlaced screen
# maximum number of colors

Height is shown for both NTSC and PAL systems—NTSC/
PAL.
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Possible Display Modes
Standard
Display Mode Special Requirements Screen Size
NTSC: Hires NTSC monitor! 440 x 200
NTSC: Hires
Interlaced NTSC monitor! 640 x 400
NTSC:
SuperHires NTSC meonitor’ 1280 x 200
NTSC:
SuperHires
Interlaced NTSC monitor’ 1280 x 400
PAL: Hires PAL monitor' 640 x 256
PAL: Hires
Interlaced PAL monitor! 640 x 512
PAL: SuperHires PAL monitor' 1280 x 256
PAL: SuperHires
interlaced PAL monitor’ 1280 x 512
Productivity Multiscan monitor® 640 x 480
Productivity
Interlaced Multiscan monitor? 640 x 960
A2024_10Hz A2024 monitor? 1008 x 800
A2024_15Hz A2024 monitor® 1008 x 800
'1f this is not the standard video mode for your country, it will only be
available it you have dragged the appropriate icon from the MonitorStore
drawer to the Monitors drawer.
3¥ou must drag the appropriate icon from the MonitorStore drawer to the
Monitors drawer for this monitor o be recognized by the Amiga.




Hires 640 x 200/256 non-interlaced
640 x 400/512 interlaced
16 colors maximum

This is the default display mode used by the Amiga. It is
suitable for most text-based applications, such as word
processing and databases.

Untless you have display enhancer hardware, the Hires-
Interlaced screen may flicker.

SuperHires 1280 x 200/256 non-interlaced
1280 x 400/512 interlaced
4 colors maximum

A SuperHires screen essentially cuts the width of the pixels
used by a Hires screen in half. It doubles the amount of
information that can fit on the screen, making text and icons

considerably smaller. SuperHires may be especially useful for
video applications.

SuperHires is only available on machines equipped with the
Enhanced Chip Set. If you have display enhancer hardware, you
should disable it when using SuperHires mode, or the display
may be distorted. {See the display enhancer documentation for
instructions. )
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Productivity 640 x 480 non-interlaced
640 x 960 interlaced

4 colors maximum

Productivity mode looks similar to the Hires-Interlaced mode.
You must have the Enhanced Chip Set and a Muitiscan
monitor in order to use Productivity mode.

If you do not have display enhancer hardware, you can use
Productivity mode to display 480 vertical lines without any
flickering or visible scan lines. This is useful for desktop
publishing, CAD/CAM, and graphics programs.

If you do have display enhancer hardware, a Hires-Interlaced
screen is a better choice as it uses fewer system resources than
Productivity mode while providing more colors.

A2024 1008 x 800 only

no interlaced option
4 shades of grey maximum

The A2024 mode is only available on an Amiga with an
A2024-style monochrome monitor. These display modes are
commonly used for desktop publishing and CAD/CAM
programs as they allow you to display a complete 8.5 x 11 inch
page on the monitor screen. The 10Hz mode is recommended
for text editing. The 15Hz mode refreshes the screen more
frequently, providing a better picture. However it uses more
system resources than the [0Hz mode.



Preferences 3-27

The Screen Mode Editor

Open the ScrzenMode icon and the following window appears:

Horeberch Scoeen

pr

Lo o o AL B R ERR AL, [ ey T A
Choase Display Mode: Propertiss of the Setected Mode; N

NTS(:Mires Supports Gemlock
NTSC; SuperMires bragqable
:}:g:ﬂires-lnterlmd

iSuperdires-[nterlaced »

\ m v ScreenMode window

|H_TSC:Hires

Nidth: | befault
Bisible Sizel B x 200

Min Size: (e x 20 Neight: | Default

Nax Sire: 16368 x 16384 Colers: 4 b |

ax Colors: 16 RutoScrotl! |

Save | se Cancet :
1 <|>[4

This window lets you select the display mode for the
Workbench screen. The different modes were explained in the
previous section.

The available display modes are shown in the Choose Display
Mode scroll gadget. If there are several modes available, you
may have to scroll through the list to see all of the options.

To select a display mode from the list, point to it and click the
selection button. The selected mode will appear in the display
box under the Choose Display Mode gadget.



3-28

Preferences

Properties of the Selected Mode

This display box lists information about the display mode you
selected. The possible properties, depending on the selected
mode and the icons in the Moenitors drawer, include:

Interlaced

ECS

PAL

NTSC

Supports
Genlock

Draggable

Paneiled

Requires
bypassing
the Display
Enhaacer

This shows whether or not the display mode
supports an interlaced screen,

Certain display modes are only available if
you have the Enhanced Chip Set in your
Amiga.

1f an NTSC machine has the Enhanced Chip
Set and the PAL icon is in the Monitors
drawer, PAL display modes will be available.

if a PAL machine has the Enhanced Chip Set
and the NTSC icon is in the Monitors
drawer, NTSC screens will be available.

This shows whether or not the display mode
supports the use of genlocking equipment.

This shows whether or not the display mode
supports a draggable Workbench screen. A
draggable screen can be pulled down to
reveal any other open screens behind it.

This appears when the selected display
mode is made up of several panels, such as
the A2024 screen.

This indicates that display enhancer
hardware should be disabled when using this
display mode.
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Screen Sizes

Various screen measurements are shown in the lower, left
corner of the window. The size is given in the number of pixels.
The first number represents the width of the screen; the second
number represents the height.

Visible Size: o480 x 200
Min Size! 648 x 208
Max Stze: 16368 x 16384
Max Colors: 16

The sizes correspond to the currently selected display mode.

Visible Size  The size of the text overscan area, as
determined by the Overscan editor
jexplained in the next section).

Min Size The smallest, or minimum, screen size that
the selected display mode supports.

Max Size The largest, or maximum, screen size that
the selected display mode supports. The
amount of chip memory available may
further restrict this size.

NOTE: If you try to use a screen size that is
beyand the capability of the available
graphics memory, the system will use the
screen size currently selected.

Max Colors The maximum number of colors that can be
displayed on a screen in the selected display
mode.
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Width/Height

Use the Width and Height text gadgets to customize the size of
your Workbench screen. Enter a number between, or equal to,
the minimum and maximum width and height. Once you
enter a number, that number remains constant no matter
which display mode you select until you select the
corresponding Default gadget. However, if the number you've
entered is farger than the maximum size for a selected display
mode, the value in the text gadget will decrease to the
maximum size.

The Default check box to the right of each gadget allows you
to select the default setting for the width and/or the heighe.
This is usvally equal to the size shown as the visible size
measurement.

Colors

This slider gadger lets you select the number of colors that can
be displayed on the screen. The fewer colors selected, the faster
the screen can be redrawn. Fewer colors aiso use less memory.

AutoScroll

If you've specified a screen width that is larger than the
monitor’s display area, you may want to turn on the AutoScroll
option. When AutoScroll is selected, the screen antomatically
starts to scroll when the mouse reaches the edge of the visible
portion of the screen.
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The Overscan Editor

Open the Overscan icon and the following window appears:

ntsc.moniter

[ntsc.monitor

Edit Text Overscan,.. |
Edit Standard Overscan... |  [* Overscan window

Regular Size: 4 x 20
Text Ouerscan: 640 x 280
Standard Overscan: 648 x 288
Maxinun Dverscam: 724 x 4t

Save | se | Cancel |

<> =

1¢|¥a

Your screen usually fills most of the monitor’s display area, but
there is often a small amount of unused space around the edges
of the monitor screen. This area is known as the overscan area.
This window lets you enlarge the size of your screen so that
you can take advantage of that unused space.

In general, any application software that uses a Workhench
screen should support the sizes you select with the Overscan
Editor. It is possible that some older software will have limits
on the window size.
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The various display groups for which you can enlarge the
overscan areas are shown in the scroll gadget in the top of the
window. As explained eatlier, the number of display groups you
can choose from depends on the type of chip set in your Amiga
and, possibly, the type of monitor you are using.

The default group will be the video standard for your country,
PAL or NTSC. If your monitor supports both video standards,
and the appropriat. icon is in the Monitors drawer, the other
video standard will also be available. Do not try to use the
other video standard unless your monitar supports it, ar your
screen image may be garbled.

The possible groups and the modes they represent are outlined
below:

NTSC Hires/Hires-Interlaced
SuperHires/SuperHires-Interlaced
PAL Hires/Hires-Interlaced

SuperHires/SuperHires-Interlaced

Multiscan  Productivity/Productivity-Interlaced
Only available if a Multiscan monitor has
been connected to the system.

Al024 A2024 — 10Hz and 15Hz
Only available if an A2024 monitor has been
connected to the system.

When you change the overscan values for a particular display
group, all modes within that group are afiected. To change the
overscan values for a display group, point to the group in the
scrolling list and click the selection button. The selected group
will appear in the display box under the scroll gadget.
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Edit Text Overscan...

NOTE: This function has no effect when used with the A2024
display modes.

This gadget lets you adjust the area available for text display.
When you select the gadget, the following screen appears:

Use the !andles to size

and place your Text Overscan
area., It nay be 3% big a3
you like, but the whale ares
should rewmain visible,
Press <ESCrape to cancel
or <ENTER> to keep changes.

= i _

m m m

The black rectangles are handles. The handles, and the line
connecting them, represent the outermost area where text can
be displayed. To enlarge the overscan area, point to a handle,
hold down the selection button, and drag the handle to the
edge of the screen. Do this with the handles on each side of the
screen.

Be careful not to move any part of the handle off the screen. If
part of a handle is out of the viewing area, you will not be able
to see all of the text on a screen.

Use the center handle to position the screen. By dragging the
handle, you can shift the screen slightly to the right or left, or
up or down. In this way you can center the display area on your
monitor screen without having to use the monitor's horizontal
and vertical controls.
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To exit the screen without saving any changes, press Esc. To
save changes, press Return. You will be returned to the
Overscan editor.

You can also exit the screen with a menu. Hold down the menu
button and point to the top left corner of the Text Overscan
screen. A menu will appear. Choose Keep Changes [or press
right Amiga-K or Return) to save your changes and exit the
screen. Choosing Quit {right Amiga—Q) or pressing Esc allows
you to leave the screen without implementing your changes.
You will be returned to the Overscan editor.

Edit Standard Overscan...

NOTE: This function has no effect when used with the A2024
display modes.

This gadget lets you adjust the standard display size. When you
select the gadget, a screen similar to the Edit Text Overscan
SCreen appears.

The handles, and the line connecting them, represent the
outermost area where data will be displayed. At times, you
may want your graphics to fill as much of the screen as
possible, even running off the screen so that there is no
discernible border surrounding the picture.

Use the mouse to drag the handles as much as necessary so
that the line connecting them completely encornpasses the
screen. The resulting area should be slightly larger than the
monitor screen. As with the Text Overscan Editing screen, you
can use the center handle 1o position the screen.
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To exit the screen without saving any changes, press Esc. To
save changes, press Return. You will be returned to the
Overscan editor. You can alse usc the menu to exit the screen.

Screen Sizes

The different sizes of your overscan areas are displayed at the
bottom of the Overscan window, The sizes are given in number
of pixels. The Arst number represents the width of the screen
(left to right]; the second number represents the height of the
screen (top to bottom).

The sizes correspond to the sizes for a standard Hires screen
when cditing the PAL or NTSC groups. If Multiscan is sclected,
the sizes for 4 non-interlaced Productivity sereen will be given.
All other display mades in a group will be affected

proportionally.

The different size categories are explained below:

Regular
Size

Text
Overscan

Standard
Qverscan

Maximum
Qverscan

This is the standard, non-overscan size of a The regelar size is
SCreen. sometimes referred to

as the nominal or
This reflects the size of the current text standard size.

overscan area. As you enlarge or reduce the
text overscan area, this value changes.

This reflects the size of the current standard
overscan area. As you enlarge or reduce the
standard overscan area, this value changes.

This is the maximum allowable size for any
overscan area, text or standard.
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The Printer Editor

Printer window ——

I you are vasure of
which driver 1o select,
please refer to Appen-
dix B, “Printer Driv-
ers.” Some drivers are
capable of supporting
more thar one printer.

Open the Printer icon and the following window appears:

Harkbench Screen

15a0: Fref el S, s . o ; lm mn E‘

Printer Drill;el;

generic Paper Length {Lines): [&k
Left Margin {{hars): [3
Right Marqin (Chars): [?5

<o~

Jgeneric

Printer Port: B  Parallel Print Pitch: (|  18-Pica
Paper Type: (]  Fanfold Print Spacing: B & lpi
Paper Size: (¥|Marrow Teactor| Print Suality: 3 Draft

Save | lise ] ® (anu!|

n
-
v

=RItiF|

This window lets you tell the system what type of printer you
are using along with what type of output you want.

The first thing you need to do is to select a printer driver.

A printer driver is software that enables the Amiga to
communicate with a particular model of printer. The drivers
are usually named for the printers they represent. The printer
driver selected is used as both the text and graphic printer.

The printer drivers are stored on the Extras2 0 disk. However,
the Printer editor looks for the drivers on the Workbench2.0
disk. You must copy the driver for your printer to your
Workbench2.0 disk. For instructions on how o do this, see the
box on page 3-37. The driver will then appear in the Printer
Driver scroll gadget.



— Copying a Printer Driver from
— Extras2.0 to Workbench2.0

1. Select the Workbench2.0 window, then choose Show All
Files from the Windows menu.

2. Double-click on the Devs drawer.
You can close the Workbench2.0 window if you wish.
This will keep the screen from getting cluttered with
windows,

3. Look for the Printers drawer in the Devs window.
You do not need to open the Printers drawer. Just leave it
in 2 visible part of the window. Once you've located the
appropriate printer driver, you will copy it by dragging the
driver icon over the Printers drawer icon.

4. Insert the Extras2.0 disk into your disk drive, and open
its window.

5. Select Show All Files from the Window menu, and
double-click on the Devs drawer.
You can safely close the Extras2.0 window if you like.

6. Double-click on the Printers drower in the Devs
window.
The Printers window will contain icons for the various
printer drivers. Scroll through the window untit you find
the driver that works with your printer. {lf you are unsure
of which driver to use, see Appendix B for additional
specifications.)

7. Drag the appropriate printer driver icon over the
Printers drawer icon in the Workbench2.0 Devs window.
If you have a single-drive system, requesters will appear
asking you to swap the Workbench2.0 and Extras2.0 disks
until the printer driver is copied.

If you have two drives, put a disk in each drive, and the
driver will be copied directly from one disk to the other.

The next time you open the Printer editor, the name of the
printer driver will appear in the scroll gadget.
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To select a printer driver, point to it and click the selection
button. The selected driver is shown in the text gadget
underneath the scroll gadget.

Horkbench Screen

Printer Prefereates T=IE

Printer briver
Paper Length (Lines): ’I
| Left Margin (Chars}: E
Right Margin (Chars): [T5_|

.

qenerLc

=

selected driver —— LITwsony 1
Printer Port: (¥  Paralie! [ Print Pitch: |  18-Pica
Paper Type: (4  Fantold Print Spacing: [3| 6 lpi
Paper Size: (¥ Harrow Tractor| Print Quality: B Draft
Save | Use (antel[

[~
[~
B

If a driver for your printer is not on the Extras2.0 disk, check to
see if a disk with an Amiga printer driver file was included
with your printer. lf the instructions for your printer tell you to
indicate a printer file, select the text gadget and type in the
name of the file included with your printer. Be sure to specity
the compiete path to the file or copy the file into the Devs/
Printers drawer on the Workbench?2.0 disk.

If you want to use a printer that is not included in the list, and
you do not have a printer driver for it, enter generic in the text
gadget. For many printers this allows you to print plain text,
but not graphics or extra type styles, such as italics and

boldface.

Once you have chosen your printer driver, the other gadgets in
the window let you set the specifications for your printer’s
output.



NOTE: The specifications you set with this editor may be
overridden when you use certain application packages, like
desktop publishers or word processors. Those types of
programs usually ask you to specify print specifications
specifically for chat program.

Three text gadgets allow you to specify the length of your paper
as well as your left and right margins. To change the default
value, select the gadget, delete the existing value, type in the
new number, and press Return. These gadgets are explained

below:

Paper Length

Left Margin

Right Margin

Determines the total number of lines on
the page, including top and bottom
margins. For instance, if you are using 11
inch long paper with 6 lines to an inch
(set with the Print Spacing gadget), you
will have 66 lines on your page.

Determines the width of the left
margin—the number of characters from
the left edge of the paper to where you
want the text to start printing. For
instance, if you want a one-inch margin,
and you are using 10 pitch type, enter 10.

Determines the width of the right
margin—the number of characters from
the left-hand edge of the paper to where
you want the right margin to begin. For
instance, if your paper is 8.5 inches
wide, and you're using 10 characters per
inch, you can fit 85 characters across the
page [10 x 8.5). To leave a one-inch right
margin, subtract 10 characters from the
right edge of the paper. The right margin
would be 75.
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Pitch refers to the
number of characters
in a horizoatal inch
and is explained later
in this section.
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You must also make sure that the six cycle gadgets across the
bottom of the window are set properly. The displayed option is
the selected option. To change the selection, keep selecting the
cycle gadget until the correct choice is displayed. Each gadget

is explained below:

Printer Port

Paper Type

Paper Size

Print Pitch

Specifies the Amiga port where you have
attached your printer. This is either
Serial or Parallel.

Specifies the type of paper you are using.
The aptions are Fanfold {continuous-
feed paper] or Single {individual sheets).

Specifies the size of paper you are using.
For specifics on each size, see the box on
page 3-41. Sometimes when printing in
graphics mode on Epson and other dot
matrix printers, narrow blank lines
appear across the printout. Selecting
Custom as the paper size may eliminate
this. if you select Custom, you must be
sure that the correct number of lines
that fit on your paper are specified in the
Paper Length gadget.

Pitch refers to the number of characters
printed in 1 inch of horizontal text—the
higher the number, the smaller the space
between characters. You can choose
from 10, 12, or 15 characters per inch.



Paper Sizes

Narrow Tractor”
Wide Tractor®
DIN A4

DIN AS

.S, Letter

U.S. Legal

*Tractor-feed paper has holes along the side that attach to
the sprockets on your printer.

9.5 inches wide by 11 inches long
{241 millimeters by 279 milluneters)

17.875 inches wide by 11 inches long
{454 millimeters by 279 millimeters)

8.3 inches wide by 11.7 inches long
{210 millimeters by 297 millimeters)

5.8 inches wide by 8.3 inches long {148
millimeters by 210 millimeters)

8.5 inches wide by 11 inches long
{216 millimeters by 279 millimeters)

8.5 inches wide by 14 inches long
{216 millimeters by 356 millimeters)

Print Spacing

Print Quality

Spacing refers to how many lines of text
are printed in 1 vertical inch of space.
You can select 6 tines per inch {Ipi) or 8
Ipi. The higher the number, the less
spacc there is between the lines.

Determines the quality of the printout.
Selecting Draft gives you a lower-quality
printout but faster printing. Selecting
Letter gives you a higher-quality
printout but slower printing,
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The Printer Graphics Editor

PrinterGix window ———

Open the PrinterGfx icon and the following window appears;

Warkherch Screen

LU T T e e e
Color Correct Snoothing Left Difset r
R & B | 1 Mo. Inches:
[ Colors = 40% Center Picture: _ |
bithering: (3 Ordered Linits
Scaling: @)  Fraction | Type: B [gnore
Image: 0|  Positive Hidth ¢ ¥
fispect: (}|  Horizontal Height ¢ 3
Shade! (Y| Black & Hhite
Thresheld: 7 B I Density: 1 N |
Save ] lse \ (ln(!ll f
3 <32

This window supports extended printer graphics features. The
printer you are using should be selected through the Printer
editor.

For tips on printing screen dumps, see the box on page 3-44.

Color Correct

NOTE: This can only be used with a color printer.

Color correction tries to better match the colors on your screen
to the colors on the printout. You can use color correction on
red, green or blue, o on a combination of the colors. To turn on
color correction, select the check box next to the color, or
colors, you want to correct: 1 {red), g {green], or b {blue).
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Color correction results in a reduction of the number of printed
colors. When color correction is not used, all 4,006 colors
displayed by the Amiga can be printed on a color printer. For
‘each color you choose to correct, 308 shades of that color are
lost. The umber of colors that can be printed is shown in the
Colors gadget underneath the color correction check boxes.

Smoothing

Sometimes when printing diagonal lines, the printed lines may Floyd-Steinberg dith-
be jagged. When smoothing is turned on, the Amiga attempts ering cannof beh‘f“d
to smooth diagonal lines to get rid of the jagged appearance. ?g::’b"ii]:m}: ”;::
This option is best suited for use with programs that do graphic plained later iu this
dumps of text. When smoothing is tumed on, printing may be section.)

much slower.

Left Offset/No. Inches

This gadget determines the number of inches to shift, or offset,
the printed picture. This is similar to setting up a left margin.
The offset is entered in increments of tenths of an inch. The
Center Picture option {below] disables Left Offset.

To enter the value, select the No. Inches text gadget, delete the
current value, type in the correct value, and press Return.

Center Picture

When Center Picture is turned on, the printed picture is
horizontally centered on the page. To turn Center Picture on,
select the check box gadget. Any value entered for the Left
Offset will be ignored.
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Tips for Printing Screen Dumps

For better quality screen dumps:

& On most printers, friction fed paper tends to
produce better graphic dumps than tractor fed
paper. There is less horizontal banding.

® Densities which use more than one pass should
only be used for black-and-white screen dumnps. [f
you use a multiple-pass density for a gray-scale or
color dump, the output may be muddy or dark.
Multiple-pass color dumps also dirty the printer
ribbon (i.e., the yellow will become contaminated
with other colors).

For faster screen dumps:

® Lower the density.

® Use horizontal dumps racher than vertical dumps.

& If you are dumping a two-color image, set Shade
to black-and-white. This is much faster than a
gray-scale or color dump.

¢ Turning on Smoothing doubles the printing time.
Use Smoothing for the final copy only.

® Floyd-Steinberg dithering doubles the printing
time, while Ordered and Halftone dithering cause
no in¢rease In printing time.

¢ If you are dumping a Hires screen that displays
more than 4 colors, you can speed up the dump by
moving the screen to the back of the display once
printing has started. This is easily done by
pressing left Amiga-N. ’




Dithering

Just as images on your screen are made up of tiny pixels,
printed images are made up of tiny dots. Dithering refers to the
printing of dots of different colors (or shades of grey) in such a
way that they are so small and close together that the eye sees
them as one color. This enables you to produce printouts
which appear to have more colors than the four ink colors
normally available on a color printer.

For instance, where there is a pixel of black on the screen,
black dots will appear on the printout. However, if you have a
pixel of purple, a color printer will use dots of vellow, magenta,
and cyan to create the illusion of purple. If you are printing grey
scale printouts, the printer will use varying patterns of black
dots to replicate the intensity of the purple on the screen.

The available dithering options are:

Ordered Coloer intensities are formed using an
ordered pattern of dots, similar to a
checkerboard pattern. The dots, while they
vary int color, are of the same density and are
printed in straight rows and columns. This
is the standard type of dithering,

Halftone Color intensities are formed by varying the
size and density of the dots. This technique
is similar to the one used in newspapers and
comic books. It works best on high density
printers |greater than 150 dots per inch).
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When Shade is set to
Black & White, chang-
ing the dithering
method has no effect
on the printout.
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Examples of Different
Dithering Output




Floyd-
Steinberg

For instance, while a pixel of black may be
reproduced with four black dots, a pixel of
purple may be reproduced by two red and
two blue dots of varying sizes that are placed
in such as way that to the human eye they
look like purple.

Color intensities are formed vsing the
Floyd-Steinberg error-distribution method,

a complex algorithmic formula. Basically
Floyd-Steinberg creates a dot pattern that
maximizes the image’s detail by distributing
the intensities of each pixel throughout the
dots comprising that pixel as well as
throughout the neighboring dots.

Printing may be slowed down considerably
when this option is chosen.

For an illustration of each of the dithering methods, see page
3-46. The pictures were generated on a 300 dot-per-inch printer.

Scaling

Scaling refers to the process of changing the size of an image.
The actual size of the printout will be determined by the
Limits setting {explained later in this section). It will be scaled
up or down to the nearest multiple of the width and height of
the picture. The available options are:

Fraction

The perspective of the picture is preserved.
Pixels are enlasged or reduced at random.
Select this option if you are printing pictures
with [ots of shading.
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This option automati-
colly turns off Smooth-
ing and weorks best on
high density printers
{greater than 158 dots
per inch}.
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The Aspect setting,
explained below, de-
termings whether the
picture Is printed
horizontally or verti-
cally on the page.

This setting only of-
fects black-and-white
and grey scale print-
ing.

Integer Every pixe! on the screen is guzranteed to
appear as an even number of dots on the
printout. Select this option when printing
a picture that contains thin vertical and
horizontal lines {like a grid).

For example, if the picture on the screen is
320 x 200, the printed picture will be either
320, 640 or 960 dots wide, etc., and 200, 400
or 600 dots high, etc.

Integer scaling completely overrides the
Aspect setting making it possible to get a
slightly distorted picture. This option 15 also
useful for printing out bit-image text, since
the fonts will not be distorted due to
fractional scaling.

Image

When set to Positive, the image is printed as it appears on the
screen. When set to Negative, the image is reversed — what is
black on the screen is printed as white, and what is white on
the screen is printed as black. This is similar to a photographic
negative.

Aspect

When set to Horizontal, the image is printed as it appears on
the screen —what appears across the top of the screen is
printed across the top of the paper. When set to Vertical, the
image is printed sideways — what appears across the top of the
screen is printed along the right-hand side of the paper.
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Shade

These options let you select what colors to print. Not all
printers support these options. The available options are:

Black & Colors are printed as either black or white.

White Whether a color is printed as black or white
is determined by the threshold value
{explained below). Dithering has no effect.

Grey Scalel  Colors are printed in varying shades of grey.

Color Colors are printed as they appear on the
screen. This can only be used with color
printers.

Grey Scale2  This option supports a maximum of four
shades of grey and is used for printing
pictures designed using the A2024 monitor.

Threshold

The threshold value determines which colors on the screen are This setting only af-
printed as white and which are printed as black. When the fects black-and-white
setting for Image is Positive and the threshold value is tow prinintg,

jaround 2}, cnly the darkest color on the screen is printed as
black. Everything else is printed as white. Increasing the
threshold value causes more colors to be printed as black.

If you change the Image setting to Negative, black and white
will be reversed. Therefore, a low threshold value will cause
the darkest color on the screen to be printed as white.

threshold = § threshold =13
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Limits/Type

The Width and Height limits {explained on 3-52} allow you to
specify the dimensions for your printout. However, those
limits can be interpreted in several ways, dependent on the
Type setting. The available options are:

Ignore

Bounded

The Width and Height limits are ignored.
The printed picture’s size is the size
requested by the application. The only
restrictions are that its width cannot be
greater than:

{right margin — left margin) + 1

characters perinch

For instance, if you are using 8.5 inch paper,
with 1 inch margins, and 10 characters per
inch, the width cannot be greater than 6.6
inches.

Height is restricted to the number of lines
on the page divided by the lines per inch.
This is usually equal to the length of the
paper.

The printed picture’s size is bounded by the
Width and Height limits. For example, if the
printed picture should be no bigger than 4.0
x 5.0 inches |but it could be smaller), set
Width to 40, Height to 50, and select
Bounded. (Width and Height are interpreted
in tenths of inches.)

This option is provided so that the text
settings (margins, lines per page, etc.) do not
have to be changed every time a graphic
print is made.
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Absolute The Width and Height limits are interpreted
as absolute values. For example, if the
printed picture should be exactly 4.0x 5.0
inches, set Width to 40, Height to 50, and
select Absolute, This completely overrides
the Aspect setting (Horizontal or Verticall,
making it possible to get a very distorted
picture.

However, you can use Absolute to get a non-
distorted printout that is a specific width or
height, not both. Set either the Width or
Height limit to the desired dimension, and
set the other limit to zero.

For example, if Width is set to 40 and Height
to 0, then the printed picture will be 4.0
inches wide and as tal} as necessary in order
ta be in perspective. If both dimensions are
set 1o zero, the printed picture will be as
wide as possible and as tall as necessary in
order to retain the picture’s perspective.

Pixels The Width and Height limits are interpreted
as pixels, instead of tenths of an inch. If one
of these values is set to zero, the same rules
for the Absolute option apply. The printout
will be the width or height specified, and as
tall or as wide as necessary to retain
perspective.

Multiply The Width and Height limits are used to
multiply the source picture’s width and
height. For instance, if you specified 2 Width
of 2 and a Height of 4, the printed picture
will be two times the source picture’s width
{in pixels} and four times the source picture’s

height.
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For example, if the source picture were 320 x
200 pixels, the printed picture would be 640
pixels wide and 800 pixels high.

if one of these values is set to zero, the same
rules for the Absolute option apply. The
picture will be scaled as necessary to
maintain the proper perspective,

Width/Height

These gadgets limit the width and height of the printed
picture. The value is interpreted as tenths of an inch unless
Pixels or Multiply is the selected Type. To enter a value, select
the text gadget, type the correct value, and press Return.

Density

This gadget selects the graphics print density. The lower the
density, the faster the image will print {on those printers with
multiple densities). When you select a higher density, more
dots are used to create the printout and the image is sharper.
However, it will take a long time for the image to print.

This option is not supported by every printer. You can check
the specifications for your printer in Appendix B, “Printer
Drivers”, to determine if multiple densities are supported.
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The Serial Editor

Open the Serial icon and the following window appears:

Workbheack Soreen

MU Rate: 9508 [ I
Inpet Buffer Size: 3512 W |
Nandshaking Parity Bits / Char Stop Bits
AMXHF @  Howe @ 1) 1@ Serial window
RTSACTS ) Even _J LX) t
Neng ) 0dd )
Mark _)
Spate ) x
Save_| Use | Cancel |
~
<
[ s E3kd]
In order to successfully communicate through a modem or
network, you must make sure that information is sent and
received in a form understandable and compatibie with the
device with which you are communicating. This window
lets you set the specifications for the serial port. Check the
documentation packaged with your serial device to determine
the appropriate settings.
Baud Rate
The baud rate determines the number of bits transferred With serial communi-
through the serial port each second. Since most characters are cation, information is

usually [0 bits (I start bit, § data bits, 1 stop bit), if you divide f:':;: :fi;f:eived one
the baud rate by 10, you ¢can approximate how many characters
per second (cps} are transmitted.
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The baud rate you select must match the rate of the device
with which you are communicating. The larger the value, the
faster che data is transferred. The available rates are: 110, 300,
1200, 2400, 4800, 9600, 19200, and 31250 baud. The current
rate is shown to the left of the slider.

Input Buffer Size

The input buffer is an area of memory set aside for serial
communication. The buffer holds incoming information that
15 sent to the Amiga. The available sizes are: 512, 1024, 2048,
4096, 8192, 16384, 32768, and 65536 bytes. The current size is
shown to the left of the slider. You may want to use a larger
buffer when working with a high baud rate or when the Amiga
is performing many tasks.

Handshaking

Handshaking refers to the method used to control the flow of
information through the serial port and the device attached to
it. The computer and the device must be set to the same
handshaking method in order to communicate. The available
choices are:

XON/XOFF  This is the most common method.
Characters embedded in the data stream
between the two devices regulate the data
flow. These special characters are called
XON and XOFE

RTS/CTS  With this method, data flow is regulated via
separate control lines, called RTS {Request
To Send) and CTS {Clear To Send).

NOTE: This method requires a propetly
wired serial cable.
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None This method causes handshaking to be shut
off entirely, allowing communication
between the devices without restriction or
regulation. Use this option with caution.

Parity

Parity refers to a method for detecting transmission errors.
Some computers check for errors in transmission by setting the
highest bit of each character a certain way. This bit is called the
parity bit. The computer checks this bit to ensure that the
transmission is complete and accurate. The available choices

are:
None All bits are used for data. This should he
used when Bits/Char 13 set to 8. No parity
checking occurs.
Even The total number of ON hits in each
character should always be an even number.
(Qdd The total number of ON bits in each
character should always be an odd number.
Mark The highest bit is always ON.
Space The highest bit is always OFFE.
Bits/Char

Bits per character specifies the number of bits that are sent
through the serial port for each character and the number of
bits expected for each character received.

This setting should correspond with your setting for parity. If
parity is set to Even, Odd, Mark or Space, bits per character
should be set to 7 since some systems look for parity in the 8th
bit of data. If parity is set to None, you should set bits per
character to 8.
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Stop Bits

Stop bits are extra bits added at the end of a character. They
allow the computer to correctly interpret spacing between
words and when a transmission ends. This pertains to both
characters sent and received through the serial port.

Slower-processing computers usually require two stop bits.
Computers which operate at 300 baud, or faster, generally
require one stop bit. If you are using 8 data bits, you can only
use one stop bit, or you may lose some data during
transmission.

The IControl Editor

1Control window —— ey

Open the IControl icon, and the following window appears:

ch Soreen

[
S T R AT T T 2 SR [al5

Verify Timeout Command Keys House
+5 Second ) i B streen to Frent Screen Drag
1.8 Second (® ﬁ%’r N o back skt _|
1.5 Seconds ) + TrORE screen 10 Bac el _|
1.0 seconds ) A [V] 1 Bewvester nt_|
5.0 Seconds _) A m ¢ Requester CAMCEL A V|
(wercion Niscetlaneous Flags

Rvoid flicker: V| Screen menu snap: |

Preserve colors: v Text gadget filter: |
gave_| Use w Cancel |

' 2 <|2),

This window lets you change several system settings, such as
the default keys for moving screens or for selecting an action
gadget in a requester. The different gadgets are explained below.
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Verify Timeout

In rare instances, the system may be waiting for a response
from a program you are running while, at the same tirne, the
program is waiting for the system to do something,

To help prevent this kind of sttuation, the Verify Timeout
gadget allows you to specify the amount of time that the
system will wait for a response from another program. If no
response is received in the allotted time, the system will
proceed and avoid a deadlock. In general, it is best to select a
longer period of time. The default setting is 1 second.

Command Keys

These four gadgets let you change some of the default keys
used by the Workbench. You can only specify a new letter key
to be used in conjunction with left Amiga. The use of left
Amiga cannot be changed. The defaults you can change are:

WBscreen  Specifies the key used to move the
to front Workbench screen in front of any other
screens. The defaultis N.

Front screen Specifies the key used to move the front-
to back most screen behind all other screens. The
default is M.

Requester  Specifies the key used to select the OK,
0K Retry or Continue gadget shown in a system
requester. The default is V.

Requester  Specifies the key used to select the Cancel
Cancel gadget in a system requester. The default
is B.
To enter a new key, select the text gadget, type in the new
letter and press Return.
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Mouse Screen Drag

Normally, you can hold down left Amiga, point anywhere in
the Workbench screen, and drag the screen by holding down
the selection bution and moving the mouse. This gadget lets
you specify other keys that can be used in addition to or in
place of left Amiga.

The available keys are left Shift, Ctrl, and left Alt. To select a
key, point to the check box to its night and click the selection
button.

For instance, if you select Ctrl, you must hold down Ctrl to
drag the screen. If Ctrl and Shift are selected, you must hold
down both Ctrl and left Shift to drag the screen.

Coercion

NOTE. These two options, Avoid flicker and Preserve colors,
are only applicable when Productivity mode is selected.

When a Productivity screen is displayed, your Multiscan
monitor works at a higher frequency than if an alternative
mode {Hires, SuperHires, etc] is displayed. When several
screens are open, the front-most screen determines the
frequency of the monitor. If you drag the front screen down so
that 2 Productivity screen and a non-Productivity screen are
both visible, the back screen may be distorted since the
maonitor is still operating at the frequency determined by the
front screen.

For instance, assume you have both a Productrvity Workbench
screen and a Hires paint program open. When the Productivity
screen is in the front, the monitor is working at a higher
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frequency than when the paint program is displayed. If you
drag the Productivity screen down, so that you can see both the
Workbench screen and the paint program screen, the paint
program screen may be distorted. This is because the monitor
is still working in the higher frequency.

However, the Amiga will try to display the back screen
properly, and in doing s0 may disturb the colors of the screen or
interlace the screen. The Coercion gadgets allow you to disable
these effeces Selecting the Avoid flicker box will prevent the
back screen from becoming interlaced. The Preserve colors
gadget keeps the screen’s original colors intact. However,
selecting these options may result in an even more distorted
back screen.

Screen Menu Snap

This option is provided for users who work with screens that
are larger than the monitor’s display area. Normally, the
Workbench menus appear at the top left corner of the screen.
If the left-most side of the screen is not visible, Screen menu
snap shifts the Workbench screen so that the menus are still
accessible. The screen only shifts while the menu button is
held down.

Text Gadget Filter

This gadget contrals whether control characters are recognized
when entered into text gadgets. A control character is a key
combination [usually Ctr] and an alphabetical key] that
performs a certain function. For instance, Ctrl-M is equivalent
to pressing Return.
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Several control characters which perform text editing
functions are listed below:

Curl-M Samee as pressing Return.

Ctrl-H Deletes character to the left of the cursor
{same as Backspace).

Ctrl-X Deletes the entire line

Ctrl-U Deletes all characters to the left of the
CUrsor.

Cul-K Deletes all characters from the cursor to the

end of the line,

Curl-A Moves the cursor to the beginning of the
line.
Ctil-Z Moves the cursor to the end of the line.

When Text gadget filter is selected, control characters that
perform editing operations can be entered into text gadgets,
and their functions will be performed. Control characters that
are not recognized as having editing functions will be ignored,
or filtered out.

When Text gadger filter is off, control characters will be
entered into the text. Special editing functions will not be
available. You can insert control characters inte the text
gadget, whether filtering is turned on or not, by pressing
Curl-left Amiga along with the desired alphabetical key.
For instance, to enter Ctrl-M, press Cerl-left Amiga-M.

NOTE: In certain windows with multiple text gadgets, like the
IControl window, pressing Tab moves the cursor to the next
text gadget. In these windows, even if Text gadget filter is off,
you must still press left Amiga-Tab to enter a Tab into the text

gadget.
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The Editor Menus and Presets Drawer

Each editor has three menus: Project, Edit, and Opticns. These
menus let you save changes to a specified file, enabling you to
save different configurations of the same editor. By defaule
these files are saved in the Presets drawer, although you can
save them elsewhere if you wish. If you save icons for the files,
you can implement the settings by opening the file’s icon. You
do not need to open the actual editor.

For instance, if you use two different printers with your
Amiga, an MPS 1250 and an HP Laser]et, you can save the
specifications for each printer in two different files in the
Presets drawer. When you wanted to use the MPS 1250 printer,
you could open the Presets drawer and just double-click on the
MPS 1250 icon. The specifications would immediately take
effect, although the Printer editor window would not open. Ii
you were to open the window, it would show the settings for
the MPS 1250. When you wanted to switch to the HP Laser]et,
you could simply double-click on the HP LaserJet icon.

This section explains each of the menus and provides a
detailed example of saving specifications for two printers,

The Project Menu

The options in this menu let you save the editor settings to a
specific file. It also allows you to open previously saved files.
The options are:

Open. .. Loads the information from a previously
saved file. When you choose Open, a file
requester appears.
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Save As...  Allows you to specify the file where you
want to save the currently displayed
settings. A default filename in the Presets
drawer is provided in the requester. If you
want to use a different filename, type in the
complete path, then select the OK gadget.

When you want to use those settings, open
the editor, choose the Open menu item, and
type in the complete path to the file. {The
default path is SYS:Prefs/Presets.| Select the
Use gadget, and the settings will be used
until you reboot the Amiga or open another
editor file.

You could also open the Presets drawer and
double-click on the file's icon.

Quit Exits the editor.

The Edit Menu

The options in this menu allow you to easily restore previously
used settings or the default settings. The options are:

Reset to Returns the editor settings to the default

Detaults settings.

Last Saved  Returns the editor settings to the last saved
settings.

Restore Returns the editor to the settings that were

displayed when the editor was open.
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The Options Menu

This menu contains one item to allow you to save icons with
your files. It is described below:

Save Icons?  Allows you to choose whether or not to save
icons with the files saved with the Save As
menu item. If you choose to save icons with
the files, the icons will be saved in the same
drawer as the file.

Fot instance, if you save printer
specifications to the SYS:Prefs/Presets/
Printer.pre file, the icon for the file will
appear in the Presets window. It you double-
click on the tcon, specifications saved in the
file will be implemented.

Using the Presets Drawer

Suppose you have two printets attached to your Amiga,

an MPS$ 1250 that you use for dot-matrix printouts and an
HP Laser]et that you use for high-quality, desktop publishing
output. The {ollowing example shows how to save printer
specifications for beth printers.

1. Open the Printer editor.

2, Make the appropriate selections to correspond with the
HP Laser]et printer.

3. Choose Save As from the Project menu,

When the requester appears, select the default file or
enter a filename, such as SYS:Prefs/Presets/Laser.

4. Without closing the editor, make the appropriate
selections to correspond with the MPS 1250 printer.



3-64 Preferences

5. Choose Save As from the Project menu.

When the requester appears, enter a new filename, such
as SYS:Prefs/Presets/MPS 1250.

6. Select the Save gadget.

The editor window will close and the current printer
specifications will be for the MPS 1250 printer.

When you want to use the HP Laser]et:

7. Open the Presets drawer, end double-click on the
Laser icon.

The settings for the HP Laser]et will take effect even
though the Printer editor does not open.

An alternative method is to open the Printer editor, choose the
Open menu item, and enter SYS: Prefs/Presets/Laser in the
requester,

When you want to use the MPS 1250, open the Presets drawer
and double-click on the MPS 1250 icon.



Chapter 4. The Workbench Programs

Chapter 3 taught you how to customize your Workbench and
set up your Amiga to work with various peripherals. This
chapter explains the rest of the drawers in the Workbench
window.

Aside from Prefs, there are five other drawers in the
Workbench2.0 disk window: System, Monitors, Utilities,
WBStartup and Expansion. The Utilities and System drawers
contain icons for programs included on the Workbench2.0 disk,
such as:

® (Clock, a program for displaying a clock on your screen

o AddMonitor, a tool that lets you notify the Amiga that
a monitor other than the standard RGB-style monitor
has been added to the system

e More, a program for displaying text files

# Say, a too] that lets the Amiga speak

The Monitors drawer contains icons used by the AddMonitor
program. The WBStartup drawer allows you to automatically
start different programs when you boot or power on the Amiga.

The Expansion drawer is sometimes used when you add
peripherals to your Amiga. If a peripheral uses the Expansion
drawer, it will be explained in the documentation packaged
with that product.

The first thing explained in this chapter is how to use Tool
Types. Tool Types let you specify different parameters for many
programs. Next, the programs in the System drawer are
covered, followed by those in Utilities. Finally, you'll leam
how to add programs to the WBStartup drawer.
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The Workbench Programs

Tool Types

Before you start reading about the Workbench programs, you
should take a few minutes to familiarize yourself with the
concept of Tool Types. As explained in Chapter 2, Tool Types
are used to specify parameters used by a program. For instance,
you can use a Tool Type to change the style of clock displayed
by the Clock program or to specify a file to be used by the
Display program.

Tool Types are usually in the form of KEYWORD =argument.
In this manual, the KEYWORD is shown in uppercase letters
while the argument is in lowercase letters. However, case
differences do not matter when entering the information.

You enter Tool Types in an icon’s Information window. Select
the appropriate icon, then choose Information from the [cons
menu. When the window appears you can add, delete or change
Tool Types.

Adding a Tool Type

1. Select the appropriate icon, then choose Information
from the Icons menu.

The Information window will appear,
2. Select the New gadget.
A cursor appears in the text gadget.
3. Type in the new Tool Type and press Return.

After pressing Return, the new Tool Type will appear in
the Tool Types scrolling list.
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To add another Tool Type, repeat steps 2 and 3.
4. Select the Save gadget to save the new information.

If you are adding more than one Tool Type, do not select
Save until you've entered all of them. Selecting Save
closes the Information window. If you do not want to
save your changes, select Cancel or the window’s close
gadget.

Deleting a Tool Type

1. Select the appropriate icon, then choose Information
from the Icons menu.

Any Tool Types you have added will be shown in the
Tool Types scrolling list.

2. Select the Tool Type you want to delete from the list.

Point to the Tool Type and click the selection button.
The Tool Type will now appear in the text gadget.
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3. Select the Del gadget.

To delete another Tool Type, repeat steps 2 and 3.

. Select the Save gadget to save the change.

Do not select Save until you have made all of your
changes. Selecting Save closes the Information window.
If you do not want to save your changes, select Cancel
ot the window’s close gadget.

Changing a Tool Type

1. Select the appropriate icon, then choose Information

from the Icons menu.

Any Tool Types you have added will be shown in the
Tool Types scrolling list.

. Select the Tool Type you want to change frdm the list.

Point to the Tool Type and click the selection button.
The Tool Type will now appear in the text gadget.

. Edit the text in the text gadget, making the necessary

changes, then press Return.

. Select the Save gadget to save the change.

Do not select Save until you have made all of your
changes. Selecting Save closes the Information window.
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The System Drawer

The System drawer contains programs that have an effect on
the way the system operates.
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The list below explains when or why you would need to use
each program. Please see the section describing the individual
programs for more information.

AddMenitor Informs the system that you've added
another type of monitor, such as an A2024 or
Multiscan monitor. You can also use it if you
have a monitor that supports the video
standard that is not normally used in your
country |PAL tor NTSC countries, and vice
versa),

BindMonitor Assigns names {Hires, SuperHires, etc.) to
the different display modes. BindMonitor is
automatically run, via the Mode_Names
tool, when the Workbench is started.

System window
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CL!

DiskCopy
FixFonts
Format
NoFastMem

RexxMast

SetMap

Starts the Shell, the program that lets you
communicate with the Amiga through
typed commands. The Shell is fully
explained in Chapter 7, “Introducing
AmigaDOS8."” The CLI is not explained in
this Chapter.

Makes copies of disks.
Makes new fonts accessible to the system.
Formats a floppy or hard disk.

Temporarily disables any expansion RAM
used by your Amiga. This is sometimes
needed when using older programs that do
not work properly if expansion RAM 1s
present.

Must be running in order for programs that
use the AREXX language to operate properly.
A command to start RexxMast is part of the
standard Startup-sequence (the file that is
read when the Amiga is turned on or
rebooted). You only need to open the
RexxMast icon if you remove the RexxMast
command frem your Startup-sequence or if
your computer doesn't have enough memory
to load the program. RexxMast is not
explained in this chapter.

Tells the Amiga what keyboard you are
using. You do not need to use SetMap if you
have an American keyboard.
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AddMonitor m"m““
You must use AddMonitor if you want to use the display I
modes available with non-RGB style monitors, such as an —

A2024 or Multiscan monitor. To use AddMonitor you drag an
icon for the type of monitor you want to use from the
MonitorStore drawer un the Extras2.0 disk to the Monitors
drawer on the Workbench2.0 disk.

There arc icons in the MenitorStare drawer for A2024,
Multiscan, PAL and NTSC monitors. The PAL and NTSC
icons are for users who have monitors that support the video
standard not used in their country.

For instance, if you live in Europe and use a PAL Amiga, but
have a monitor that also supports NTSC displays, you must
put the NTSC icon inte the Monitors drawer to make the
NTSC display modes available to your system. If you have an
NTSC system, you do not need to put the NTSC icon into the
Monitors drawer; the NTSC display modes will be your default
display modes.

To copy the icon to the Workbench2.0 disk:
1. Open the Workbench2.0 disk window.

2. Remove the Workbench2.0 disk from the disk drive,
insert the Extras2.0 disk, and open the Extras2.0 disk
icon.

NOTE: If you have two disk drives, do not remove your
Workbench2.0 disk. Just insert the Extras2.0 disk in the
other drive, and open the Extras2.0 icon.
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3. Open the MonitorStore drawer in the Extras2.0 disk
window.
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You can close the Extras2.0 disk window if you want to
unclutter your screen.

4. Drag the icon for your monitor type over the Monitors
drawer in the Workbench2.0 disk window.
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A requester will appear asking you to insert the
Workbench2.0 disk. You may have to swap between the
Workbench2.0 and Extras2.0 disks until the file is
completely copied.

NOTE: If you have two disk drives, you will not see this
requester. The system will copy directly from one disk to
the other.

Once the icon is copied, double-click on the monitor icon. The
AddMonitor program will tell the Amiga that the monitor has
been connected, and the corresponding display modes will be
available through the ScreenMode editor [explained in Chapter
3, “Preferences.”)

As long as the icon is in the Monitors drawer, AddMonitor will
be run every time you boot your Amiga. You will not need to
double-click on the monitor icon.

BindMonitor

The Amiga's ROM {read-only memory} contains data to
support the various display modes possible with the different
types of monitors. However, ROM does not automatically
recognize the display modes by name. For instance, a Hires
display is 640 x 200/256 pixels, but ROM does not recognize
the word Hires. It only recognizes the pixel configuration of
640 x 200/256.

BindMonitor assigns names to the different display modes so
that the system will associate the display mode with the
appropriate name. To make things easier, there is a file called
Mode_Names in the WBStartup window. Mode_Names
already contains the assignments for all the possible display
modes. As long as this icon is in your WBStartup drawer, the
system will automatically be told the display mode names
every time Workbench is loaded.
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When you open the ScreenMode Editor in the Prefs drawer, the
names assigned through BindMonitor [via the Mode_Names
file] will appear in the Choose Display Mode gadget. I
Mode_Names is ever removed from the WBStartup drawer,
only the display modes, such as 640 x 200 or 1008 x 800, will
appear in the ScreenMode window.

DiskCopy

You can copy a disk by selecting the disk icon, holding down
Shift, then double-clicking on the DiskCopy icon. The copy
procedure will follow the same steps as if you had chosen the
Copy menu item. A requester wili notify you when it is time to
swap disks.

The DiskCopy program is used by the Copy menu item in the
Icons menu. If you simply double-click on the DiskCopy icon,
you will e referred to the Copy menu item.

FixFonts

FixFonts should be used after you have added or deleted fonts
from your Fonts drawer. (The Fonts drawer does not have an
icon associated with it; you have to use the Show All Files
menu item in order to see the Fonts drawer on the Workbench.)

With a floppy disk system, the only font immediately available
to you is Topaz. Topaz ts stored in ROM. Other fonts are
available in the Fonts drawer on the AmigaFonts2.0 disk, but
to copy them to your Workbench2.0 disk, you would have to
delete information from the disk to make room for them.
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You should not delete files from the Workbench2.0
disk unless you are an experienced user. lnstructions
ate given in Chapter 7, “Introducing AmigaDOS," for
making room on the Workbench2.0 disk. If you do
decide to modify your disk to make room for fonts, be

sure to use a backup copy of your original
Workbench2.0 disk.

The Fonts drawer contains a font file and drawer for every font
available to the Workbench. For instance, inside the Fonts
drawer there is a .sapphire file and a Sapphire drawer which
contain the data needed to create the different sizes of the
Sapphire font.

Sometimes additional font files are supplied with word
processing or desktop publishing sottware. The software
usually includes instructions on adding the files to the Fonts
drawer. After you add fonts to the Fonss drawer, FixFonts
updates all the font files so that they accurately reflect the
current contents of the corresponding font drawers.

To use FixFonts, double-click on the FixFonts icen. FixFonts
does not open a window.

Format

You can format a disk by selecting the disk icon, holding down
Shift, then double-clicking an the Format icon. The formatting
procedure will follow the same steps as if you had chosen the
Format Disk menu item.

The Format program is used by the Fermat Disk menu item in
the lcons menu. If you simply double-click on the Format icon,
vou will be referred to the Format Disk menu item.
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NoFastMem

Some very old programs may not run propetly when memory
other than graphics memory is present in the Amiga system. In
this case, double-clicking on the NoFastMem icon forces the
Amiga to use only the available graphics mernory. The icon
works like a toggle switch. To restore all memory to the
system, double-click on the NoFastMem icon again.

SetMap

SetMap allows you to select the correct keymap for your
keyboard. A keymap teils the computer which character to
register for each key on the keyboard. The default keymap
stored in ROM is usa—a standard American keyboard.
Additional keymaps are included on the Extras2.0 disk |in the
Devs/Keymaps drawer).

Available Keymaps
Keymap Keyboard
cdn French Canadian
chl Swiss French
ch2 Swiss German
d German
dk Danish
e Spanish
f French
gb Great Britain
i Italian
is Icelandic
I Norwegian
s Swedish
usal For programs developed with V1.0
usal Dvorak
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With a floppy disk system, you must copy the correct keymap
from the Extras2.0 disk to your Workbench2.0 disk.

1. Open the Workbench2.0 disk window, and select
Show All Files from the Window menu.

Additional icons will appear in the window. Look for
the icon for the Devs drawer. You may need to scroll the
contents of the window, or enlarge the window, to find
the icon.

2. Open the Devs drawer.

A window will appear containing several fites and two
drawers: Keymaps and Printers. {You can safely close
the Workbench?2.0 disk window if you want to unclutter
the screen.)
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3. Remove the Workbench?2.0 disk from the disk drive,
insert the Extras2.0 disk and open the Extras2.0 disk
icon.

NOTE: If you have two disk drives, do not remove your
Workbench2.0 disk. Just insert the Extras2.0 disk in the
other drive, and open the Extras2.0 icon.

Keymaps drawer
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4.

Select the Extras2.0 disk window, and choose Show All
Files from the Window menu.

Just as with the Workbench2.0 disk window, an icon for
the Devs drawer will appear.

. Open the Devs drawer in the Extras2.0 disk window,

then open the Keymaps drawer that appears in the
Devs window.

You can close the Extras2.0 disk window and the
Extras2.0 Devs window if you want to unclutter the
screen. The only windows that need to be open are the
Workbench?.0 Devs window and the Extras2.0
Keymaps window

There will be several icons in the Keymaps window.
These 1cons represent the various keymaps for the
different keyboards used throughout the world.
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6. Find the icon that represents the correct keyboard for
your use,

7. Drag the correct Keymap icon out of the Extras2.0
Keymaps window and over the Keymaps drawer in the
Workbench2.0 Devs window.
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A requester will appear asking you to insert the
Workbench2.0 disk. You may have to swap between the
Workbench2.0 and Extras2.0 disks until the file 1s
completely copied.

NOTE: If you have two disk drives, you will not see this
requester.
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The angle brackets in-
dicate that informa-
tiom, in this case a file-
name, must be sabsti-
tuted. Do not type the
brackets.

Adding a Tool Type

Once the correct keymap is in the Keymaps drawer, you should
add a Tool Type to the SetMap icon’s Information window to
notify SetMap of the new keymap file. The format is
KEYMAP = <file>. For example, to enter the keymap for a
German keyboard:

1. Select the SetMap icon, then choose Information from
the Icons menu,

The SetMap Information window will appear on the
screen.

2, Select the New gadget.
A cursor will appear in the text gadget.
3. Type:
KEYMAP = d

Press Return, and the new Tool Type will appear in the
Tool Types scrolling list.

4. Select the Information window's Save gadget.
To implement your change, double-click on the SetMap icon.

You can have SetMap run automatically every time you boot
your system by dragging the SetMap icon into the WBStartup
drawer. |This is fully explained in “The WBStartup Drawer”
section on page 4-33.)
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The Utilities Drawer

The Utilities drawer contains some basic programs that you
may want to use while working with your Amiga.
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The programs are listed below:
Clock Displays a clock on the Workbench screen.
Display Displays an IFF graphics file.

Exchange = Monitors and controls the Commodities
Exchange programs on the Extras2.Q digk.

More Displays the contents of text files on the
screen.
Say Makes the Amiga talk.

Each of the these programs is explained in this section.
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analog clock

Clock

The Clock lets you display the time on your Workbench
screen. You can also use it as an alarm clock to signal you at a
specified time.
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When you open the Clock icon, a window with a round clock
face appears. If the time shown is incorrect, use the Time editor
in the Prefs drawer to set the clock [see Chapter 3].

When the Clock window is selected, menus are available that
let you change to a digital display, change the way the time is
shown, and set the alarm.

The Type Menu

This menu lets you change the way the clock is displayed. If
you choose Analog, the round clock appears. [This is the
default.) This is the only mode that lets you change the size of
the Clock window. If you choose Digital, a digital clock the
height of the title bar appears.
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The Mode Menu

This menu lets you choose a 12-hour or 24-hour clock. If you
choose the 12 Hour menu item, AM or PM is shown after
the time. If you choose 24 Hour and a digital display, time is
displayed as 0:00 [12:00 AM or midnight) through 23:59
{11:59 PM). 12 Hour is the defauit.

The Seconds Menu

This menu lets you choose to display the seconds. If you
choose the Seconds On menu item, a second hand appears on
the analog display. In a digital display, the seconds are shown
after the minutes (11:36:04). Seconds Off is the default.

The Date Menu

This menu lets you choose to display the date. If you choose
the Date On menu item, the date is shown underneath the
analog clock. If you are using the digital clock, the date and
time will be alternately displayed. Date Off is the default.

digital clock
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The Alarm Menu

With this menu, you can tell the Amiga o signal you at a
certain time. The signal is a brief flash on the display. If your
monitor is hooked up to the Amiga’s audio output, you will
also hear a short tone.

To set the alarm:
1. Choose the Set menu item.

In the requester that appears, time is shown in the same
mode as your clock — either 12 Hour or 24 Hour. If it is
shown in 12 Hour mode, an AM/PM cycle gadget will
appear next to the time sliders.
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The requester defaults to 12:00. It does not reflect the
currently set time.

2. To change the time setting, use the hour and minute
sliders.

Use the mouse to drag the bars up or down until the
correct time is displayed at the top of the sliders.
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3. When the requester displays the desired alarm time,
select the Use gadget.

If you want to restore the previous alarm setting, select
the Cancel gadget.

4. To turn the alarm on, choose the Alarm On menu jtem.

When the clock reaches the alarm setting, the screen
will flash and a short tone will sound.

The alarm will remain on and will flash at the same time each
day, until you choose Alarm Off. If the Clock is not displayed,
the alarm will not work. The next time you open the Clock,
you will have to reset the alarm.

Tool Types

By entering Tool Types in the Clock icon’s Information
window, you can save the menu, size and position settings so
that the Clock will open as you want it every time. The
acceptable Tool Types are:

DIGITAL  The clock will open in digital mode.
24HOUR  The clock will open in 24-hour mode.
SECONDS  The clock will display the seconds.

DATE The clock will display the date. The angle brackets
indicate that infor-

LEFT=<n>> The clock will open <n> pixels from the P
mation, in this case o
left edge of the screen. number, must be sub-
- ; : stituted. Do not type
TOP=<n> Theclock will open <n> pixels from the top the brackets

of the screen.
WIDTH=  The clock will be <n> pixels wide
<n> {disregarded if using a digital clock).

HEIGHT=  The clock will be <n> pixels high
<n> {disregarded if using a digital clock}.
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Display

Display allows you to view graphic files saved using the
standard Amiga IFF ILBM format. Most graphics created with
standard Amiga paint programs save files in this format. You
can create a slide show with Display by specifying multiple
files to be shown. You can advance from one picture to the next

automatically, or you can tell Display to wait for a mouse
click.

To display a single picture file:
1. Select the Display icon.

2. Hold down Shift, and double-click on the icon of the
picture file,

The file will be displayed on a new screen.

To retuzn to the Workbench screen, press Ctrl-C. You can also
click on the hidden close gadget in the upper left corner of the
screen.

An alternative method is to add a Defaulc Tool to the picture
icon’s Information window. If you do this, you will be able to
display the picture by opening its icon.

1. Select the picture icon, then choose Information from
the Icons menu.

An Information window will appear.
2. Select the Defoult Tool text gadget.

A cursor will appear in the gadget. Delete any existing
text.

3. Type in the path to the Display program as the
picture’s defeult tool.

Be sure to specify the complete path, such as
Workbench2.0:Utilities/Display.
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4. Select the Save gadget.

If you open the picture icon, the Display program will be run,
and the picture will be displayed.

To display multiple fites:
1. Select the Display icon.

2. Hold down Shift, and select the icons for the picture
files you want to display.

3. When you get to the last picture file, double-click on its
icon.

The first picture file will be displayed. Press Ctrl-C to
advance to the next picture. To exit Display before all
the pictures are shown, press Ctri-D.

You can also create an ASCII text file containing a list of the
IFF files that you want to display. This “filelist” can be created
with one of the Workbench text editors, ED or MEmacs, or
with any word processor that allows you to save files in ASCII
format. For instance, a sample file might look like this:

PigsDisk:Ar/Sea

PicsCisk: Ar/bountain

PicsDisk: Ar/Sky

PicsDisk: ArLightning

PicsCisk: ArGulls
This indicates that the IFF files are in the Art drawer on a disk
called PicsDisk. The filelist should be saved in a drawer
accessible by the Workbench, and it should have a project type
icon. {You can check this by opening the icon’s Information
window. If it is not a proiect, you can use the IconEdit program
to change the tcon’s type. See Chapter 5 for instructions on
using fconEdit.}

ASCII is a standard
texi formeal that can
be read by maay pro-
grams and computers.
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Open the flelist icon’s Information window, and add the
following Tool Type:

FILELIST = true

Select the Default Tool text gadget and enter the path to the
Display program, for instance, Workbench2.0:Utilities/
Display. This tells the system that the file is a project of the
Display Tool. When you open the filelist icon, Display will
automatically be run, and the pictures in the list will be
displayed.

Tool Types

Display supports several Tool Types for moving from one
picture to the next. You can move forward by clicking the
selection button or by specifying a certain amount of time for
Display to wait before moving ahead. Several of these Tool
Types are global, which means they must be added to the
Intormatian window for the filelist icon or for the Display
icon. The global Tool Types are listed below:

FILELIST =true Display all the pictures listed in the
ASCIl file.
MOUSE =true Clicking the selection button

displays the next picture file.
Clicking the menu button displays
the previously displayed picture.

LOOP=true When Display has shown all of the
selected picture files, it will loop
back, or start over, with the first
picture. This will continue until you
press Ctri-D.



BACK =true

PRINT =true

AUTOSCROLL =
true

TIMER = <seconds>
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The picture files will be displayed on
a back screen. The Workbench
screen will remain active and at the
front of the display. This is useful
when you are printing picture files
while doing something else.

Display will automatically print
each file that is displayed. You can
also print manually by pressing Ctrl-
P while the picture is displayed on
the screen.

If the screen is larger than the
display area, the screen will scroll
automatically when the pointer is
positioned at the edge of the screen.

Display will automatically advance
from one picture to the next in the
specified number of seconds. For
instance, if you enter TIMER = 5,
Display will automatically move
ahead to the next picture after 5
seconds have passed.

The following Tool Types can be entered on a per-picture basis.

EHB=true

NOTRANSB = true

VIDEQ =true

Unspecified, 6-bitplane pictures are
treated as Extra Halfbrite rather than
HAM.

Borders around the picture are not
transparent when genlocked.

The picture file will be displayed
with a full-video display clip.

The angle brackets
indicate that infor-
mation, in this case a
number, must be sub-
stituted, Do not type
the brackets.
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Exchange

E x Exchange lets you monitor and control the Commodities
Exchange programs stored in the Tools/Commodities drawer
on the Extras2.0 disk. [For more information on the individual
Commodities programs, see “The Commodities Drawer”
section of Chapter 5.)

When you open the Exchange icon, a window appears.
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Any Commodities that have been opened will be displayed in
the Available Commodities scroll gadget. When you select a
Commodity from the scrolling list, information about that
program appears beneath the gadget:
Title Shows the name of the selected Commodity.

Description  Gives a brief description of the program.

Status Shows whether the program is enabled or
disabled.

The gadgets to the right of the scroll window control the
selected program. Exchange also has an Action menu that
contains menu items corresponding to each of these gadgets.
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You can perform the same operation by choosing the menu
item or using the menu item’s keyboard shortcut.

The operations are explained below:

Show Brings the window for the selected
Commodity to the front of the screen. If the
window is closed, Show automatically
opens it.

if the selected Commodity does not open a
window, this gadget will be ghosted.

Hide Closes the window for the selected
Commodity but does not exit the program.
This is the same as selecting the window’s
close gadget or choosing the Hide menu
item from a Commaodity’s menu.

If the selected Commodity does not open a
window, this gadget will be ghosted.

Disable Tempotarily tumns off a Commodity.

Enable Turmns a Commmodity back on if it has been
disabled.

Kill Exits the currently selected Commodity

program. If the program has a window,
selecting the Kill gadget is the same as
choosing the Quit menu item.

The gadgets to the left of the Available Commodities scroll
gadget control the Exchange window. There are cotresponding
menu items in Exchange’s Project menu. These operations are
explained below:

Hide Closes the Exchange window, but the
program continues to rumn.

Quit Shuts down Exchange so that it is no longer
monitoring the other Commodities.
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More

More allows you to display ASCII text files on the Workbench
screen. To run More, select the More icon, then while holding
down Shift, double-click on the text file icon. If the text file
does not have an icon, use the Show All Files menu item in the
Window menu to display a pseudo-icon for the text file.

You can also run More without specifying the text file by
double-clicking on the More icon. In this case, a file requester
will ask you for the complete path to the text file you want to
read. This file requester contains a pattern gadget that allows
you to view all the files that match the specified pattem.
Pattern matching is fully explained in Chapter 7, “Introducing
AmigaDOS§.”

A typical More display looks like this:

ot
!III( L HT all quiet noreq
:::: " I.ml ’:et Tt directary for scripts
(‘I.Il’r| ra clizn

|f wsts 598 Ilnmtors
oin 595; nmtorsf"(l' info} as timom-start
ecute tmn-s

chy “Mniga System Software 2.8 Kickstart $ickstaet, Horkbench SHorkbeach®
MDriyers

The message at the bottom of the window, - -~ More (60%}) —--,
indicates the percentage of the file viewed so far.



To move through the display, use the following key sequences:

Space bar
Backspace
Retum

<

>

%n

Ctrl-L
ftext

.text
N

H
Q
Cul-C
Shift-E

A case-sensitive search means that More will fook for the text
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Displays the next page.

Displays the previous page.

Displays the next line.

Displays the first page.

Displays the last page.

Displays approximately n% into the file; if
you type %60, you will be moved 60% into
the file.

Refreshes the window.

More will perform 2 case-sensitive search
for the text specified after the slash (/).
More will perform a case-insensitive search
for the text specified after the period ().
Finds the next occurrence of the previously
searched for text.

Help {displays a list similar to this one).
Exits the program.

Exits the program.

Allows you to edit the file using the editor
set in ENV:editor {see Chapter 7 for more
information on environment variables|.

exactly as it is entered. If you type the text in capital letters,
More will only loak for occurrences of the text that appear in

capital letters.

A case-insensitive search means that it does not make a
difference whether the text is entered in upper or lowercase
letters. More will search for the text in any form.

When you reach the last page of the display, ——- End of File ———

is displayed at the bottom of the screen.
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Say

With Say, the Amiga can speak words typed on the screen.
When you open the Say icon, two windows appear.

1| Workbench E:II‘QJ

Phoneme window ——

Phonene uindoy

§ VOUP ARs5age, thew retuen.
W5 are;

n imale} =f {female)

e (robot) - (naturall

FsBl [speed 40-400)

[-p# {pitch 65-3200

¢ filenane (Command lime only)

Input window

<

} <]

The top window is the Phoneme window, and the bottom
window is the Input window. You enter text in the Input
window, and the text is displayed phonetically in the Phoneme
window and spoken through the Amiga’s stereo output
COnnectors.

To use Say:

1. Select the Input window, then type a word, phrase, or
sentence.
If your text reaches the edge of the Input window, do not
press Return. The text automatically wraps around to
the next line,

2. After you've entered your text, press Return.
The Amiga will literally say the sentence, while at the
same time the text will appear in the Phoneme window.
This is the phonetic interpretation of your input.
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[n some cases, it may help to spell a word phonetically (as it
sounds| to get the Amiga to repeat it correctly.

You can change the voice, pitch and speed of your Amiga’s
speech by choosing any of the different options shown in the
Phoneme window.

1. Select the Input window.

2. Type the letter, or letters, necessary to make your
changes, and press Return.

Your choices for voice and inflection are:

-m male voice —r robot inflection
—f  female voice -n natural inflection

When you change the voice, you can also change the
pttch so the change in the new voice is noticeable.
Type-p followed by a number from 65 through 320—the
higher the number, the higher the voice’s pitch. Do not
put a space between the p and the number.

To change the speed of the voice, type -5 followed by a

number from 40 through 400—the higher the number,

the faster the voice speaks. Do not put a space between
the s and the number.

phonetic interpretation

typed input

Say only understands
English phonetics. To
have the Amiga pro-
aounce other flan-
guages, the input
words must be spefled
according to English
promunciation rules.
For instance, the Ger-
man phrase ‘‘die
Weite” should be
spelled “dee Vytah'
for more correct pro-
nunciation.
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For example, to use a deep male voice with a natural inflection
that speaks at a moderate pace, select the Input window and
type:

-mn —5125 -pb5

Then press Return. Remember that the hyphen must be typed
before the alphabetical option. Next, enter some text. When
you press Return, the Say program will speak your text using
the new options.

To exit the Say program, select the Input window’s close
gadget. You can also select the Input window and press Return
without entering any text. Either of these actions will close
both the Input and Phoneme windows.

Tool Types

Say supports Tool Types for all the voice, pitch and speed
options. Instead of entering the options in the Input window,
you can enter them in the Say icon’s [nformation window. This
saves your selections so that they do not have to be re-entered
each time you open Say. The Tool Types are:

-m Male voice

-4 Female voice

-r Robot inflection

-n Natural inflection

-p# Sets the pitch; # represents a number

ranging from 65 through 320.

-s# Sets the speed; # represents a number
ranging from 40 through 400.

When you run Say, the options entered as Tool Types will be
used, unless you specify other options in the Input window.
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The WBStartup Drawer

Any icons stored in the WBStartup window will be opened
whenever the Workbench is started. For instance, if you drag
the Clock icon into the WBStartup window, the Clock program
will be run when you reboot, or power on, your Amiga.

If you are using a non-American keymap, you may want to put
the SetMap icon into the WBStartup drawer. This way the
correct keymap will be used each time you boot your Amiga.

The Mode_Names icon will already be in the WBStartup
window.

workbhe~ch 2.0 952872 qraph.cc ren 9748E2 other men

1] Horkbench I
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WBStartup window

Tool Types

The icons that are put into the WBStartup window support a
few special Tool Types:
DONOTWAIT Nommally the Workbench waits for one
program to finish executing before it opens
the next program. If you specify the
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The angle brackets
indicate that infor-
mation, in this case o
number, must be sub-
stituted. Do not type
the brackets.

WAIT =
<seconds:

STARTPRI=
< priority>

DONOTWAIT Tool Type, the Workbench
will open all the programs at once. DONQT-
WAIT does not take an argument.

If vou do not specify the DONQTWAIT Tool
Type, a requester may appear and state that
the program has not vet returned. The
system will ask you if it should wait some
more. Select the No gadget in the requester
to continte.

Lets you specify how many seconds the
Workbench should wait before opening the
next icon in the WBStartup window.

Lets you assign a priority to an icon so that it
opens before, or after, other icons. By
default, all icons have a priority of 0. The
acceptable range is from - 128 to +127—
the higher the value, the higher the
program’s priority.



Chapter 5. The Extras Programs

In Chapter 4, you learned about all the programs supplied on
the Workbench2.0 disk. This chapter explains the programs
found on the Extras2.0 disk, such as:

¢ Colors, which lets you change the colors of a screen
¢ GraphicDump, which prints entire screen images

¢ IconEdit, which lets you create and change icons

¢ KeyShow, which displays the keymap for your Amiga

When you are finished with this chapter, you should be
comfortable with the Workbench system and with running
programs through the Workbench.

NQTE: The Fountain ptogram, contained in the System
drawer, is explained in Appendix C.

The MonitorStore Drawer

This drawer contains icons for A2024, Multiscan, PAL and
NTSC monitors. These icons represent projects used by the
AddMonitor program (explained in Chapter 4) and provide an
easy way for you to notify your system that you have attached
one of these monitors.

See the “AddMonitor” section of Chapter 4 for full instructions
on adding an A2024, Multiscan, PAL or NTSC monitor to your
system.
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The Tools Drawer

Tools window

The Tools drawer contains programs that expand vour printing
options, allow you to change the color of non-Workbench
SCIeens, even Create new icons.
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The programs are listed below:

Calculator A standard, four-function calculator.

CMD Allows you to redirect printer output to
a file.
Colors Changes the colors of a non-

Workbench screen.
GraphicDump  Allows you to print screen images.

HDBackup A hard disk backup and restore
program. HDBackup is covered in the
documentation packaged with the
Commodore hard drive.



IconEdit
InitPrinter
KeyShow
MEmacs

PrintFiles
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Allows you to change and create icons.
Initializes your printer.

Displays the current keymap.

A text editor, explained in Chapter 6.
Sends files to the printer.

The programs in the Commodities drawer are explained
starting on page 5-28.

Calculator

The Calculator s a standard four-function calculator that you
can use to add, subtract, multiply and divide. Open the
Calculator icon, and the calculator appears.

Hzrktenzh Screer
| Horkbeach
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o] Tools
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e

1¢)3[2 -<|>J%
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It works like any standard calculator — vou enter numbers and
use the operations keys to reach an answer. The “’buttons” on
the calculator are gadgets. The numbered gadgets represent the
digits 0 through 9. The non-numerical gadgets represent:

CA  Clearall previous entries. Resets the calculator to 0.

CE  Clear the curtent entry. If you make a mistake
typing, select this gadget, and re-enter your value.

Multiply
/ Divide
+  Add
- Subtract

Decimal point
< — Delete the last digit entered

+ — Change the sign of the current entry. Positive
numbers become negative; negative numbers
become positive.

= Display the result of the operation.

To press a button, select the gadget with the mouse or press the
corresponding key on the keyboard. The <— sign corresponds
to Backspace.

For instance, to add 75 and 916:
1. Select the gadgets for 675 — 6, 7, and 5.

As you select each gadget, the corresponding number
will be displayed in the calculator window.

2, Select the + gadget.



The Extras Programs

5-5

o] Markbench IE”:;I
. H o] Cale H L]
! Ran Disk | 673.8
i ML 248 9]
Horkbench2. B ﬂi’ﬂﬂﬂ
. 3 2] 2 o~
Ex%‘m Lljﬂjil—’

1<|>J%

3. Select the gadgets for 916 — 9, 1, and 6.
4. Select the = gadget.
The sum, 1591, will be displayed in the window.

To do the same calculation using the keyboard, you could just
type 675, press +, type 916, then press Return. As you typed
each number, it would be displayed in the calculator window.

To exit the Calculator, select the close gadget.

CMD

CMD directs your printer output to a file. This is useful if you
do not have a printer attached to your Amiga. You can capture
your output on disk, then take the disk to another Amiga that
15 connected to a printer. You can also use it to save the images
from GraphicDump [explained later in this chapter).

Before you ¢an use CMD, you must tell the program some
details about how your system is set up and where you want
the printer output to be sent. This is done by adding Tool Types
to the CMD icon’s Information window.

“'-'*f':'-‘-"?||h.:h||
N L
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The angle brackets
indicete that infor-
reation must be substi-
tuted. Do not type the
brackets.

As shipped, CMD is set to certain default Tool Types. If your
choice is the default, you do not need to enter anything in the
Tool Types window. The recognized KEYWQRDS and

argurnents are:

DEVICE = <port> The Amiga port where your printer is

attached, either parallel or serial.
DEVICE = parallel is the default.

FILE = <filename>> This is the name of the file where you

SKIP =true

MULTIPLE = true

NQTIFY = true

want the printer output to be sent.
FILE = ram:CMD_file is the defauls.
This tells CMD to skip any short
initial write. Sometimes, especially
with screen dumps, the first write sent
to the printer is a printer reset. You can
use SKIP = true to ignore that first
write.

The default is SKIP = faise—initial
writes are not skipped.

This tells CMD to intercept more than
one file.

The default is MULTIPLE = false—only
one file is redirected.

This tells CMD to display progress
messages.

When CMD intercepts the file, a
typical message that may appear is:

Redirected <# of bytes> from
parallet.device to <filename>
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After the output is sent to the file and
CMD is turned off, another message
may state;

CMD redirection of parallel.device removed

The default is NOTIFY = false—
messages are not displayed.

To use CMD, double-click on its icon. The next time you send
information to your printer, it will be sent to the designated
file instead.

Colors

Colors lets you change the colors of a non-Workbench screen,

such as a screen opened by an application program like a

communications program or word processor. However, color
changes made with Colors are only temporary. They cannot be
saved to disk.

To change the colors of a screen, Colors must open on that
screen. The following exarnple will show you how to open
Colors on the MEmacs screen. {Don‘t worry about using
MEmacs at this point. It is fully explained in Chapter 6.)

1. Open the Tools window, and open the MEmacs icon.
MEmacs opens on another screen.

2. Drag the MEmacs screen down so that you can see the
Tools window on the Workbench screen.

Point to the MEmacs title bar, hold down the selection
button, and drag the screen down.
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MEmacs screen

Colors window
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3. Open the Colors icon in the Tools window.

The Colors window will open on the front-most screen
which will be the MEmacs screen.
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4. Drag the MEmacs screen back up to the top of the
display.



The Extras Programs

5-9

Using Colors

Just tike the Prefs Palette editor, the Colors window contains
color sliders that let you change the application screen colors.
The number of colors is equal to the number of colors in the
screen. In this example, the MEmacs screen is only made up of
two colors, so Colors will only have two colors in its color
selection gadget.

1. Select the color you want to change from the color
selection gadget.

The selected color appears in the display box that runs
along the left side of the Colors window.

2. Use the color sliders to change the selected color.

Drag the slider bars in the R {red}, G (green), and B (blue)
color sliders until you create the color you want.

color selection gadget

selected color

- NicrokKE - main

To return to the original screen colors, select the Reset
gadget. To implement your changes, select the Use
gadget. Select the Cancel gadget to exit Colors without
making any changes.

To exit MEmacs, click on the MEmacs screen and press Ctrl-C.
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Do not include the
brackets around the
numbers. They just in-
dicate that a substitu-
tion mast be made.

GraphicDump

GraphicDump prints, or dumps, entire screens, including
menus and icons, just as they appear on your monitor. Your
printer must be capable of printing graphtc images. Most dot-
matrix printers can print GraphicDump output.

Before using GraphicDump, make sure the settings in the
Printer and PrinterGex editors are appropriate for your printer.
You can specity the dimensions of the printout with the Limits
setting in the PrinterGfx editor. Otherwise, the printout will
be the full width allowed by the printer.

To use GraphicDump, double-click on its icon. In about ten
seconds the front-rmost screen trmage will be sent to the printer.
The ten second delay gives you time to open or close windows,
display menus, or move screens.

Tool Types

GraphicDump supports a SIZE Tool Type. The acceptable
arguments for SIZE and the resulting size of the printout are:

SIZE =tiny 1/4 the total width allowed by the printer.
SIZE=small  1/2 the total width allowed by the printer.
SIZE = medium 3/4 the total width allowed by the printer.
SIZE=large  Full width allowed by the printer. |default)

The height of the printout is such that the perspective of the
screen is maintained. The Limits Type gadget in the PrinterGfx
editor must be set to Ignore for GraphicDump to recognize
these arguments. Otherwise, the size of the printout is
determined by the Limits setting.

To specify specific dimensions in a Tool Type, use:
SIZE = <xdots>: <ydots>

Substitute the width, in number of dots, for the <xdots>
argument and the height for the <ydots> argument.
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IconEdit

IconEdit lets you personalize your Workbhench by changing the
appearance of existing icons and creating new icons.

Open the lconEdit icon, and the following window appears:

=]
_Iﬂ___l_l_lﬂ =)
E' selected color
] L] =
E "- '-. !
i - ol E color selection gadget
—. ..‘l .‘-l .-.-I §
I 8
—— =
magnifled view box
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Just as with the WBPattern and Pointer editors in the Prefs
drawer, you can draw and edit an icon in the magnified view
box. However, the IconEdit window also contains several
gadgets to give you more controi over your drawing, such as
gadgets for drawing squares, circles, and straight lines.

Color Selection Gadget

This gadget lets you select a color for drawing. In addition to
the standard way of selecting a color by pointing to it and
clicking the selection button, this color selection gadget also
allows you to choose two colors at once.



5-12

The Extras Programs

To create a “checkerboard” pattern, select the first coloy, hoid
down Shift, then select the second color. If you were to create a
solid box or circle, it would be filled with dots of both cotors.

To create a pattern of verrical bars, select the first coler, hold
down Alt, then select the second color

Keyboard shortcut: Press P to cycle forward through the colors.
Press Shift-P to cycle through dithered patterns using the
background color. Press / to reset the color to a solid pattern.

Magnified View Box

You use the mouse to draw your icon in this box. Click the
selection button, and a pixel of the selected color will appear.
Hold down the selection button while moving the mouse, and
you can draw with the mouse.

The pointer turns into cross hairs when it is in the magnified
view box. The center of the cross hairs is where the new pixels
appear. Pixel coordinates also appear in the lconEdit window
title bar to help you with the placement of your images.

Freehand Gadget

This gadget allows you to draw unstructured shapes very
quickly. If you select this gadget, then draw in the magnified
view box, the pixels will quickly fill in as the mouse passes
over them. However, you may not get a continuous line, and
some pixels may not be filled in. This gadget is useful when
you just want to sketch an icon, then go back and £ll in the
details later.

Keyboard shortcut: Press S to select the frechand gadget.
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Continuous Freehand Gadget it

This gadget is very similar to the freehand gadget except that
you will always get a continuous line. However, in order to
achieve a continuous line, you cannot draw as fast as you can
when using the freehand gadget. The pixels will not be
continually filled in as you move the mouse. There may be a
delay before the display catches up with your movement.

Keyboard shortcut: Press D to select the continuous frechand
gadget.

Circle Gadget @

To draw a circle:
1. Select the circle gadget.

2. Point inside the magnified box at the point where you
want the center of the circle, hold down the selection
button, and move the mouse.

As you move the mouse, you'l] draw a circle.

3. Release the selection butten when the circle is the size
that you want.

Selecting the right portion of the gadget lets you draw a filled
circie. You can fill the circle with a dithered pattern, by
selecting two colors from the selection gadget {as explained on
page 5-12]).

Selecting the left portion of the gadget lets you draw an outline
of a circle. To double the thickness of the circle’s outline, hold
down Ctrl before releasing the selection button [step 3 above).

Keyboard shortcat: Press E for an outlined circle; Shift-E for a
filled circle.
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Box Gadget 1]

To draw a box:
L. Select the box gadget.

2. Point inside the magnified box at the point where you
want a cornet of the box, hold dewn the selection
button, and move the mouse.

As you move the mouse, you'tl draw a box.

3. Release the selection button when the box is the size
that you want.

Selecting the right portion of the gadget lets you draw a filled
box. You can fill the box with a dithered pattern by selecting
two colors from the color selection gadget [as explained on
page 5-12).

Sclecting the left portion of the gadget lets you draw an outline
of a box. To double the width of the box’s outline, hold down
Ctrl before releasing the sclection button {step 3 above),

You can automatically draw a three-dimensional box like the
type that surround the Workbench icons by holding down an
Alt key while drawing a box outline. To draw an "unselected”
hox hold down left Alt. To draw a selected box, hold down right

Ale.

Keybeard shortcut: Press R for an outlined box; Shifc-R for a
filled box.

Line Gadget s,

To draw a straight line:
1. Select the line gadget.
2, Point to the place where you want the line to stort.
3. Hold down the selection button.
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4. Move the mouse to where you want the line to end.
5. Release the selection button,

As with the circle and box gadgets, you can double the
thickness of the line by pressing Ctrl before releasing the
selection button.

Keyboard shorteut: Press L to select the line gadget.

Fill Gadget

You can use the fill gadget to fill an area of the magnified view
box with the selected color. This is an easy way to change the
color of a complete area. Assume there is an icon with text in
it, and you want to change the color of that text. Simply select
the new color, setect the fill gadget, then move the pointer
inside one of the letters and click the selection button. The
letter will change to the new color.

NOTE: The fill gadget will not work on a dithered pattern.
Keyboard shortcut: Press F to select the fill gadget.

Undo Undo

Select Undo to cance] the last mouse action that took place in
the magnified view box.

Keyboard shortcut: Press U to select the Unde gadget.
Clear Clear

Select the Clear gadget to erase the contents of the magnified
view box. The magnified view box will fill with the currently
selected color.

Keyboard shortcut: Press Shift-C to select the Clear gadget.
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Normal/Selected Radio Buttons

The Normal and Selected radio buttons let you switch between
unselected and selected images for an icon. The normal image
is how the icon will look when it is unselected. The selected
image is how the icon will appear when you click on it.

When the Normal radio button is selected, any image drawn in
the magnified view box will appear in the normal view box at
the top of the window.

When the Selected radio button is selected, you can create the
image that will appear when the 1con is selected. You can only
select this radio button when the Image menu item is chosen

from the Highlight menu. {All the menus are explained later in
this section.) Any image you create will appear in the selected
view box.

ieyboard shortcut: Press Shift-S to select the Selected radio
button; Shift-N for the Normal radio button.

Arrows

The arrows let you shift your image. By pointing to an arrow,
and holding down the selection button, you can move the
image in the magnified view in the direction of the arrow. You
can use these arrows to contral the placement of your image
within the box surrounding the finished icon.

Keyboard shortcut: Press the corresponding cursor key to move
the image.
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The Project Menu
The items in the Project menu let you open and save icon files.
New AN

Loads the default icon for the currently chosen type of icon.
{The type of icon is determined by the Type menu, see page
5-18.) if you have made any changes to the window that have
not been saved, a requester will ask you if you want to save
those changes.

Open... AO
Opens an existing icon file. A requester appears so that you can
enter the name of the file that you want to open.

Save AS
Saves an existing icon file, averwriting the file. For instance, if
you opened a file called Testlcon, then you made changes to
that icon, choosing Save would save those changes to the
Testlcon file. The previous contents will be lost.

SaveAs... AA
Assigns a filename to the current image. A requester lets you
enter the name of the file where you want the image to be
saved.

Save As Default Icon AD
Saves the current image as the default icon used when you
choose the Show All Files menu item in the Workbench
Window menu or the New menu item in the lconEdit Project
menu.

For instance, if you create a drawer icon, then choose Save As
Default Icon, that icon will be used to represent drawers when
you choose the Show All Files menu item.

Quit AQ
Exits the IconEdit program. If you have not saved the current

image, a requester will ask if you want to save the image before
exiting [conEdit.
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The Edit Menu

The items in the Edit menu allow you to import IFF ILBM clips
that were created with other paint packages. To do this
IconEdic uses the clipboard, an area of memory that 1s used to
store text and graphics while they are being transferred
between programs.

Cut AX
Deletes the image in the magnified view box and copies it to
the clipboard.

Copy AC
Copies the image in the magnified view box to the clipboard.
Paste AV

Copies any image in the clipboard to the magnified view box,
replacing the current contents.

Open Clip...

Copies an existing IFF file into the clipboard. A requester
appears so that you can enter the name of the file you want to
open.

Save Clip As...
Saves the current contents of the clipboard to a specified file.

Show Clip

Displays the contents of the clipboard using the Display
program. I the Display program cannot be found, for instance,
if the Workbench?2.0 disk is not in a drive, Show Clip will not
work.

The Type Menu
The items in the Type menu allow you to specify the type of

icon you are changing or creating,

Disk Al
Represents the disk icons that appear in the Workbench
window.
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Drawer A2
Represents the drawer icons that appear in a disk window, such
as the Utilities or Tools drawer.

Tool A3
Represents a tool, such as the Calculator, Clock or IconEdit
program.

Project Ad
Represents a project, an icon that has been created by a tool,
such as the Mode_Names icon or any of the icens in the
MonitorStore drawer.

Garbage AD
Represents the Trashcan drawer.

The Highlight Menu

The items in the Highlight menu allow you to determine how
an icon will appear when it is selected.

Complement A7
Highlights the entire icon, including cthe background of the box
surrounding the icon. For instance, if you are using the default
Workbench colors and the icon is surrounded by a field of grey,
the grey will become blue when the icon is selected.

unselected selected
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Backfill A8
Highlights the icon, but not the background of the box. For
instance, if you are using the default Workbench colors and the
icon is surrounded by a fleld of grey, the grey will remain grey
when the icon is selected.

unselected selected

Image A9
Creates an entirely different image for the selected icon |an
animated icon). For instance, the drawer icons on the
Workbench are animated. When you select a drawer, it does not
change color. Instead an entirely new image of an open drawer
appears.

The Images Menu

The items in the Images menu let you manipulate the images
in the normal and selected view boxes and import [FF images
created with other graphic programs.

Exchange AE
Swaps the 1mages that appear in the normal view and the
selected view.

Copy AC
Copy is dependent on which radio button is selected. If Normal
1s selected, the image in the normal view is copied to the
selected view. If the Selected radio button is selected, the
image in the selected view is copied to the normal view.



Use Template

Copies a box the same size as the standard Workbench icon box
into the magnified view. You can then create your new icon
within this box.

Load
Loads previously saved images. When you point to the Load
menu item, a submenu appears. The available submenu items
are:
Normal Image AY
Loads the unselected image of the specified ican into the

normal or selected view box, depending on which radio
button is selected.

Selected Image AU
Loads the selected image aof the specified icon into the
normal or selected view box, depending on which radio
button is selected.

Both Images Al
Loads both the normal and selected images of the specified
icon into the appropriate view boxes,

IFF Brush Al
Allows you to load an [FF file created by another program
as either the normal or selected view, depending on which
radio button is selected.

When you choose an item from the submenu, a requester
appears to allow vou to specify the file that you want to load.
You must specify the correct drawer and filename.

Save IFF Brush AK
Saves an image as an IFF file.
Restore AR

Returns the IconEdit window to the state it was in when you
opened the window or last selected New or Open.
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The Extras Menu

The items in the Extras menu control a few miscellaneous
features of lconEdit.

Recolor AM
Switches the colors of any pixels using the second and third
colors in the color selection gadget. By default the second color
is black and the third color is white. i you are using the default
colors, choosing Recolor will make all white pixels black, and
VICE Versa.

Auto TopLeft AT
Moves the image to the upper left corner of the magnified view
box.

Color Palette. . .
Opens the Preferences Palette editor so that you can change the
default colors.

The Settings Menu

The items in the Settings menu ailow you to save various
IconEdit options.

Use Grid

When Grid is chosen, each pixel in the magnified view box is
distinct. You can see the background color surrounding each
pixel. A check mark next to the menu item indicates that this
option is tumed on. When Use Grid is not chosen, the pixels
blend together smoothly. The default is for the grid to be on.

Save Icons!?

If Save Icons is chosen and you save the contents of the
magnified view box with the Save IFF Brush menu item, an
icon will be saved with the IFF file, if Save lcons is not chosen,
no icon will be saved. The default is for icons to be saved.

Save Settings

Save Settings saves all of the current fconEdit settings,
including the size and position of the IconEdit window and file
requesters and all of the menu item settings.
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IconEdit supports the following Tool Types:

UNIT=<n>

XMAG=<n>

YMAG=<n>

LEFTEDGE =
<n>

TOPEDGE=
<p>

FRLEFTEDGE =
<n>

FRTOPEDGE =
<N

FRWIDTH =<n>

FRHEIGHT =
<n>

PALETTE =
<path>

Specifies the clipboard unit to use. 0 is
the default.

Allows you to enlarge the width of the
magnified view box. XMAG accepts a
number from 4 to 16. The default is 4.

Allows you to enlarge the height of the
magnified view box. YMAG accepts a
number from 4 to 16. The default is 4.

Specifies where to place the left edge of
the editor window.

Specifies where to place the top edge of
the editor window.

Specifies where to place the left edge of
the file requester, relative to the editor
window. For instance, FRLEFTEDGE =0
will align the left edge of the file
requester with the left edge of the
editor window.

Specifies where to place the top edge of
the file requester, relative to the editor
window.

Specifies the width, in pixels, of the file
requester.

Specifies the height, in pixels, of the
file requester.

Specifies the complete path to the
Palette editor. This is used when the
Color Palette menu item is chosen.
The default is SYS:Prefs/Palette. You
will only need to change this if you
have moved your Palette editor.
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SHOWCLIP=
<path>

NOICONS

NOGRID

ICONDRAWER =
<path>

ILBMDRAWER =
<path>

CLIPDRAWER =
<path>

ALTDRAWER =
<path>

SRC

Specifies the complete path to the
utility used to display the clipboard.
The default is SYS:Utilities/Display. If
you only have one floppy drive, you
may want to copy the Display program
onto your Extras2.0 disk, and change
the path to reflect this. You could also
change this Tool Type if you have
another program you would rather use
for displaying the clipboard.

Disables the creation of icons when
saving support files, such as when
saving a file as an [FF brush.

Disables the use of the grid in the
magnified view box.

Specifies the default drawer to be used
by the file requesters that appear when
the Open and Save As menu items in
the Project menu ate chosen.

Specifies the default drawer to be used
by the file requesters that appear when
the Load and Save IFF Brush menu
items in the Images menu are chosen.

Specifies the default drawer to be used
by the file requesters that appear when
the Open Clip and Save As Clip menu
items in the Edit menu are chosen.

Specifies the default drawer to be used
by the file requesters that appear when
the Load menu item in the Images
menu is chosen.

Creates a Save As C .. . menu item in
the Project menu. This allows you to
save the icon as C source code.



InitPrinter

In Chapter 3, you learned how to use the Printer and
PrinterGix editors to specify your print options. InitPrinter
sends the printer options to the printer. This is known as
initializing your printer.

To use InitPrinter:
1. Turn on your printer.
2. Double-click on the InitPrinter icon.

You may hear your printer reset. This is normal. It just means
that the printer is receiving the mformation from the Amiga
and is processing it.

KeyShow

The KeyShow program allows you to view the current keymap
for your model of Amiga. When you open the KeyShow icon,
the following window appears:
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This display shows o
keyboard with a USA
keymap. If you are us-
ing another keymap,
your display may
vary.
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These colors corre-
spond to the defoult
colors used by the
Workbench.

The initial display shows the characters that appear when a
key is pressed alone. For instance, the Q key shows a lower
case . However, when you press a qualifier key with a
character key, you may get different output. For KeyShow the
acceptable qualifer keys are Ctxl, Shift and both Alt keys.

To see the characters that are output when a qualifier key is
pressed simultaneously with a character key:

1. Select any of the qualifer keys that appeaor in the
KeyShow window.

The qualifier key will be highlighted to represent its
being pressed. The KeyShow display will change to
indicate the output that you get if you press the selected
qualifer key along with a character key. You can select
any combination of qualifers and the display will
change accordingly. Select the qualifier key again to
returm it to its unpressed state.

Keyboard shortcut: Instead of pointing to the qualifer
key in the display, you can simply press the
corresponding key on the keyboard.

The following list is a guide to interpreting the KeyShow
display:

® Grey keys are qualifier keys not currently pressed. For

example, when you first open the KeyShow window,
Ctrl, Shift, and Alt appear in grey. This is because
KeyShow is not using those keys in the initial display.

# Blue keys are dead keys. A dead key is one which

modifies the output of the key pressed immediately
afterward. For instance, on the USA keyboard, the Alt-G
combination is a dead key representing the grave accent.
If you press Alt-G, then press E, you will superimpose
the accent symbol over the e [&].

NQOTE: This multiple-key stroke procedure does not
apply to Del, Help, the functions keys, or the cursor
keys.
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¢ Bold-italics indicate that a key may be used in
comjunction with a dead key. In the above example, E can
be modified by a dead key.

¢ $3% indicates that it would take more than one character
to define the key.

¢ If a characteris preceded by a tilde |~ or a caret{" ), itis a
control character.

® Blank keys are undefined for the currently selected
gqualifer(s).

PrintFiles

PrintFiles sends files to your printer. PrintFiles accepts
multiple files, so you can use drag selection or extended

selection to specify a series of files to be printed. [f PrintFiles
cannot find or open one of the files, it will skip it and go on to
the next one.

To use PrintFiles:

1. Select the icon of the first file you want to print, hold
down Shift and select the icons of any additional files
you want to print.

You can also use drag selection to select the icons.

2. Hold down Shift, and double-click on the PrintFiles
icon.

When printing multiple files, you may want to add a form feed
between each file. To do this add a FLAGS =formfeed Tool
Type to the PrintFiles Information window.

A form feed starts each file on a new page. Without a form feed,
the next file will start printing immediately after the first file
ends. For instance, if your first file stops in the middle of the
page, the second file will start printing on that same piece of
paper. If you add a form feed, the second file will begin on a
new sheet.
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The Commodities Drawer

Exchoage is explained

on page 4-27.

Commaodities

i g

The Commodities drawer is in the Tools drawer and contains
the Commodities Exchange programs. These programs
monitor your keyboard and mouse input to the Amiga before
Workbench or any other application programs, such as a paint
program or communications program.

The Exchange program in the Utilities drawer on the
Workbench2.0 disk monitors and controls all the other
Commodities programs, which are shown below:

Harkben:h 7.8 353476 qraphics nen 931944 other nenm ]
o] Morkbeach Lalk=]
MJ a] Comedities 1BI5)
Ram Disk lJ ﬂ
L w
i Rutefoint ey

Worihenth?. 8 _.:l _1_;,_

NEAEX

1 <]

AutoPoint  Automatically activates the window under
the pointer.

Blanker Causes the screen to go blank if there has
been no input for a specified period of time.

ClickToFront Brings a window to the front of the screen by
double-clicking in it.

FKey Lets you assign text to function keys.
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[Help Gives you keyboard control over certain
operations usually performed by the mouse,
like enlarging or shrinking windows.

NoCapsiock Temporarily disables the Caps Lock key.

All of the Commodities programs share a common Tool Type,
CX_PRIORITY = <n>>, which assigns priorities to the
Comumodities Exchange programs. This priority is only relative
to the other Commodities programs. All the programs are set
to a default priority of 0. If you enter a Tool Type changing the
priority to a higher value, that program will have priority over
any other Commodities Exchange program.

For instance, IHelp and FKey both allow you to assign
operations to function keys. If both programs have an
operation assigned to F1, the program with the highest priority
will intercept the key first, making it unavailable to any other
Commodities programs.

Thete are two Tool Types that only apply to programs that open
a window, such as Blanker and FKey. CX_POPUP = no prevents
the program window from opening when the icon is opened.
The program will be activated when you double-click on its
icon, but its window will remain closed.

CX_POPKEY = <key> determines the hot key for the program.
When the hot key {or key combination) is pressed, the
program’s window is automatically brought to the front of the
screen. If the window is hidden, it will be opened. The hot key
does not start a program.

When specifying key combinations, leave a space between the
two keys. For instance:

CX_POPKEY =F9
CX_POPKEY = Shift F4
CX_POPKEY = LShift LAlt LCommand X

For a list of acceptable key combinations, see the chart on page
5-30.

Be sure to inclade the
underscore after CX.
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Acceptable Key Combinations

When specifying key combinations for a Commaodities
Exchange program, you can use any of the function keys

{F1 through F10] and any of the keys in the typewriter area

of the keyboard {numbers, letters, symbols, etc.|. However,
keys from the typewriter area must be preceded by a qualifier.
The allowable gnalifiers are:

Qualibier Key

Ale either Alt key

RAlt right Alt only

Lalt left Alt only

Shift either Shift key

RShift right Shift onty

LShife left Shift only

LCommand left Amiga

RCommand right Amiga

Control Cerl

Numericpad specifies a key on the numeric
keypad

Rbutton click the menu button

Leftbutton click the selection button

Qualifiers can also be used before function keys, but it is not
mandatory. You can use any combination of qualifiers, but it
must be followed by a typewriter or funtction key. A qualifier is
only recognized once in a combination, so a combination of:
LAlt RCommand LAlt F10
is the same as
LAlt RCommand FI10
Some acceptable combinations are listed below:
AltF6
LCommand 8
Control LShift Y
Lefthutton Control CapsLock =
Numericpad 8
'Click the selection buteon, then press Cerl-Caps Lock-=.

Press the 8 in the numeric keypad. The 8 in the typewriter area will
not satisfy the combination.
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AutoPoint

AutoPoint allows you to select windows without clicking the
selection button. To start AutoPoint, double-click on its icon.
AutoPoint does not open a window.

When AutoPoint is ronning, the system activates the window
that is underneath the pointer. This eliminates the need to
click the selection button.

The AutoPoint icon acts like a toggle switch. To exit
AutoPeint, double-click on its icon again. You can also open
the Exchange window, select AutoPoint from the scroll gadget,
then select the Kill gadget.

Blanker

When the Blanker program is operating, the screen will
automatically go blank if no input has been received during a
specified period of time. This helps preserve your monitor.
The default time is 60 seconds. If you do not press a key or
click a mouse button during a 60 second period, the screen will
go blank. When you double-click on the Blanker icon, the
following window appears:

worshech Siresn

0] Workbench E

K

Ram Disk

Horkh miz [] Seconds

[xmrs-J.l oS

Blanker window

|<]> I
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The angle brackets
indicate that infor.
mation must be substi-
tuted. Do not type
the brackets.

To change the default time, select the Seconds text gadget,
and enter the new value. To close the window, but not exit
the program, select the Hide gadget. If you want to exit the
program, select the Quit gadget. You can also choose the Hide
and Quit menuv items.

Tool Types

Blankert supports a SECONDS = <n> Tool Type that atlows
you to specify the number of seconds that will pass before the
screen goes blank. For instance, to change the value to 30
seconds, enter SECONDS = 30.

ClickToFront

ClickToFront allows you to bring a window to the front of the
screen by holding down left Alt and double-clicking in the
window. (The use of left Alt can be changed. See the “Tool
Types” section below.] You do not need to select the window's
depth gadget. To start Click ToFront, double-click on its icon.
[t does not open a window. {Remember, you can also put
ClickToFront in the WBStartup drawer so that it is
automatically started each time you hoot )

To exit ClickToFront, double-click on its icon again, or open
the Exchange window, select ClickToFront from the scroll
gadget, then select the Kill gadget.

Tool Types

ClickToFront supports a QUALIFIER Tool Type. This allows
you to specify a qualifier key that must be pressed while you
double-click in the window you want to bring to the front of
the screen. There are four acceptable key arguments:

Lalt Left Alt—Default
Ralt Right Alt

Control  Ctrl

None No key



For instance, if you have specified QUALIFIER =Lalt and
ClickToFront is activated, you would hold down lett Alt and
double-click in the window you wanted to bring to the front of
the screen.

FKey

FKey allows you to assign text to a function key. This is of
particular interest to frequent Shell users as it eliminates
repetitive typing of AmigaDOS commands.
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FKey assigns the function keys to the specified text before
the system or any other application accesses the key.
Therefore, if your application uses function keys, you
should disable or quit FKey when using that software.

When you open the FKey icon, the following window appears:

FKey window

T |

o] MRey: Metkeysalt 1 L) lﬂl%
Fi [Status Fyll'n | ré [<Fe> |
F2 [Birn | F? s |
F3 [[istn I e [ ]
P4 Iﬂ\ [ F9 [k ]+
£5 [T5 GINEID ]

Nodifier: 0|  None |
$ave _| Use [ Cancel I Quit !
l<I>I'VZ

lext gadyet
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You can assign text to every function key and Shifted function
key, giving you a total of 20 assignments. Notice that the first
three function keys are already assigned to AmigaDQS
commands. These are Status Full, Dir, and List, respectively.
The output of these function keys is viewable through the
Execute Command menu item or a Shell window. You can edit
these text gadgets if you wish.

To enter text, select the appropriate text gadget in the FKey
window, and type the text.

Some special characters supported by the text gadgets are:

N\n  Adds a Return. If the function key is linked to an
AmigaDOS command and the \\n is omitted, the
command will appear in the Shell window, but you
will have to manually press Return.

NI Adds a Return.
Nt Adds a Tab.
0  Adds azero.

<key> You can use angle brackets to enter key
combinations; the combination must be prefaced
by a qualifier.

There are several gadgets at the bottorn of the FKey window.
The Modifier cycle gadget determines whether the text is
attached to the function key alone or to the combination of
Shift and the function key. When None is displayed, the text is
assigned to the function key alone. When the gadget displays
the word Shift, text is assigned to the Shifted function key.
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The four action gadgets allow you to enable or quit FKey:

Save

Use

Cancel

Quit

Enables FKey and permanently saves the
text entered in the window. The text will be
saved even after FKey is shut down.

Enables FKey and temporarily uses the text
in the window. When FKey is shut down, the
current text will be lost, and FKey will
revert to using any previously saved text.

Enables FKey but ignores any recent changes
made to the text. Only the last saved text is
recognized.

Shuts down the FKey window disabling all
function key assignments until the program
is run again. This is the same as choosing
the Quit menu itern.

The next time you start FKey, only the saved text will be
present in the window.

Tool Types

FKey supports a <Function Key> = <text> Tool Type which
allows you to assign text to a function key. The acceptable
values for <Function Key>> are F1 through F10 and SF1
through SF10 for Shifted function keys.

The function key assignments mirror those made in the FKey
window. If you enter text in the window, it will appear in the
Tool Types gadget, and vice versa.

The angle brackets
indicate that infor-
mation must be substi-
tuted. Do not type the
brackets.
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IHelp

IHelp allows you to use the kevboard, instead of the mouse, to
perform certain operations usually performed by the window
gadgets. To start [Help, double-click on its icon. [Help does not

open a window.

The operations performed by IHelp, and the default function
keys assigned to those operations, are listed below:

Cycle windows
{Detault—F1)

Enlarge window
(Default—F2)

Shrink window
(Default—F3|

Cycle screens
(Default—F4|

Zoom window
(Detault—F5)

Brings the rearmost application window
on the Workbench screen 1o the frong of
the screen and activates it. This only
affects application windows opened by
tools or projects, such as the Clock. Disk
and drawer windows are not affected.

Enlarges the active window to its
maximum size, taking into account the
edges of the screen.

Shrinks the active window to its
minimum size.

Brings the rearmost screen to the front of
the display.

Zooms the active window just as if you
had selected the window’s zoom gadget.

To exit [Help, double-click on its icon again, or open the
Exchange window, select IHelp from the scroll gadget, and
select the Kill gadget.
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Tool Types

You can change the default keys assigned to the [Help
operations by entering Tool Types in the IHelp icon’s
Information window. Each Tool Type takes a key argument.
This argument is the key or key combination that you want to
press to invoke the operation.

The acceprable Tool Types and the aperations they correspond
to are listed below:

CYCLE= Cycle windows. For example,
CYCLE = Shift C
MAKEBIG = Enilarge active window. For example,

MAXKEBIG = Control Shift B

MAKESMALL = Shrink active window. For example,
MAKESMALL=RAL §

CYCLESCREEN = Cycle screens. For example,
CYCLESCREEN =LShift Alt §

ZIPWINDOW = Zoom active window. For example,
ZIPWINDQW = RCommand Z

NoCapsLock

NoCapsLock disables the Caps Lock key. The Shift keys suill
function normally, but you don’t have to warry about
accidentally pressing Caps Lock while using the kevboard.

To start NoCapsLock, double-click on its icon. It does not open
a window. To exit NoCapsLock, double-click on its icon again,
or open the Exchange window, select NoCapsLock from the
scroil gadget, and select the Kill gadget.






Chapter 6. MEmacs

MEmacs, which stands for MicroEmacs and is pronounced
“M-E-MACS,” is a screen-oriented text editor found in the
Tools drawer of the Extras2.0Q disk. A text editor has the basic
tunctionality of a word processer, but it does not support style
formatting options, such as italics, page numbering or font
changes.

With MEmacs you can edit one or more files at the same time.
However, each file must be able to fit into memory in its
entirety, so you are limited by the amount of memory avaitable
to your system and the size of your files.

This chapter explains how to:

& start MEmacs

® move around the MEmacs screen

& use the menus for operations such as copying blocks of
text or performing search and replace operations

® create macros to allow you to easily repeat complex
operations
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Using MEmacs

To start MEmacs, double-click on the MEmacs icon in the
Tools drawer of the Extras).0 disk. A new screen will appear:

_

%

F- MicrofMACS -- main

The bottom line of the screen displays the name of the buffer
that is currently in use. A buffer is an area of memory [RAM
that MEmacs uses to store the text that you ate editing. If you
read an existing file into MEmacs to edit it, you do not change
the contents of the file until you save your changes. All the
edits are being made to a copy of the fite that is in the buffer—
the original file does not change.

When you first open MEmacs, the name of the buffer is main.
You can have several buffers in use at one time, and you can see
one or more on the screen at the same time. Menu options let
you switch back and forth between them. At all times, what
you see on the screen is what is actually in the buffer.
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MEmacs has two modes of operations: normal and command.
When MEmacs is in normal mode, you can:

® move the cursor using the cursor keys

® move the cursor to the edge of the window by holding
down Shift and pressing the appropriate cursor key

¢ move the cursor by clicking the left mouse button at the
desired place on the screen

® insert characters at the current cursor position simply by
typing them

® delete the character at the current cursor position by
pressing Del

¢ delete the character to the lefr of the cursor by pressing
Backspace

You can also perform other special functions as explained in
the menu section and command summaries that follow.

When MEmacs is in the command mode, the cursor jumps to
the bottom line of the display, and the program asks you for
certain additional information. The command mode is entered
through various menu itemns which are explained later in this
chapter.

The length of the lines you can edit is limited to the right-hand
edge of the screen, usually 80 characters. Characters beyond
the right-hand edge are not lost; they simply da not show on
the screen. The only way to see those characters is to break
the line or to delete some of the displayed characters. When
entering new characters, you can keep typing past the
rightrmost character on the line, but what you type will not
show on the screen,
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Menu Commands

MEmacs has the following menus:

Project
Edit

Window

Move
Line
Word
Search

Extras

Contains system and file-oriented items.
Contains buffer editing commands.

Controls the characteristics of the MEmacs
windows.

Controls the placement of the cursor.
Controls line-oriented operations.

Controls word-oriented operations.
Controls search and search/replace options.

Controls the numerical value of arguments,
and lets you execute a series of operations as
though it were a single special command.

This section explains each of these menus and their related
commands. Each of the commands also has a keyboard
shortcut. The shortcuts appear to the right of the menu item.
In the menu, Ctrl is represented by a caret {*}. For instance, the
Rename menu item shows “XF as its shorteut. You must press

Ctrl-X-F.

In the manual, the keyboard shortcuts are shown along the
right margin and the standard format for key sequences is used.
However, if a symbol is shown, you must press Shift to create
that symbeal. For instance, the keyboard shortcut for the Set-
Mark menu item is Ctrl-@. Since the @ symbol is created by
pressing Shift-2, you must press Ctrl-Shift-2; Ctrl-2 will not

work.



The Project Menu

The commands in the Project menu, except for Visit-file, affect
the buffer associated with the current cursor position.

Rename Cul-X-F

Changes the name of the file associated with the current
buffer. This command is useful if you are saving versions of a
program or text file as you go along. You can perform a Save
command for the first version, modify a few things, rename the
file associated with this buffer and then save the new version,

When you select Rename, MEmacs prompts:

New file name:

If you press Return without specifying a filename, the buifer
becomes disassociated from any filename. You must specity a
name here if you want the buffer to be appropriately associared
with a file.

Read-file Ctrl-X-Ctrl-R

Replaces the contents of the current buffer with the contents
of a file. When you select Read-file, MEmacs moves the cursor
to the bottom line of the display and prompts:

Read file:

Enter the complete path to the file, including the volume
name, directory, and file, then press Return. The file is read
into the current buffer, overwriting the data that was stored
there.

If you do not want to read a file, simply press Return without
specifying a filename. MEmacs will ignore the request and
return you to normal mode.

MEmacs 0-5
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Visit-file Ctrl-X-Ctsl-V

Lets you work with additional files, aside from the first file
you open. You must already be editing something before you
can visit another file. This command is useful for programmers
who are creating a program and want to extract pieces from or
refer to other programs.

When you issue this command, MEmacs moves the cursor to
the bottom line and prompts:

visit tite:
Type the complete path of the file, and press Return. MEmacs
will read the file into a new buffer, if it is not already there. If
the file you want to visit is on a different disk, AmigaDOS$ will
display a requester asking you to insert that particular disk into
any drive. If the file is already in a bufier, MEmacs will switch
you to that buffer automatically.

Inserc-file Ctr)-X-Ctrl-I

Inserts the contents of a file into the current buffer. When you
1ssue this command, MEmacs moves the cursor to the bottom
line and prompts:

Insert lile:

Enter the complete path to the file, and press Return. MEmacs
will read the file into the cuyrent bufter at a point one line
above the current cursor position.

Save-file Cerl-X-Ctrl-S

Writes the contents of the current buffer to the filename
associated with that buffer. The filename associated with the
butfer was determined when the contents of an existing file
were read to the file or when the file associated with the
current buffer was renamed.

I there is no &lename specified on the status line, MEmacs
teils you No File Name and refuses to perform the Save.



After a successful Save, MEmacs uses the bottom line of the
screent to tell you how many lires it has written out to the
designated file.

Save-as-file Ctrl-X-Ctrl-W

Allows you to specify the name of a file to associate with a
buffer. When you issue this command, MEmacs prompts:
Wnite filg

MEmacs is requesting the name of the file in which it shouid
save the current contents of the butfer. If you provide a
complete path and press Return, the buffer will be written out
to that disk, dircctory, and filename. {If you press Return
without providing a name, you are returned to normal mode. )
The fellowing notation appears on the status line:

File: - lilenarme .-

From now on, that file will be used to save the current contents
of this buffer when you issue a Save command.

Save-mod Ctrt-X-Curl-M

Writes the contents of all modified buffers to the disk. Use this
item with caution to ensure that you don‘t accidentally modify
a buffer associated with a file you have visited but don’t intend
to change.

Save-exit Cuel-X-Ctrl-F

Saves all modified buffers then exits MEmacs. It is simply a
combination of the Save and Quit items. Again, use this item
with caution (see the Save-mod menu item).

New-Cli Ctrl- -

Brings up a new Shell window called Spawn Window. You can
1ssue as many AmigaDOS commands in the spawn window as
you want without interfering with MEmacs. To return to
MEmacs, use the ENDSHELL command. The spawn window
disappears, and MEmacs is restored to its previous state.

MEmacs
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Cli-Command Cirl-X-!

Allows you to execute an AmigaDOS command while you are
still in MEmacs. It is similar to issuing a RUN command while
in the Shell.

When you select this menu item, MEmacs moves the cursor to
the bottom of the screen and provides you with a ! prompt. You
can then type a command for AmigaDOS to process on this
line. MEmacs temporarily suspends operation, and AmigaDOS$
executes your command. The output of the command appears
in a temporary buffer called spawn.output.

Quit Cird-C

Exits MEmacs. If one or more of the bulfers has been modified
since you last saved it to a file, MEmacs prompts:
Moditied buffers exist, do you really want to exit? [yin}?

MEmacs is giving vou a last chance to save your work. If you
don't want to exit, simply press Return. If you do want to quit,
press Y then press Return.

Before quitting, you can check existing buffers by selecting
List-buffers in the Edit menu. MEmacs lists the names
associated with each buffer and shows an asterisk by each
buifer that has been modified since you last saved it 1o disk.

There are circumstances under which you will not want to
save all buffers back to the original files. For example, suppose
you were writing a program and copying pieces from other
existing programs as you went along. Some of the files you
visited may have been accidentally modified or may have been
on a write-protected disk.

If you are simply using an old program as temporary source
material, you will not want to destroy the original program.
When you are finished writing the new program, save your new
material and exit MEmacs without saving the modified buffers
of the source program.

Two alternative keyboard shortcuts for the Quit command are
Ctrl-X-Ct1l-C and Esc-Ctrl-C.
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The Edit Menu

The commands in the Edit menu affect the editing of your
buffers and their associated files.

Kill-region Cuel-W

Deletes blocks of text from the current buffer and saves them
in ¢ kill buffer. [Text can be pulled back into the document by
using the Yank command, described below.|

It a block of text has been marked using the Set-mark
command [explained on 6-10) and the cursor has been
positioned away from the mark, the area between those two
poeints is considered a block and can be deleted by selecting
Kill-region.

You can also use Kill-region to copy a block from one section of
the buffer to another. Mark the block, select Kill-region, then
without moving the cursor, immediately select Yank. The
block will be restored to its original position, but there will
also be a copy of the block in the kill buifer.

If you repeatedly select Kill-region on different areas of text,
without performing a Yank, each successive kill segment is
appended to the kili buffer. When you perform the first Yank, it
marks the end of the kill buffer.

Yank Ctrl-Y

Copies the contents of the kill buffer 1o the line immediately
above the current cursor location. Yank reverses the action of
Kill-region, but it does not change the contents of the kill
buffer. Therefore, you can repeatedly move the cursor to
another buffer, select Yank, and copy the contents of the kill
buffer. The next time you kill a block of text, however, the
contents of the kill buffer will be replaced with the new
material and the old contents will be lost.

Kill-region and Yank are often used together to move text from
one buffer to another.
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Set-mark Ctel-@

Marks the cursor position. When you select Set-mark, the
position of the cursor is marked in the current buffer. From
then on, any other position of the cursor is reterred to as the
dot. You can move back and forth between the mark and the
dot by selecting the Swap-dot&mark command in the Move
menu.

You can use Set-mark to mark the beginning of a block of text
that you want to duplicate or move somewhere else in the
buffer. Set the mark on the first character you want to include
in the block. As you move the cursor through the file, you are
essentially blocking out a portion of text.

An alternative keyboard shortcut for Set Mark is Esc - -.
Copy-region Esc-W

Copies the contents of the marked region to the kill buffer.
This new text replaces any previous contents of the kill buffer.

Upper-region Ctrl-X-Curl-U
Changes the text of the entire marked region to uppercase.
Lower-region Ctrh-X.Ctrl-L,

Changes the text of the entire marked region to lowercase.
List-buffers Cul-X-Ctrl-B

Splits the current buffer’s window and provides you with a list
of the buffers that MEmacs is currently maintaining. The list
has 4 columns. For example:

c Size Butier File

17260 Emacs. doc df: Docfiles/Emacs. doc

The fields are:

C Displays an asterisk if the buffer has been
modified since it was last saved to 4 file.
{Stands for “changed.”|
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Size Shows how many characters are in the
buffer.
Buffer Shows the name given to the buffer. If you

have read in a file, this will usually be the
name of the file itself, minus the full path.

File Shows the iull path to the file. This is the
file where MEmacs will write the buffer it
you choose Save-file or Save-exit while the
cursor is in that butfer.

When you choose List-buffers, the status line at the bottorn of
the screen displays MEmacs — [List]. Even though List-buffers
brings up a window display, it is not listed as an available
bufier. If you edit the List-buffers window, it can be made to act
just like any other buffer.

If you should leave the List-buffers window on the screen but
use a difterent window to modify the listed buffers, the List-
buffers display will not be continuously changed to reflect the
current changes. To get current information, you must select
List-buffers again.

Select-buffer Curl-X-B

Lets vou select a buffer to edit In the currently selected
window. When you choose Select-buffer, MEmacs moves the
cursor to the bottom line and prompts:

Use buffer;

You must provide a name that is the same as one of those
shown in the List-buffers listing. The specified buffer will
replace the contents of the currently selected window.

If you specify a name that is not in the List-buffers listing, you
are telling MEmacs to create a new buffer with that name. In
this case, there is no filename associated with the new buffer
and you will have to rename the file or select Save-as-file when
you are prepared to save the buffer’s contents to a file.

If you simply press Return, the command is ignored.
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Insert-buffer Esc-Curl-Y
Inserts the contents of a named buffer into the current buffer
at the line above the current cursor position. When you select
Insert-buffer, MEmacs prompts:

Insert buffer:

You must type the name of the bulffer to insert, then press
Return.

Kill-buffer Ctrl-X-K

Deletes the contents of a chosen buffer. MEmacs can only edit
a file if the entire file will fit in available memory. To make
room in memory, you can use Kill-butfer to delete the contents
of one or more buHers. This command returns the buifer’s
memory to the memory manager for reuse.

When you choose Kill-buffer, MEmacs prompts:
Butter to kill {delete):

You must then enter the name of the buffer you wish to delete,
You cannot kill a buffer if its contents are currently displayed.

Justify-buffer Ctrl-X-]

Removes all blank spaces and tabs from the left-hand edge of
ail the lines in the current buffer. The text is rearranged so that
it aligns with the current margins.

Redisplay Ctrl-L
Redraws the screen.
Quote-char Cul-Q

Allows you to insert a literal character in the text file. Some
keyboard selections have been assigned as MEmacs control
characters {for instance, the menu command shortcuts). If you
try to insert such a selection into your text, MEmacs will react
as if you chose a menu item.
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For example, Ctrl-L tells MEmacs to redraw the display, but
Cerl-L is also useful as a printing control to insert a form feed
character. By selecting Quote-char, the next character you type
will be taken “literally” by MEmacs and will be inserted into
the text file, instead of being treated as a menu command.

To quote the form feed character, press Ctrl-Q-Ctrl-L. MEmacs
will display "L, on the screen. IMEmacs uses the caret | ~)
symbol to represent Ctrl.)

As MEmacs manipulates the buffer, the combination of the
caret and the character is treated as a single character, both by
the cursor keys and the character counter.

You can also use Quote-char to insert a Return (Ctel-M),
Backspace (Ctrl-H|, or Esc (Cul-|) into the text by quoting the
single keys or for inserting any other control character that
may be needed during a macro command. Even Cul-Q can be
inserted by typing it twice. The Tab key cannot be quoted.

An altemnative keyboard shortcut for Quote-char is Ctrl-X-Q.
Indent Curl-]

Moves the cursor to the next fing, autonatically indenting the
same amount of spaces as the previous line.

Alternative keyboard commands are Help or Enter on the
numeric keypad.

Transpose Cul-T

Swaps the positions of two adjacent characters. The cursor is
placed on the right-most of the two characters.

Cancel Ctrl-G

Ends an ongoing menu command, such as a query search and
replace.
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The Window Menu

A window in MEmacs is not the same as a window on the
Workbench. MEmacs splits the screen into multiple layers, or
windows, allowing you to edit a separate file [bufter) in each
MEmacs window. The Window menu lets vou control how you
view your bulfers on the screen.

One-window Crl-X-1
Makes the current buffer a single, full-sized window on the

MEmacs screen. All other bufiers remain invisible, allowing
you maximum space to work on the current buffer.
Split-window Curl-X-2
Splits the current window in half, positioning the current
buffer identically in both windows. This lets you edit two
segments of the buifer at the same time. Any changes made in
either window affect the entire buffer. This is convenient when
you want to see what you wrote in an earlier part of your
document while working on a later section.

Next-window Ctrl-X-N

Moves the cursor to the next window and makes that window
available for editing.

If the cursor has been moved down to the bottom window, the
cursor will automatically move up to the top window.

Prev-window Curl-X-P

Moves the cursor to the previous window and makes that
window available for editing.

Selecting Prev-window when the cursor is in the top window
will move the cursor to the last, or bottom, window.



Expand-window Cul-X-Z

Adds g line to the height of the current window and
simultaneously subtracts a fine from the adjacent window.

Shrink-window Ctrl-X-Ctl-Z

Subtracts a line from the height of the current window and
simultaneously adds a line to the adjacent window.

Next-w-page Esc-Ctrl-V

Displays the next page of the adjacent window. For instance, if
you have split a window and are working in the top one,
selecting Next-w-page will move the contents of the bottom
window (the one you aren’t working in} to the next page. This
doesn't make the window available for editing; it just lets you
view the contents.

Prev-w-page Curl-X-V

Displays the previous page of the adjacent window. I only one
window is displayed, it displays the previous page of that
window.

The Move Menu

The commands in the Move menu let you move the cursor
rapidly through the current buffer.

Top-of-buffer Esc-<<
Moves the cursor to the top line of the current buffer.
End-of-buifer Esc->
Moves the cursor to the bottom line of the current buffer.
Top-of-window Esc-,
Moves the cursor to the top of the current window.
End-of-window Esc-.

Moves the cursor to the bottom of the current window.

MEmacs
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Goto-line Ctrl-X-Cirl-G

Moves the cursor to a specific line number. When you select
Goto-line, MEmacs moves the cursor to the bottom of the
screen and prompts:

goto-line:

Enter a line number, press Return, and MEmacs moves the
cursor directly to that line. If you specify a line number larger
than the total number of lines in the buffer, MEmacs moves the
cursor to the last line of the buffer.

Swap-dot&mark Cerl-X-Cul-X

Places a mark at the current cursor position and moves the
cursor to where the mark had been set. If you have not yet set a
mark in the window, MEmacs replies, No mark in this window.
This command lets you move quickly to and from a preset
location in your buffer, Selecting this item again restores the
cursor to where it was before you selected Swap-dot&mark the
first time.

Next-page Ctrl-V

Moves the text within the window toward the end of the
buffer by one full window, less one line. The cursor is
repositioned so as to stay on the screen.

Prev-page Esc-V
Moves the text within the window toward the beginning of the

buffer by one full window, less one line. The cursor is
repositioned so as to stay on the screen.

Next-word Esc-F

Moves the cursor forward to the next non-alphanumeric
character, such as a space or punctuation mark.
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Previous-word Esc-B
Moves the cursor back to the first letter of the previous word.
Scroll-up Ctrl-Z
Moves the text up a single line.

Scroll-down Esc-Z

Moves the text down a single line.

The Line Menu

The commands in the Line menu let you move the cursor
within or between lines and let you perform operations
involving entire lines.

Open-line Cirl-0

Splits the line the cursor is in, forcing the character on which
the cursor rests to become the first character of the following
line. This command leaves the cursor in the original line so
that you can type new characters beginning at the current
cursor position.

If you select Open-line by mistake, immediately pressing Del
closes up the line.

Kill-line Ctrl-X-Ctrl-D

Deletes the line in which the cursor is located and places the
text in the kill buffer. If you have not selected Yank since the
1ast Kill command, the text will be appended to the existing
text in the kill buffer.

Kill-to-e0l Ctrl-K

Deletes the text between the current cursor position and the
end of the line. If you have not selected Yank since the last Kill
command, the text will be appended to the existing text in the
kill buffer.



6-18

MEmacs

Start-of-line Ctrl-A
Moves the cursor to the left-most position on a line.
End-of-line Ctrl-E

Moves the cursor to the right-most position on ¢ line. If you
have typed more characters than will fit on a line, 2 dollar sign
{$) appears at the right-hand edge of the line. Moving to the end
of the line places the cursor logically on the right-most
character even though you cannot see it. Physically the cursor
is positioned over the dollar sign. If you use the left cursor key
to move the cursor, it will take as many key presses as there are
unseen characters before the cursor actually begins to move.

Next-line Ctrl-N
Moves the cursor down one line.

Previous-line Ctrl-P
Moves the cursor up one line.

Line-to-top Esc-!
Moves the line containing the cursot to the top of the window.
Delete-blanks Ctulb-X-Cul-Q

Deletes blank lines, proceeding forward from the current
cursor position until MEmacs gets to the next line on which
text exists.

Show-Line# Cirl-X-=
Displays information on the present cursor position. For
example:

Line 17 Column 1 {2%}

In this example, the cursor is on the 17th line of text, in the
first column. The percentage shows that the cursor is in a
position 2% of the way from the top of the buffer. If the cursor
was on the last character of text, the percentage would be equal
to 100,



The Word Menu

The Word menu contains word-assoctated operations.
Delete-forw Esc-D

Deletes the character on which the cursor is positioned and all
remaining characters to the right untii the next non-
alphanumeric character is found, [i.e., a blank space, tab, or
punctuation mark].

If the cursor is positioned on a blank space, it must be moved
forward to the start of a word to delete that word.

Delete-back Esc-H

Deletes all characters to the feft of the cursor until it finds the

first character of a word. The character under the cursor is not
deleted.

An alternative keyboard shortcut for this command is Esc-Del.
Upper-word Esc-U

Changes a word to uppercase, starting at the character where
the cursor is positioned and proceeding to the last character of
the word.

Lower-word Esc-L

Changes a word to Jowercase, starting at the character where
the cursor is positioned and proceeding to the last character of
the word.

Cap-word Esc-C

Changes the character where the cursor is positioned to
uppercase. It also changes the characters to the right of the
cursor, up to the end of the word, to lowercase.

Switch-case Esc-

Changes the case of a word, starting at the current cursor
position and proceeding to the right until it reaches the end of
the word. If a word is uppercase it changes it to lowercase, and
vice versa.

MEmacs
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The Search Menu

The Search menu allows you to search through the current
buffer for specific text strings. The case {upper or lower} of the
string is not significant in the search itself. However, if you are
using text substitution [search and replace), the text will be
replaced in the same case as that of the replacement string.

Search-forward - Ctl-§

Searches through the tex! starting at the current cursor
posttion and moving forward to the end of the buffer. When
you issue this command, MEmacs moves the cursor to the
bottom line of the screen and prompts:

Search:

Enter the string of characters that you want MEmacs to search
for, and press Retumn. If the string is found, MEmacs positions
the cursor immediately following the last character of the
string. If MEmacs cannot find the string, it replies Not foung.

An altemmative keyhoard shortcut for this command is Ctel-X-S.
Search-backward Cul-R

Searches through the text from the current cursor position
backwards to the beginning of the buffer. This command
operates in the same manner as Search-forward.

An alternative keyboard shortcut for this command is Ctrl-X-R.
Search-replace Esc-R

Operates the same way as Search-forward, except that it
allows you to replace the string with differ